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About WeatherCat

WeatherCat is weather station software for Macintosh computers.

WeatherCat is designed to work with hardware-based weather stations and at the time of
writing works with the following stations:

* Davis Vantage, Vue and Envoy stations. WeatherCat also supports the
WeatherLinkIP data-logger.

* Fine Offset WH1080 and variants. This station is sold under a variety of brands
including Maplin (W96GY), Ambient Weather, Conrad, Clas Ohlson, Watson
(W8681) and others.

* Fine Offset WH3080 and variants — this station has solar and UV sensors and again
1s sold under a variety of brands.

* La Crosse WS23xx range of stations.

* Oregon Scientific WMR 928/968 stations.

* Oregon Scientific WMR200 stations

* Oregon Scientific WMRS88 stations

* WeatherHawk stations equipped with an IP server module.

* Instromet MetPlus stations.

As data 1s gathered and stored in its database, WeatherCat allows you to view weather
statistics such as the lowest temperature, or the highest wind speed over any time period
stored in the database. In addition WeatherCat can generate and upload simple web pages
which are quick to get going but lack customisation, as well as more complex ‘custom’
web pages containing current conditions, graphs, gauges, statistics, webcam image and
time-lapse movies. These web pages can be uploaded to your server by WeatherCat for
display via a web browser anywhere in the world.

WeatherCat can also send your weather data to the Weather Underground (Wunderground),
the Citizens Weather Observer Program (C.W.0O.P.), the Met-Office WOW program,
PWSWeather and WeatherCloud. In addition it provides close to real time Custom C.G.I.
upload to a web-server for your own web-based applications.

WeatherCat monitors the weather and can run a set of pre-defined and user programmed
alerts that can trigger emails and/or run scripts should an alert trigger; for example to
switch on your sprinklers, heating or cooling. In addition WeatherCat can integrate with
other systems via its AppleScript and rich client protocol interfaces.

WeatherCat is designed to run 24/7/365 and doesn’t normally require user interaction or
maintenance. Important events are notified via email — for example WeatherCat may detect
a problem uploading weather data to Wunderground — it will typically be able to resolve
the issue, but if it can’t, will send you an email.
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Finally, daily and monthly reports are generated and saved to disk (as PDF’s), automatic
exports can be programmed to export both raw and hourly data on a daily basis and a small
client application is available! which can display real-time weather gauges on one or more
Macintosh computers connected either to the local network or over the Internet. Clients for
10S are also available in the AppStore.

I Downloadable from the Trixology web-site.
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Requirements
Whilst WeatherCat works best on a computer that is always running and which is
permanently connected to the Internet, it will work on any Intel or Apple Silicon based

Macintosh running OS X 10.13 (or later).
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Support

If you have a problem or question with regards to WeatherCat, please check this manual
first — it may contain what you are looking for.

If this manual doesn’t help, there are active support forums at the following U.R.L.:
http://athena.trixology.com

In addition we have a wiki at wiki.trixology.com which contains many helpful pages on
station setup, hardware issues, WeatherCat usage and so on - it’s very possible the answer
to your question can be found there.

Finally, if you can't find the answer to your question on the forum or wiki, you can email
us at weathercat support@trixology.com. Please be sure to include as much information as
possible including your weather station type and operating system version.
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Terms & Conventions Used In This Manual

Database — The collection of files WeatherCat maintains on disk to hold weather data.
WeatherCat stores and retrieves samples from a simple database held in the users Library
folder. The database is organised by year and month. Each month has a text file, (given

a .cat extension), which stores the samples for that month along with a statistics file (given
a .hrs extension).

Interpolation — The calculation of additional data between 2 known values. For example
if WeatherCat has data for 1P.M. and 2P.M. and it isn’t available for download from your
data-logger then WeatherCat calculates the missing data in-between by calculating the
incremental difference in the sample data between these two times and then applying and
accumulating that difference to the missing samples between 1 and 2 P.M.

Path Syntax — This manual occasionally uses a path to show the location of a file or
folder. A path is the location of a particular item within your file system. We will use two
types of path; the first is an absolute path, indicated by a slash at the start of the path. For
example, in OS X 10.9 you can find the Console utility at the following path:
/Applications/Utilities/Console

The slash indicates the path starts at the root of the file system; your hard drive.

The second type of path begins with a ~ (tilde). The tilde is a shortcut to your home
directory, so the path to your documents directory (i.e. documents available only to you) is:
~/Documents

If your name 1s Mary, then the absolute path to your documents is:
/Users/Mary/Documents

Sample — A set of data representing the weather at a given date. The sample consists of
primary, calculated and secondary data. Primary data includes the temperature, humidity,
barometric pressure, wind speed, wind direction, precipitation and current conditions — i.e.
data available from the hardware weather station. Calculated data is data WeatherCat did
not receive from a weather source but was able to calculate — an example might be the
wind chill. Secondary data includes the date of the sample and the validation — i.e. if the
data is real or synthesised (interpolated because no data was available at the time the
sample was collected).
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Introduction And Concepts

WeatherCat can be thought of as a multi-track recorder; it captures the data from your
weather station and records it to disk.

WeatherCat works with ‘channels’ — each variable available from your station is assigned a
channel; as an example, the external temperature is always assigned to channel 1.2

Periodically WeatherCat records all channels available from your station to disk. These
periods can range from 1 minute up to 30 minutes and we call the act of recording the data
to disk ‘taking a sample’. The faster the recording rate, the higher the resolution of your
database but the more storage your database requires. Ideally we’d always record as fast as
we can to maintain the highest resolution possible, but in reality the weather doesn’t
change all that much one minute to the next and recording the data every minute can waste
disk space.

To avoid this problem, WeatherCat provides what we call ‘Adaptive Sampling’. In this
mode, WeatherCat monitors important weather variables and only takes a sample if a
variable changes; this way we maximise the resolution of the data whilst not wasting
storage space (which over many years can amount to a lot of wasted space). If the weather
is changing a lot, WeatherCat will record as frequently as once per minute; conversely, if
the weather is essentially stagnant, WeatherCat will record less often as the data is
changing less frequently. Thus WeatherCat adapts to how active the weather is.

The database on disk is made up of text files that can be viewed or edited in a good text
editor. These text files are given a ‘.cat’ extension, for example ‘2 WeatherCatData.cat’
and each file holds the data for a month — in this example February. WeatherCat also
maintains hourly statistics files — these are maintained by WeatherCat as each sample is
taken and are given a ‘.hrs’ extension, for example ‘2 WeatherCatData.cat.hrs’. The
database is organised by year and month making it easy to find a given file for a given
date.

WeatherCat knows what channels are available from your station — for example a Vantage
can provide more than 50 channels, but typically many are not actually active as they don’t
have any sensors attached. WeatherCat knows which channels are actually valid and only
records those channels. For example, if you have an extra temperature sensor fitted and
your station supports up to 3 additional temperature sensors, WeatherCat will only record
the channel with the sensor actually fitted.

WeatherCat provides a plug-in architecture for weather stations — at the heart of
WeatherCat is the ‘Station Driver’ — this is a plug-in, loaded into WeatherCat when it
launches. Typically a station driver updates the data to WeatherCat about once every two
or three seconds. Some stations can provide all of their data within this time and some
stations can take up to a minute or longer for all of their data to be made available. The

2 For a list of all currently available channels, please see Appendix 1
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station driver manages this and makes a consistent set of data channels available to
WeatherCat.

These channels are made available to the systems in WeatherCat that require access to the
weather data; things like the AppleScript, web pages, emails (new weather record for
example), statistics, on-line services, video overlay, plug-ins and so on.

As WeatherCat is channel based, it allows easy access to the data for external applications
via AppleScript or its rich client protocol interface. Irrespective of the actual hardware
WeatherCat is working with, these interfaces provide a consistent interface.

With regards to design, there are a couple of decisions and philosophies at work within
WeatherCat. The thinking behind the User Interface is to not provide a confusing jumble of
options — wherever possible we try to choose a sensible default for operation.
Unfortunately, there are more options than we would like, but we’ve tried to categorise
them into logical groups and hide them when they aren’t frequently used — for example the
C.W.O.P advanced preferences.

Another line of thinking runs through the fault tolerance within WeatherCat. When a
problem occurs, WeatherCat will try to correct the problem automatically. You may receive
an email saying some system is having problems followed very shortly by another email
indicating whether the problem has been cleared or not. Unfortunately it is not possible to
guarantee bug-free operation 24/7/365 but WeatherCat is designed to run for these kinds of
periods and thus has multiple checks in place to ensure it can run as trouble free as
possible.

Weather software can be complex and difficult to understand, so another philosophy at
play in WeatherCat is that it should be easy to get going without having to worry about
more complex issues. WeatherCat provides simple web pages that require just a few clicks
to get on-line, basic graphs that immediately begin to show useful data, and easy to use but
reliable uploads to on-line services.

Beyond these initial facilities, it is possible to create and generate beautiful web pages via
WeatherCat’s Custom Web pages feature, control your home automation system either via
simple rules that can trigger scripts or more complex programming in conjunction with
WeatherCat’s AppleScript or rich client interfaces. In addition you can create stunning
graphs that compare weather variables, beautiful gauges that can track up to four variables
on the same gauge, create your own channels from existing or external data with synthetic
channels, set up custom alerts to be informed of weather events you care about, be
informed of new weather records as they happen, access real time data remotely via
WeatherCat clients, create and upload time-lapse movies and images from your webcam in
addition to browsing comprehensive statistics and reports.

Going back to the complexity issue of weather software, when launched for the very first
time, WeatherCat will display just a few windows — the first being the ‘Daily View’, which
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shortly after WeatherCat is launched will be updated with the current weather. The others
being the log window and release notes. This is deliberate — it is quite possible to
completely cover multiple monitors with WeatherCat windows but we believe it’s better to
just display these few, and let you discover what’s available for yourself by clicking about
and discovering stuff.
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WeatherCat 3

If you are upgrading from WeatherCat 2, WeatherCat 3 introduces the following major

features and changes:

1. WeatherCat is now a 64 bit universal application for both Intel and Apple Silicon
based Macs.

2. Arich client protocol enabling clients to retrieve data, make queries and display
images such as graphs or webcam via http.

3. Custom text Windows. A custom text window is a window you can create and edit to
have just the data you want in it - weekly and monthly custom text windows are
provided by way of example.

4. Updated movie functionality - as well as creating 1 hour movies, WeatherCat 3 can

also create a 24 hour time-lapse movie and upload it to your web-site on an hourly

basis as the day progresses.

Additional time specifiers for web-tags.

6. Auto-update functionality. After initial installation, WeatherCat will auto-update itself
with the click of a button.

9]

For a complete list of changes, please see the release notes (available from the ‘Help’ menu
within WeatherCat or at the end of this manual).

Upgrading to WeatherCat 3

Whereas earlier versions of WeatherCat were supplied as a zip image which expanded to a
folder, WeatherCat 3 is supplied as a single application on a disk image. To upgrade to
WeatherCat 3 from WeatherCat 1 or 2, first quit your existing WeatherCat then open the
WeatherCat 3 disk image you downloaded from our web-site. Drag the WeatherCat
application over the Applications folder in the disk image then run the new WeatherCat
(which will be found in your Applications folder). Do not run WeatherCat directly off the
disk image.

After installing WeatherCat 3 into your Applications folder, you can delete, or zip up and
then delete, your old WeatherCat folder - it is no longer used or required.

Notes:
1. If you previously auto-started WeatherCat on machine start-up, you will need to update

your log-in items for the new WeatherCat.

2. The macOS client which was previously found in the download can now be downloaded
from our web-site as a separate download. Clients for IOS can be found in the App store.
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Getting Started

Installation

After downloading WeatherCat 3, open the WeatherCat disk image and drag the
WeatherCat application over the Applications folder in the disk image. This will copy
WeatherCat to your Applications folder. Finally, eject the disk image.

If you wish WeatherCat's icon to stay in the dock, either drag the application to the dock
before running it (from your Applications folder, not the disk image), or right click on its
icon in the dock when running and use the pop-up menu to select 'Keep In Dock'.

You may also wish to add WeatherCat to your 'Login Items' via the 'Accounts' pane of the

System Preferences so that WeatherCat starts-up whenever you log-in to your computer. If
you have automatic login enabled for the account then WeatherCat will start whenever the
computer starts or restarts.

Before running WeatherCat, please ensure you have the correct driver installed for
your station or USB to serial converter. Without the correct driver installed,
WeatherCat will not be able to communicate with your hardware. Note that
WeatherLink IP, the WMRS88, WMR200, WH1080/2080/3080 and WeatherHawk do
not need a driver to be installed to be used by WeatherCat.

Please see the next page for more details on USB drivers.
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Hardware Support

WeatherCat currently supports the following stations:

* Davis Vantage, Vue and Envoy stations. WeatherCat also supports the
WeatherLinkIP data-logger.
Fine Offset WH1080 and variants. This station is sold under a variety of brands
including Maplin (W96GY), Ambient Weather, Conrad, Clas Ohlson, Watson
(W8681) and others.
Fine Offset WH3080 and variants — this station has solar and UV sensors and again
is sold under a variety of brands.
La Crosse WS23xx range of stations.
* Oregon Scientific WMR 928/968 stations.
* Oregon Scientific WMR200 stations
* Oregon Scientific WMRS88 stations
WeatherHawk stations equipped with an IP server module.
Instromet MetPlus stations.

Serial To USB converters

Some weather stations are serial devices and come equipped with a serial connection. Most
Macintosh’s do not have serial ports but do have USB ports. If your weather station is not
USB based, you will need to obtain a serial to USB converter. These little dongles convert
from the weather station’s RS232 interface to USB so you can use the station with your
Macintosh.
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Serial to USB converters are not generally expensive and are available to buy on-line or at
electronics retailers. Prices range from about 15 UK Pounds (as per the converter in the
image above) to about 40 UK Pounds for a branded item.

Most serial to USB converters require a driver to work with the Operating System. Before
running WeatherCat, check you have the right drivers installed for your converter. A list of
common driver software and download links can be found in Appendix 3.

If running a USB Davis station, be aware that the latest Davis drivers rarely install
correctly on OS X 10.13 or later and if they do, they are unreliable. In this case you can
download the Silicon Labs drivers directly from https://www.silabs.com/products/
development-tools/software/usb-to-uart-bridge-vep-drivers (download and install the VCP
Driver Kit before running WeatherCat (V6.0.2 is current at time of writing)).

NOTE: Mac OS High Sierra 10.13 introduces a new feature that requires user approval
before loading new third-party kernel extensions. Go to System Preferences - Security &
Privacy and click Allow. This will only be present for half an hour after installation. If it’s
been longer than that since you installed the driver, reboot and check it again.

https://developer.apple.com/library/content/technotes/tn2459/_index.html

If you need more advice on suitable RS232 to USB converters and their drivers, search
and/or post on the WeatherCat forum.
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Running WeatherCat For The First Time

Please ensure your weather station is installed and set up as per the manufacturers
instructions.

In particular, check the following:

l.

2.

The time and date is correct on your station and matches the time on your computer
(check with your station manual as to how to do this).

Your station is plugged into your Macintosh with a suitable serial to USB converter
(if necessary).

. You have installed the driver for your serial to USB converter or USB based Davis

station (see Appendix 3).
If your weather station is wireless, check that all sensors are being received reliably
and consistently.

Finally, make sure you have quit any other weather software that may be accessing the
station. If you own a Davis weather station, make sure it is not in 'Setup' mode or that the
forecast ticker is not running (both of these prevent communications with the weather
station).

When you run WeatherCat for the first time, you will be asked to select your station and if
necessary, the relevant communications settings as shown in the following picture:
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O Station Communications

Weather Station Communications Set-up

If you have a serial or U.S.B. based weather station, please tell WeatherCat which weather station you have and
which communications port it is plugged into. Ensure the USB drivers for your station or serial to USB converter
are installed correctly, your weather station is powered up and plugged into the computer then select your
weather station and the comms port it is connected to.

If you have an |.P. based station, please select your station type and enter the station's |.P. address.

If you have a Netatmo station, please select the 'Netatmo' station type and enter your log-in email address
and password

Station Type: Netatmo ﬁ

Comms Port: | /dev/cu.Bluetooth-Incoming-Port Rescan Ports
Or
I.P. Address:

Or
Email Address: Password:

Done

If your station is serial based, select the relevant comms port - for Davis stations using the
Silicon Labs driver, this is typically dev/cu/SLAB_USBtoUART.

If your station is a native USB based station, the Comms Port and IP Address fields will be
greyed out — these aren’t needed for USB based stations.

If your station is I.P. based (WeatherLink I.P.3 or WeatherHawk), after selecting the station
type, enter its [.P. address into the I.P. address field. If necessary specify the port with a
colon — for example 192.168.1.110:22223 specifies the station can be found at I.P. address
192.168.1.110 on port 22223.

When you have selected your station type and the communications port/settings, press the
'Done' button whereupon the software will try to connect to your station and continue to
launch.

If the weather station hardware is not found:

3 If you are using WeatherLink IP, please see the WeatherLink IP Hardware Options
section of this manual for information regarding finding its I.P. address.
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If the station is locally connected to the computer, please check all your
connections. Unplug your station from the computer, power it down (remove the
batteries), leave it for a minute. Then power it up and set it up (date and time,
barometer etc.) then plug it back in, re-launch WeatherCat and try again. If you
need a serial to USB driver, be sure you have the latest version installed.

If your station is I.P. based, check the I.P. address you have entered into
WeatherCat is correct.

Once your station is found by WeatherCat, it will continue to launch and will look
something like the picture below:

SN S T— _ WeatherCat

® WeatherCat File Edit Tools Window Help Help
O

R Initial Set Up
T Ty, e E To get the most out of WeatherCat, the software
- et ) g needs to know your location and height. Would you
123 456 7 £ < like to set it up now?
8 9 10p8§12 13 14 . .
15 16 17 18 19 20 21 ] 5 i (Please note that latitude and longitude are entered
E Y 3 as degrees, minutes and hundredths of a minute
e Ay ey . 5 rather than the more common, but less accurate,
2930 1 2 3 4 5 .9 » . degrees, minutes and seconds.)

6 7 8 91011 12 [ N | [ Yes |

. Sep 2014 <0
Bl Mo Tu We Th Fr Sa Su §

V2.00 Build 4472 20:51:53 Sep 11 2014

At this point WeatherCat is asking for your location and height — if you don’t have this
information to hand, just click the ‘No’ button. Otherwise click ‘Yes’ and enter the details
into WeatherCat’s preferences (see the following section ‘Basic Setup’ for more details).

WeatherCat is now running and logging the weather; the next section will detail some of
WeatherCat’s major user interface elements, but as a quick start, nearly all of WeatherCat’s
set-up is performed via its Preferences available from the ‘WeatherCat’ menu [APPLE ,]
and most of the data windows, graphs and gauges are accessed from the ‘Tools’ menu.

Have a little look around, then come back to learn more about WeatherCat.
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Basic Set-up

Now we need to tell WeatherCat the name of your station, the location and altitude. The
name is used in your web pages, the location and altitude is used when sending your data
to C.W.O.P and when calculating things like cloud-base or sun-rise and sun-set times.

Setting Your Location
Open WeatherCat’s preferences from the WeatherCat menu:

e OO0 WeatherCat Preferences

Email On-Line = Alerts Alerts 2 Custom Alerts Units/Miscl Misc2 = Webcam Imagery = Advanced |

This pane allows you to set your station name, latitude, longitude and elevation. ‘Graph Drawing' sets various
parameters for the basic graphs WeatherCat can draw.

Station Details

Enter station name, elevation, latitude and longitude in degrees, minutes &
hundredths of a minute. You must click 'Set Details' for these details to be registered.

Weather Station Name

Local v -

° '
N 3

Lat: 00 =00 | 00

Elevation: 0 Metres

Lon: 000° 00 ‘_ 00 \E :\ | Set Details HDeIete Data |

Drawing/Basic Graphs

Graph Background Color C} ‘ Graph Line Width f—\j—~

. Graph BG Blending e——()
|_| Missing Data Color - o }7
Craph FC Blending f—(p
Basic Graph Scale (Days) ! ! !

) Missing Data Style | Solid Line =l
s6 28 14 7 1

Basic Graph Display Filter

S

Cauges

Frame - Text - Pointer - Pointer Shadows @
Frame Secondary
wiath T Mercury | [ Poimer\i|

1. Enter a name for your station in the ‘Location 1’ field.

2. Enter your Latitude and Longitude; please note that the format is Loran — 1.e. Degrees,
Minutes and Hundredths of a minute. 4

If you don’t have your altitude and longitude in Loran format, you can convert Degrees,
Minutes and Seconds to Degrees, Minutes and Hundredths with the following formula:

4WeatherCat uses degrees, minutes, hundredths as it is more accurate than degrees, minutes and seconds. It is also the format

sent to C.W.O.P.
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Hundredths=Seconds / 60 * 100
(Where ‘/” means divide).

3. Enter the station elevation in metres. Feet can be converted to metres by multiplying the
height in feet by 0.3048.

4. After entering your data it is important you press the ‘Set Details’ button — if you do not,
your details will not be registered and every time you start WeatherCat it will ask you if
you want to set your location! (The ‘Set Location’ button prevents accidental editing of the
location data.)

Email Setup
Next switch to the Email tab of the preferences and enter your mail server details.

For some common email settings, please see Appendix 2, but at the very least you will
need to enter the SMTP server address, an address in the ‘From’ field and at least one
‘Admin’ email address.

The ‘Admin’ addresses receive all emails from WeatherCat whereas the ‘User’ addresses

receive only weather alerts and records. You can enter more than one address by separating
the addresses with commas.
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6.0.0,

~ WeatherCat Preferences

{ Location/Colors m On-Line

Alerts | Alerts 2

Custom Alerts

Units/Miscl Misc2 = Webcam Imagery Advanced}

WeatherCat can send various email messages when certain events occur. Weather alerts and records, test emails, data
emails, administrative emails can all be sent. All email is sent to the addresses in the 'Admin Addresses' field. The
addresses declared in the 'Users Addresses’ field do not receive administrative emails. The address fields can take

one or more email add , sep d by c
Email
SMTP Server
SMTP Server |
User Password

I Port 25
("] Authentication

Email 'From' Field ’WeatherCat@mydomain.com

|

Admin Addresses ’

\ Test Now

User Addresses ’

~ Daily Data Email

M Send Temperature
[V Send Dewpoint

User Text (Included in all Emails)

\ Test Now

@Send Pressure
¥ Send Windspeed

needs...

!

@ Email Forecasts @ Email Reports

;Edit this text using WeatherCat's email preferences to suit your |

@ Email New Records @ Send Admin Emails

You can test whether WeatherCat can send email by pressing one of the ‘Test Now’
buttons; this will send a test email to either the Admin or User addresses.

If the test succeeds you’ll see a confirmation sheet as shown in the picture below:

Mail Test OK

WeatherCat has successfully sent a test email to
weathercat_support@trixology.com.

o )
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If the test fails, then the specific error will be reported as shown below:

Mail Test Failed

WeatherCat was unable to send a test email to
weathercat_support@trixology.com.

Please check the SMTP settings. In addition some
servers may REQUIRE that the 'From' field has a valid
address in it.

Error: Mail server not found.

In this particular case the mail server address had been entered incorrectly.

WeatherCat now knows the name of your station, your location, height, email server
details and email addresses so it can send you weather and administration alerts.

We will cover setting up WeatherCat to perform more tasks, such as reporting to on-line

weather services and generating and uploading web pages in the ‘How Do ...’ section of
this manual a little later, but for now we should take a look at WeatherCat’s user interface.
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User Interface

Graph Types

Before we get too deep into a description of WeatherCat’s user interface, we need to
introduce the two types of graphs in WeatherCat; basic graphs and custom graphs.

Basic graphs plot a single weather variable in a scrolling manner — as time progresses the
data scrolls to the left.

'8 SN &) 1hr Rain Rate

Precipitation mm/h
30.0 cnnpg—————— G B

27.0

24.0

21.0
18.0

15.0
12.0
9.0
6.0

30 ..t
0.0 ANIEYA

12:35 AM 8:35 AM 12:35 PM '4:35 PM

Custom graphs can graph up to three variables in either scrolling or anchored format.
Anchored custom graphs are graphs that start at a specific historical point in time on the
left-hand side; for example midnight or the start of the week>, month or year.

5 The week in WeatherCat starts on Sunday
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®no Average Temperature & Dew Point This Week
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WeatherCat Controller

When you first launch WeatherCat, the WeatherCat controller window (also known as the
‘Daily View’) will be displayed as shown below:

[ NON WeatherCat

Feb 2018 <0
Mo TuWe Th Fr Sa Su
29 3031 1 2 3"
5 6 7 8 910 11
12 13 14 15 16 17 18
18 20 21 22 23 24 25
262728 1 2 3 4
5 6 7 8 9101

V3.00 (Tactical Grace) Beta 1 Build 2135 12:48:14 Jan 28 2018

At the top of the window is the date and time of the last known sample. You can change
the date and time here and the data along with any open graphs (apart from anchored
custom graphs) and satellite imagery will display the data for that day (assuming the data
exists in your database).

The buttons to the left and right of the calendar/clock allow you to scroll backwards and
forwards in time — again, any open graphs (apart from anchored custom graphs) and the
satellite imagery window, if open, will also update to reflect the historical data/imagery.
Note that holding the ‘ctr]’ key down whilst scrolling will accelerate the scrolling rate.
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The main view of the window shows various daily data as collected from your station.
Items in parentheses indicate the 1 hour delta, the exception being the Pressure which
displays the 3 hour delta. (These delta’s will read as ‘Cal’ during the first hour of data
collecting).

Note that the items displayed in this window will depend on the capabilities of your
hardware. For example, if your hardware does not support or have fitted a solar radiation
sensor, then solar radiation will not be displayed.

Finally, the window may be resized by dragging the lower right corner of the window.

Note: When WeatherCat launches for the very first time, there may be a delay (how long
depends on your type of weather station) before this data appears.
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Tools

Most of WeatherCat’s windows are available from the ‘Tools’ menu. In this section we will
examine each of them in turn.

Basic Graphs

All of WeatherCat’s basic graphs are available from the ‘Tools’ menu. Basic graphs are
provided for all the main weather variables. To plot extra sensors available on your
hardware, please see custom graphs on the next page.

‘Q OO0 Wind Direction

Wind Direction

H ﬂ“ W\A N 2 W Y ARAA VA’

18:00 00:00 06:00 12:0

Here we can see the wind direction graph for the last twenty-four hours. In general,
WeatherCat’s graphs auto-scale the vertical axis to provide the required range.

WeatherCat’s ‘Location/Colours’ preferences contain a ‘Display Filter’ for basic graphs;
here is the same graph with some filtering applied:
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'6 OO0 Wind Direction

Wind Direction
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Basic graph window positions can be saved in user definable sets using the ‘Save Graph
Window Positions’ command available from the ‘Windows’ menu. The ‘Load Graph
Window Positions’ command can also be found there. Basic graphs are used in the simple
web pages and can also be used in custom web pages.

Basic graphs are configured in WeatherCat’s ‘Location/Colours’ pane of its preferences.

Page 33



Custom Graphs

Custom graphs are available from WeatherCat’s ‘Tools’ menu. WeatherCat can manage an
unlimited number of custom graphs and, like WeatherCat’s basic graphs, custom graphs
can be displayed in custom-web pages.

Each custom graph is fully independent of any other graph and can plot any channel
available on your hardware including all extra channels and synthetic channels (see later).

As mentioned above, WeatherCat supports two basic types of custom graphs — scrolling
and anchored.

Scrolling graphs can display data with a time range between 28 days and 1 hour and as
time progresses the data scrolls to the left — (the same behaviour as basic graphs).

Anchored graphs start at a specific point in time on the left and progress from there until
the period is over — for example the start of a day, week, month or year. Figure 13 shows
an anchored weekly graph. In this case it is anchored at the start of the week. As you can
see this image was captured on a Friday.

®no Average Temperature & Dew Point This Week
>

T Average Temperature & Dew Point This Week
au

26 26
22 22
18 18
14

Tue Wed Thu
Ext. Temperature “C Dew Point °C

Clicking the small disclosure triangle located at the top-left of the window allows custom
graphs to be configured.
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L ASNG) Average Temperature & Dew Point This Week

Average Temperature & Dew Point This Week

-~

Average Temperature & Dew Point This Week

Tuesday Wednesday Thursday Saturday
Ext. Temperature ‘C Dew Point °C

A custom graph can display up to 3 variables in a variety of graph types. Each variable can
be drawn in a number of styles and the size of the graph displayed on the web can be set
independently of the size as displayed on screen.

We won’t describe each option here — the best approach is to create a new custom graph
and examine the various options for yourself.

To use the graph in a custom web page, simply use the WebTag as shown in the graphs’
controls — in this case it would be CUSTOMGRAPH$1$

(Please see later for details of custom web pages).
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Gauges

M OO Weather Station Gauges
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Cood Data: 9 Comms Error: 0 Sensor Error. Quality: 100.00%

The basic gauges window displays real time conditions as received by your station. Along
the top of the window are dial-type instruments and along the bottom are thermometer-
type instruments. At the very bottom are some figures indicating communications counts
and quality. This display is replicated in the WeatherCat OS X Client application.

The Wind Direction dial indicates the current immediate wind direction via the long
pointer and the 10-minute average wind direction with the short pointer. If the short pointer
is gray, then WeatherCat hasn’t had time to finish calculating the average wind direction;
when it has, the pointer turns red. The figures in the centre of the dial are the current wind
direction on top and the average wind direction on bottom.

The Wind Speed dial indicates the current wind speed via the longer of the two pointers
and the 10-minute average via the shorter pointer. Again, the average pointer will be gray
until WeatherCat has had time to calculate the correct value. The figures in the centre of
the dial are, from the top, the instantaneous wind speed, the 10-minute average speed, the
10-minute wind gust and the daily high.

The Wind Rose gauge indicates all known wind vectors since midnight. Wind run is the
amount of wind that has passed your location in a given time. For example if the wind was
blowing at a constant 1 mile per hour for 1 hour, then the wind run would be 1 mile for
that hour. If the wind velocity increased to 5 miles per hour then it would be 5 miles, or
120 miles in 24 hours. The wind run gauge goes one step further and displays the wind run
for each degree of the compass — this gives a visual representation of where the wind has
been blowing from over the last 24 hours.
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The numbers at the bottom of the wind run gauge shows the total daily wind run and the
current scale of the gauge — i.e. the length of the longest wind run vector being displayed.
An option in WeatherCat’s preferences can overlay the current wind-run vector if required.

The Pressure dial indicates the current reading and the daily low and high values via the
red pointers. The numbers in the centre show the current pressure and the three-hour
pressure change. The three-hour pressure change is a good indicator of what the weather is
going to do. If the pressure is rising, then it is likely the weather is improving and if
falling, the weather is likely to deteriorate. If the pressure is falling quickly, then it is
possible a storm is on its way.

The Calculated Cloud Base dial indicates the current calculated cloud base along with the
daily low and high via the red pointers. The figures on the dials are in 1000’s of units; thus
1.5 reads as 1500. Calculated cloud base is derived from the air temperature and dew point
and gives an approximate indication of the base of cumulus clouds.

The Solar and U.V. gauges are not displayed by default; they can be enabled from the Misc
2 pane of WeatherCat’s preferences. The smaller pointer on the ‘Solar’ dial is the 10-
minute average, the larger pointer is the instantaneous reading. The top figure is the current
value, the middle figure is the 10-minute average and the bottom figure is the daily high.

The thermometer type gauges indicate the current values of various weather variables
along with the daily high (red) and daily low (blue) values as horizontal bars.

The appearance of the gauges can be adjusted in the ‘Location/Colours’ pane of
WeatherCat’s preferences.

Communications Counts And Quality
At the bottom of the Gauges window are counts for ‘Good Data’, ‘Comms Error’, ‘Sensor
Error’ and ‘Quality’.

Every time WeatherCat requests data from the weather station it checks it for validity — if it
is all valid then the Good Data count is incremented. If the station fails to respond (a time
out) or responds with data that fails a simple error check then the ‘Comms Error’ count is
incremented. If there is an error in the data - primarily a sensor value that is out of bounds
with regards to the manufacturers specification, then for each error the ‘Sensor Error’
count is incremented. The Quality figure is simply the ratio between the Good Data and
combined errors and can be used as a quick check that communications to the station are
satisfactory. See also the Status window available from WeatherCat’s “Tools” menu.

If you are receiving a lot of ‘Comms Errors’ then the problem lies with the connection
between the computer and the weather station — check your USB dongle and/or driver
along with any USB cables; in particular do not use USB extension cables between the
weather station and your computer and make sure the station is connected to the computer,
not any hubs or keyboards.
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If there are a lot of sensor errors then the problem lies between the weather station and its
sensors — if wireless try repositioning the station, if wired, check the connections. In all
cases it’s worth checking any batteries. (Note, for Davis Vantage owners, WeatherCat can
warn you when batteries and or power supplies are out of specification — see ‘Hardware
Options’ from the ‘Tools’ menu.)

The Live Data tool, available from WeatherCat’s “Tools” menu gives more information
about the status of each channel available from your hardware and breaks down the comms
errors into timeouts (your station did not respond to WeatherCat) and corruption (when
WeatherCat checked the data from your station, an error was found).
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Custom Gauges

e 00 New Gauge 1
v
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Just as there custom graphs, there are also custom gauges. Custom gauges are available

from WeatherCat’s ‘Tools’ menu. WeatherCat can manage up to 16 custom gauges and,

like WeatherCat’s custom graphs, custom gauges can be displayed in custom-web pages
via their web-tag.

Each custom gauge is fully independent of any other gauge and can display any channel(s)

available on your hardware including all extra channels (including any synthetic channels)
as well as daily high/low/average values.
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Features of the gauges include:
e Unlimited gauge size.
* Up to 4 pointers per gauge.
* The main pointer indicates channel data, secondary pointers can be another
channel (WeatherCat decides which channels make sense) or one of daily min/
max/average. It's possible to display for example daily rain versus daily
evapotranspiration on the one gauge.
* Main pointer has two styles.
* Secondary pointers can be a pointer or a 'bug' around the circumference.
* All pointers have variable width, colour and opacity.
* Six base styles.
* Three glass styles.
* Auto or manual scaling.
* Choosable font and attributes for gauge label.
» Usable on web pages via their custom web tag (web size independent of local
display size).
 Ability to clone one gauge from another for quick creation.

When a custom gauge is created, its controls are initially visible. Once the gauge is

configured, click the disclosure triangle to hide the controls - the gauge will expand to fill
the whole window as per the picture below.
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With the controls hidden, double clicking the gauge will remove the window borders and
background, leaving just the gauge.

New Gauge 1

59.4

Dragging a gauge with its controls hidden displays its coordinates in the label area,
allowing accurate alignment of multiple gauges.

When resizing a gauge, the label area displays the current radius. When dragging a gauge
with the window border hidden, holding the control key down will cause the gauge to align
to a 12 by 12 grid to ease alignment with other gauges. Finally, right-clicking on a gauge
will display a pop-up menu allowing you to clone the gauge (useful if you are creating
multiple gauges in the same style) or delete the gauge.

Custom Gauge notes:
a). Daily average calculated cloud-base will display as 0 as WeatherCat does not keep
statistics information for calculated cloud base (however it can calculate the daily high and

low values).

b). A wind rose display is available in the custom gauges. In this mode, the digital display

indicates the scale of the gauge (in user units) - i.e. the length of the longest vector. No
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other channel types are selectable in conjunction with this type. However, selecting 'Daily
High' on any of the other pointers will display the accumulated daily linear wind run
(subject to a maximum of 360 units).

¢). In some situations it may be impossible for WeatherCat to compute a solution for a
suitable scale for the gauge - in this case the scale will appear blank. The workaround is to
switch to manual scaling.
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Custom Text Windows

O O This Week
Weekly High Weekly Low Weekly Average
Temperature 7.3 (4 Feb 2018 5:45 PM) 7.3 (4 Feb2018 5:48 PM) 7.3
Humidity 88 (4 Feb 2018 5:45 PM) 88 (4 Feb 2018 5:45 PM) 88
Dew Point 5.4 (4 Feb 2018 5:48 PN) 5.4 (4 Feb 2018 5:45 PM) 54
Av. Wind Speed 0.00 (4 Feb 2018 5:45 PM) 0.00 (4 Feb 2018 5:45 PM) 0.00
Wind Gust 1 (4 Feb 2018 5:45 PM) 1 (4 Feb 2018 5:45 PN) 1.2
Pressure 1033.8 (4 Feb 2018 5:45 PN) 1033.8 (4 Feb 2018 5:48 PNM) 1033.8
Rain Rate 0.0 (4 Feb 2018 5:45 PM) 0.00 (4 Feb 2018 5:45 PM) 0.0000
Weekly Totals
Rain 0.0
Wind Run 0.00

Just as there are custom graphs and gauges, there are also custom text windows.
A custom text window is a window you can create and edit to have just the data you want
in it.

Custom text windows (CTW's) can be found in the Tools menu. There can be an unlimited
number of CTW's. On installation, example weekly and monthly windows are created and
will appear the the CTW menu - these can be used as an example for building new CTW's.

To create a CTW, use the Tools->Custom Text Window->New menu item.

To delete a CTW, use the Tools->Custom Text Window->Delete menu item.

To create items in a CTW, ctrl-click in the window. A pop-up menu lists items that can be
added (the window name can also be set from this menu as well as other functionality).
These items consist of time and date, the channels available from your station and STATS
tags (see Custom Web for more details of STATS tags).

To edit an editable item, click it. To edit an items attributes (font, colour etc), first click the

item to make it editable then ctrl-click in the item where a pop-up menu will list the
available options.
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Multiple items can be selected by cmd-clicking items. Items can be dragged with the
mouse or moved via the keyboard arrow keys by holding down the alt key whilst using the
arrow keys (the window's title bar will indicate the coordinates of the item).

Selected items can be copied with cmd-c. Items can be pasted with cmd-v (items can be
copied and pasted between CTW's).

Items can be cleared either by selecting delete this item in the pop-up menu (for a single
item) or using the Edit menu 'Clear' command when multiple items are selected.

All items in a CTW can be selected with cmd-a. cmd-z will undo the last operation.

The background image for a CTW can be set by dragging an image over the window.
You can save a Custom Text Window (CTW) from its pop-up menu. Similarly, individual
Custom Text Windows can be loaded from the Custom Text Window's menu (Tools-

>Custom Text Windows->File->Load... ).

All CTW's can be saved and loaded as a set from the CTW menu (Tools->Custom Text
Windows->File->Save Set.../Load Set...).

Note: Loading a CTW set replaces your current CTW's with the CTW's in the set being
loaded.

Note also that the only web-tag you can use in a CTW is the STATS tag, all other tags will
be unrecognised.
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Satellite Imagery
WeatherCat can record and play back up to 3 channels of satellite imagery.

By default, imagery is disabled. To enable, open WeatherCat’s preferences and go to the
Imagery tab. For each channel, select a suitable source (or enter your own) and enable the
channel. The first image will appear within the time-frame set as the update period for that
channel.

There are two modes of operation for the imagery viewer: the first is to play back the
imagery as a movie by setting the animation length and speed from the controls at the
bottom of the window.

The second is in conjunction with WeatherCat’s daily view window. As you scroll through
time with the scroll buttons, if the imagery window is open, the imagery will update in
synchronisation with the data — this allows you to scroll backwards and forwards through
the imagery animation (this also works for direct date entry).
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The imagery is stored in WeatherCat’s database on disk at: ~/Library/WeatherCatData/
Imagery as jpeg files. Each file is named ‘Imagery hh mm dd mm yy,jpg’ to aid
identifying each file by date.

It is important to note that the update rate of the imagery (how often WeatherCat captures
an image) has a direct effect on how large your database on disk will be. We would
recommend setting the imagery update rate to no less than 2 hours and ideally, for the best
animation and most efficient usage of space on disk, it should update at the same rate as
the source image is updated. For example, if your source image is updated every 3 hours,
and you set the update rate to every 2 hours then WeatherCat is going to be capturing some
images twice. For example (assuming the source updates every 3 hours and WeatherCat is
capturing every 2 hours): The source updates at 00:00 and WeatherCat captures it at that
time. The next WeatherCat capture will be at 02:00 — the same image. The image changes
at 03:00, WeatherCat captures it at 04:00. The image changes at 06:00, WeatherCat
captures the new image. WeatherCat captures the same image at 08:00 and so it repeats. In
this case, WeatherCat has captured the 00:00 image twice and the 06:00 twice, setting
WeatherCat’s capture rate to 3 hours will ensure each image is only captured once.

Over the months and years, a large number of files can accumulate on disk; you may want
to prune or archive them periodically. As an example, an imagery file of average size
30KB, captured every 2 hours results in more than 4300 files totalling over 130 megabytes
on disk each year.
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Statistics/Reports

The Statistics tool displays a range of statistics and reports. Select the report you’d like to
see from the buttons at the top of the window.

St

Records  Recent | Daily | Monthly Year Over Year

Statistics as of 8:15 PM 17-Feb-2012

Local

Hour TempHiTempLo HeatHi HeatLo ChillHi ChillLo DewPHi DewPLo HumHi HumLo PresHi  PreslLo R/AHI  R/Lo Rain
a 43.1 42.7 43.1 42.7 41.8 38.1 39.5 38.9 88 85 36.11 36.11 8.00 8.00 9.08
1 43.1 42.9 43.1 42.9 41.7 37.6 39.6 39.8 88 86 38.11 36.18 8.86 8.08 8.08
2 42.9 42.2 42.9 42.2 38.9 37.8 39.9 39.0 =L} 28 38.11 36.89 a.80 a.00 8.08
3 42.5 41.7 42.5 41.7 40.2 37.8 40.2 39.5 az =] 30.09 30.88 8.00 8.00 9.08
4 41.7 41.4 41.7 41.4 38.3 37.5 39.7 39.3 a3 9z 36.69 30.88 8.00 8.08 8.08
S 41.7 41.2 41.7 41.2 41.2 37.8 39.8 39.1 a3 92 30.88 30.86 a.00 8.00 8.00
6 42.4 41.7 42.4 41.7 38.6 37.5 48.5 39.8 a3 a3 30.87 30.86 a.00 8.00 8.00
7 42.4 42.2 42.4 42.2 39.3 37.5 48.5 40.3 a3 a3 30.87 30.85 8.00 8.00 9.08
g 42.9 42.1 42.9 42.1 39.5 37.2 41.8 39.9 a3 92 30.85 30.84 a.00 @.00 @.00
] 43.6 43.8 43.6 43.8 39.5 38.0 42.0 41.1 94 az 30.85 30.83 a.80 8.00 8.01
18 44.9 43.7 44.9 43.7 41.8 38.1 42.1 41.6 a4 89 30.83 30.83 8.00 8.00 9.08
1 45.1 44.6 45.1 44.6 41.8 39.8 42.3 42.8 =1 29 360.83 36.62 8.08 8.08 a.08
12 45.9 45.8 45.9 45.8 42.3 48.2 42.1 41.6 29 85 30.62 29.99 a.80 8.00 8.08
13 46.4 46.8 46.4 46.8 42.2 48.5 41.8 40.9 a5 =74 30.00 29.97 8.00 8.00 9.08
14 46.8 45.6 46.8 45.6 43.1 41.3 42.2 41.6 87 85 29.97 29.92 8.06 8.08 8.08
15 45.8 45.5 45.8 45.5 44.9 41.3 43.6 41.9 =¥ a7 29.92 29.88 a.60 8.00 8.00
16 47.6 45.8 47.6 45.8 45.8 43.3 46.5 43.9 6 a3 29.88 29.83 8.00 8.00 8.00
17 48.6 47.6 48.6 47.6 45.1 43.3 47.5 46.5 a6 a6 29.83 29.81 8.00 8.00 9.08
18 48.6 48.5 48.6 48.5 45.9 43.3 47.5 46.8 a6 a4 29.82 29.79 a.60 8.00 8.00
19 48.9 48.5 48.9 48.5 45.9 44.1 47.0 46.6 a4 az 29.79 29.76 a.80 8.00 8.08
20 48.9 48.8 48.9 48.8 45.8 44.2 46.7 46.6 az az 29.76 29.75 8.00 8.00 9.08
Daily High 48.9 48.8 48.9 48.8 45.9 44.2 47.5 46.8 a6 a6 38.11 36.11 a.80 a.00 8.01
Daily Low 41.7 41.2 41.7 41.2 38.3 37.0 39.5 38.9 85 82 29.76 29.75 8.00 8.00 9.08
Dai ly Average 44.9 44.3 44.9 44.3 42.8 39.8 42.5 41.7 9z =] 29.99 29.97 8.00 8.06 8.08
Dai ly Total 6.8

The statistics are updated every time WeatherCat takes a sample.

At midnight every day, the Daily report is saved to disk at ~/Documents/
WeatherCatReports as a PDF file.

At the end of the month, the monthly report is also saved to the same location on disk.
(Note that if WeatherCat isn’t running at midnight, then no report will be saved).

From the Statistics window you can also query the database via the ‘Query’ button. A sheet
will appear as shown in the image below:
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’ M Minimum  Average @ Total }—

Find The Maximum: | Temperature % |

During The | Last 24 Hrs ]

Between 21:33 Wed Nov 28 2012

And 21:33 Thu Nov 29 2012

Result:
The highest temperature recorded for WMR200 over the above
date range is 0.3 °C on 29-Nov-2012 at 03:23 PM.

| Done | | Find |

When processing a query, the database only considers valid samples; interpolated and
invalid samples are not considered.
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NOAA Style Reports

Monthly and annual NOAA style reports are available and can be calculated for all years/
months present in your WeatherCat database.

® 00 NOAA Style Reports
| Monthly | Annual]

ANNUAL CLIMATOLOGICAL SUMMARY FOR 2015

NAME: Branchalwood
ELEV: 420.0 Feet LAT: ©55° 47' 34" N LONG: -@3° -54' -39" W

TEMPERATURE (°C), HEAT BASE 16.5, COOL BASE 16.5

DEP HEAT (COOL
MEAN MEAN FROM DEG  DEG MAX MAX MIN MIN
YR MO MAX MIN MEAN NORM DAYS DAYS HI DATE LOW DATE >=25 <=0 <=0 <=-5

15 1 6.3 2.9 3.5 0.4 403 9 12.4 1 -5.8 19 ] 7] 11 1
15 2 6.8 1.1 3.8 -0.0 356 o 11.8 18 -6.7 3 7] ] 10 2
15 3 9.1 2.2 5.5 0.2 341 9 12.2 28 -1.6 25 7] 7] 5 ]
15 4 13.2 2.6 7.9 0.1 259 2 20.3 22 -2.1 27 ] 7] 4 7]
15 5 13.4 5.4 9.2 -1.2 228 9 18.2 23 -1.2 1 %} (7} 1 (]
15 6 16.6 7.8 12.1 -1.0 124 7 23.6 11 2.7 8 (%] (] (%] (]
15 7
15 8
15 9
15 10
15 11
15 12

10.9 3.4 7.0 -0.3 1709 8 23.6 6 2.7 6 (%} [} 31 3

PRECIPITATION (mm)
| Save | | SaveAll | {June 3 [ 2015 ]

Monthly and Annual NOAA reports are automatically saved to disk at ~/Documents/
WeatherCatNOA AReports/. The current monthly report is updated every sample, the
current annual report is updated hourly on the first sample past the hour. The report is
saved as a simple text file (.txt).

A 'Save' button on the NOAA reports window will save the report currently being
displayed to disk at ~/Documents/WeatherCatNOA AReports/ (folders will be created for
the year/month if they do not exist).

The ‘Save All’ button is useful if you wish to generate a complete set of reports from your

database or you have changed something which would affect all historical reports (heating
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degree days base temperature for example). This will save all NOAA style reports to disk
(overwriting any existing ones). This processing can take a while so is carried out as a
background task. Task start and end are reported in the WeatherCat log window along with
how long the task took to run.

The extreme high and low temps for NOAA reports can be set in the 'Advanced' pane of
WeatherCat's preferences (defaults are a high of 90°F/32.2°C and a low of 0°F/-17.7°C).

NOAA style report web-tags are also available for use on custom web pages. Please see
the Custom Web section of this manual for more details.
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Live Video Preview

WeatherCat can utilise a webcam to provide images and movies both locally and for your
website. This tool displays the current picture, which is useful for checking the camera set-

up.

® 00 Video Preview
' —'ﬁamﬁnnking Moit

Temperature 19 S (-0°2
“ Dew Point: 12:5 (021):
pHumidity: 64 ( 1) W
Pressure? 102783 (-0: 75
AV. Wind Sgeed 0.00 (000
10 Min Gust: 04" 0)
Wind Dir. Eby N
Rain Rate: 0.00 (0.00)
Daily Rain: 0.00 (0.00) 13 Sep 2014 16:05

(¥ Scale Image To Fit [ Camera Adjustments |

The ‘Camera Adjustments’ button will open a window where various parameters can be
adjusted — the parameters available will depend on your camera and how WeatherCat is
obtaining the image.

WeatherCat can take an image from a locally connected camera, from a file on disk (useful
if you are using third party camera software) or via http, which is useful if you have an IP
based camera with an in-built web-server that can make the image available.

If updating from a local file, the image will update once every 2 seconds. If updating from
an image served over http, the image will update once every 2 seconds if the preview
window is open, otherwise at the capture rate set in the Webcam preferences (or 5 minutes,
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whichever is the shorter). From a locally connected USB camera, the image will update
approximately 10 times per second.

For more information on the camera set-up and usage, please see “How Do I Use A
Webcam With WeatherCat’ and the webcam preferences section.
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Data Viewer/Editor

This tool, as its name suggests, allows you to view your data by date in tabular form. You
can also apply quick edits to the data — WeatherCat allows you to edit most of the channels
it records, the exception being calculated channels such as wind chill. To edit other data or
make more than simple changes we would suggest using a good text editor® — please see

‘WeatherCat And Data’ later in this manual for more details.

e OO Data Viewer/Editor
29/11/2012 )
| Time | Ext. Temp Dew Point  Wind Chill Pressure Ext. Hum Rain/h Daily Rain | Ra
00:00 -2.60 -4.3 -2.6 1018.000 88 0.00 0.00 2
00:03 -2.60 -4.3 -2.6 1018.000 88 0.00 0.00 2
00:04 -2.70 -4.4 -2.7 1018.000 88 0.00 0.00 2
00:06 -2.70 -4.4 -2.7 1018.000 88 0.00 0.00 2
00:09 -2.70 -4.4 -2.7 1018.000 88 0.00 0.00 2
00:12 -2.70 -4.4 -2.7 1018.000 88 0.00 0.00 2
00:14 -2.70 -4.4 -2.7 1017.000 88 0.00 0.00 2
00:15 -2.70 -4.4 -2.7 1017.000 88 0.00 0.00 2
00:16 -2.70 -4.4 -2.7 1018.000 88 0.00 0.00 2
00:17 | -2.70 -4.4 -2.7 1017.000 88 0.00 0.00 2
00:18 -2.70 -4.4 -2.7 1017.000 88 0.00 0.00 2
00:19 -2.80 -4.5 -2.8 1017.000 88 0.00 0.00 2
00:21 -2.80 -4.5 -2.8 1017.000 88 0.00 0.00 2
00:24 -2.80 -4.5 -2.8 1017.000 88 0.00 0.00 2
00:27 -2.80 -4.5 -2.8 1017.000 88 0.00 0.00 2
00:30 -2.80 -4.7 -2.8 1017.000 87 0.00 0.00 2
00:33 -2.80 -4.7 -2.8 1017.000 87 0.00 0.00 2
00:36 -2.80 -4.7 -2.8 1017.000 87 0.00 0.00 2
00:39 -2.80 -4.7 -2.8 1017.000 87 0.00 0.00 2
00:42 -2.80 -4.7 -2.8 1017.000 87 0.00 0.00 2
L

[2] Grid Lines @Alternating Rows |W

6 Do not use a word processor or web editor — use a good text editor designed for editing raw text — something like BBEdit.

(available from Bare Bones: http://www.barebones.com/products/bbedit/)
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Daily Snow Editor

WeatherCat has a snow editor available from the ‘Tools’ menu. Daily snow can be entered
and will be displayed in the year over year statistics (monthly totals and snow days) as
well as in the monthly statistics.

.0 O O ~ Daily Snow Editor . |

Use this tool to add, edit and delete daily snow accumulations.
Entries here affect any statistics that include cummulative
snow and custom web STATS tags using the SNOW variable
type. Double click an item to edit it.

2 Feb 2014 : Daily value = 0.30 in.

13 Dec 2013 : Daily value = 0.50 in.

Snow data can be accessed in custom web tags with the SNOW and SNOWDAYS item.

Daily snow can be entered for any date in WeatherCat's database including 'today'. It is not
possible to enter snow either before the first date in WeatherCat's database or in the future.
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When entering snow for a day, enter the new snow for that day, not the current total depth
as WeatherCat adds daily values together to calculate accumulated snow over a given time
range.

Example STATS tag usage:

Snow this season: STAT$SNOW:TOTAL:THISSEASON$

Snow this year: STAT$SNOW:TOTAL:THISYEAR$

Snow this week: STAT$SNOW:TOTAL:THISWEEK$

Snow today: STAT$SNOW:TOTAL:TODAY$

Snow tomorrow: STAT$SNOW:TOTAL:TOMORROW$ (J/K)

Snow days this year: STAT$SNOWDAYS:TOTAL:THISYEARS
Snow days last year: STAT$SNOWDAYS:TOTAL:LASTYEARS

etc.

Snow notes:

a). If there are no snow entries at all, then snow won't show in the year over year statistics.
b). The SNOW and SNOWDAYS items honour the rain season - so THISYEAR and
THISSEASON may give different results if your rain season is not set to January.

c). SNOW and SNOWDAYS will only work with the TOTAL custom web stats tag query

type.
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Daily Rain Editor

WeatherCat has an easy-to-use daily rain editor available from the ‘Tools’ menu - this is
useful for those occasions where you know the daily rain for a given date is wrong or isn't
available until after the event (i.e. melting snow). Note: It is not possible to edit the daily
rain for the current day (as the day is not yet over); wait until the next day to edit it. The
editor affects all statistics queries (reports, tags etc) that output accumulated rain where the
edited day is included in the date range of the query. When this tool is selected, a list of
existing edits is displayed, sorted by date:

eno Daily Rain Editor

Use this tool to add, edit and delete daily rain edits. An edit overrides the
calculated value for daily rain and affects all cumulative rain stats that include the
day. Double click an item to edit it.

10 Oct 2008 : Recorded value = 48.00 mm. Edited value = 25.00 mm.

| —E——. ———————
[ Delete ) : New )
Ne—

Pressing the ‘New’ button will display the following sheet:
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Date To Edit:

OO0 October 2008

M TWTF S S

12345
6 7 8 9flil11 12
13 14 15 16 17 18 19
20 21 22 23 24 25 26
27 28 29 30 31

Edited Daily Rain:

Recorded Daily Rain: 48.00

25.00

mm

mm

( Cancel ) (——OI(—-)

Use the calendar to select the day you wish to edit — the current daily rain value will be

displayed. Enter the new value and press the OK button.
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Synthetic Channels

Synthetic channels are channels created by WeatherCat and added to the available channels
from your station.

e OO Synthetic Channels Editor

You can configure up to 5 synthetic channels. A synthetic
channel takes other channels as inputs and applies a function
to that data to create a new channel. Double click a channel to

configure it.

Av. Temp. Enabled. Current value = 56.1°F
Heating Load. Enabled. Current value = 12.20
Daily Water Gain. Enabled. Current value = -0.04
Synthetic Channel 4 Disabled.

Synthetic Channel 5 Disabled.

Synthetic channels act as per normal channels with the exception that the data is user
defined by a function written in AppleScript.

The function can take up to 5 existing channels (or none) as input parameters and return a
new value, calculated by the function, which is then recorded by WeatherCat. In addition

daily high/low/average data can be used as input parameters.

It is also possible to use a synthetic channel to pull in data from external sources via
AppleScript - for example Lunar data from a web-site.

Up to 5 synthetic channels can be defined, these are added to the channels from your
hardware and act and be used as any other channel.

Synthetic channels can be displayed on custom graphs or custom gauges.
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Synthetic channel values can be used on custom web pages via the following STATS tag

types:
SYNI1,SYN2,SYN3,SYN4 and SYNS.
Examples:

Current Synthetic Channel 1 value and one hour delta: STAT$SYN1:CURRENT$

(STAT$SYN1:DELTA1S$)
Lowest Synthetic Channel 1 value this week = STAT$SYN1:MIN:THISWEEK$ at

STAT$SYN1:MIN: THISWEEK: TIME$
Average Synthetic Channel 1 value this week = STAT$SYN1:AVERAGE:THISWEEK$

etc.

The channel function is defined in AppleScript - for example:

— Simple heating/cooling load index (where +100 is max heating load and

-100 is max cooling load).

— The basic load is calculated from the difference between the internal and
external temperatures.

— Assume temperature units are Fahrenheit.

— To use:

— Set Param1 to internal temperature

— Set Param?2 to external temperature

— Set the Channel Type to ‘No units’.

— Get the temperature difference between internal temperature and external
temperature into a variable called diff
set diff to Param1-Param?2

— We set the maximum differential temperature to +/-50°F
if diff > 50 then set diff to 50

if diff <-50 then set diff to -50

—multiply by 2 to convert to an index in the range +/-100

set result to diff*2
return result

There is no limit on the complexity of the function.

To edit a synthetic channel, double click it from the editor window - a sheet will appear
with the options for the channel.
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SNsNs) Synthetic Channels Editor

Channel Name:[Heaﬁng Load 1 (¥ Enabled
'Param1':| Int. Temperaturé — +| | Current Value 3 \
'Param?2':| Ext. Temperature +| | Current Value 3 \
'Param3": | None — s | | Current Value
'Param4’: | None s | | Current Value
'Param5':| None 4| | Current Value
Channel Type:| No units Al

Enter an AppleScript function using the variables 'Param1' through 'Param5’. The result of
this formula is the value of the synthetic channel. For example:

return Param1-Param2

Channel Function

— Simple heating/cooling load index (where +100 is max heating load and
-100 is max cooling load).

— The basic load is calculated from the difference between the internal and
external temperatures.

— Assume temperature units are Fahrenheit.

— To use:

— Set Param1 to internal temperature

Status: Current value = 11.60

. Forget Previous | | Test | [OK ]

The function can take up to 5 parameters defined by the ‘Param1’ through ‘Param35’ pop-up
menus. For each parameter you have the choice of the current value, the current daily high,
daily low or daily average.

These parameters are used in your script as variables Param1 through ParamS5.

The ‘Channel Type’ tells WeatherCat how to display the data - for example if it’s set to
temperature then the value will display as X.X °F if your temperature units are set to
Fahrenheit. If the data has no units, be sure to set the channel type to no units.

The “Test’ button will cause the function to run - the ‘Status’ area will indicate any errors,
or if there are none, the current result of the function.
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A 'Forget Previous' button is available in the synthetic channel edit window - this will
cause WeatherCat to forget all the data previously recorded for the channel (which is
useful if the channel function or type has changed).

It is also possible to query WeatherCat’s AppleScript interface from a Synthetic channel,
thus allowing channels to be built from queries. For example, the following channel
function records the monthly average temperature:

set Query to "STATSTEMPERATURE:AVERAGE:THISMONTHS$"
set result to QueryResult

This type of function requires no input parameters.

Synthetic channel's notes:

a). Synthetic channels are dependent on their input channels if used - if an input channel
becomes invalid, the synthetic channel will also become invalid.

b). Input channels are converted into user units before being passed to the synthetic
channel function.

c). Synthetic channels can be enabled and disabled - if disabled, they are not recorded.

d). Synthetic channels values are not calculated for historical data (i.e. data downloaded
from the logger because WeatherCat was not running). Synthetic channel data will be
interpolated across these periods.

e). Be sure not to introduce an infinite loop into a channel function, this will cause
WeatherCat to hang requiring a forced quit. Should this happen, boot up WeatherCat into
'Safe mode' (hold the 'ctrl' key down whilst launching WeatherCat), then edit the synthetic
channel to remove the loop, quit WeatherCat, then relaunch it normally.

f). Synthetic channels are not currently available via WeatherCat's AppleScript interface
nor do they appear in the data viewer/editor.

g). After using the 'Forget Previous' button for a synthetic channel, it can be up to an hour
before the data is actually forgotten.

h). Synthetic channel values are calculated each time WeatherCat receives data from your
station.

1). If there is no channel function, the last parameter defined will be returned.

J)- Renaming a synthetic channel currently requires a reboot of WeatherCat before the new
channel name is visible in custom gauges and graphs.

k). External data can be pulled in to a channel function via AppleScript (for example
electricity or gas consumption data) but be sure this processing is quick - due to operating
system restrictions, channel functions execute on WeatherCat’s main thread and will
impact Ul responsiveness if the processing time for the channel function is significant.
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Update Weather Now
This menu item forces WeatherCat to take a sample now.

The Journal

eSO Journal

Journal For Local

03-Jan-2012, 12:00 Again broke our highest windspeed record; this time 64MPH.

08-Dec-2011 9:24 PM
25-Nov-2011 9:57 PM

([ Show Entry On Graphs ) | Retrospective Entry | ( Delete Entry ) { New Entry )

WeatherCat provides a journal in which you can record notes about the weather. The
journal automatically time-stamps each entry and can be uploaded to your web pages as a
simple weather blog.

The layout of the journal is as two panes; the left pane shows journal entries, with newest
at the top. The right pane shows the actual journal entry.

To Create A New Entry

To create a new entry either click the ‘New Entry’ button at the bottom right of the journal
or simply start typing in the right hand text field.
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Links and in-line images can be inserted via the following html:
Link: <A HREF="http://some.link.com" target="_blank">A cool link</A>
Image: <img src="url" alt="descriptive text"/>

(Note: The double quotes in the code are needed).

Examples:
Link Test:
<A HREF="http://www.trixology.com/" target="_blank"> Trixology</A>

Image Test:
<img src="tempout.jpg" alt="Temperature gauge"/>

Links and images will not be displayed in the Journal window within WeatherCat, but will
be displayed once uploaded to your web-site.

To View An Entry
To view a journal entry, double click it in the left hand pane.

To Edit An Entry
To edit a journal entry, first double click it then edit the text in the right hand pane.

To Delete An Entry
To delete a journal entry, select an entry in the right hand pane then hit the ‘Delete Entry’
button.

To View The Data For An Entry
To view the data for a journal entry, first select the entry in the right hand pane, and then
hit the ‘Show Entry On Graphs’ button.

Status

This shows the state of various internal systems and can help quickly diagnose problems.
Please note: Weathercat 1s designed to automatically recover from failures where-ever
possible - sometimes this can take up to an hour. Your first course of action when noticing
a problem is to just leave WeatherCat alone for an hour to see if the problem clears up.

The FTP section shows the state of WeatherCat’s FTP queues — the longer the bar, the
more files are queued for upload. If the FTP queues become full, you’ll receive an admin
email — typically this indicates a problem either with your local Internet connection
(commonly the cause), or the FTP server (rare).
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The On-Line Services section shows the state of some of the on-line services WeatherCat
can send data to. Figures separated by a ‘/° character indicate the number of transmissions
versus the number of acknowledgements for that service.

WeatherCat Core shows the current communications quality to your hardware, the status of
the webcam and the watchdog. The Watchdog is a separate task within WeatherCat that
monitors WeatherCat for hangs — it will reboot WeatherCat if it detects a problem or if
WeatherCat unexpectedly quits (if enabled in WeatherCat’s preferences).

e OO WeatherCat Status
WeatherCat: V1.10, Build 1738 % Uptime: 0:00:14:30
FTP
Main FTP : Bytes Sent: 1017.57 KB
Status: Idle
Aux FTP: Bytes Sent: 0
Status: Idle
Total Bytes Sent: 1017.57 KB
On-Line Services
Wunderground: Disabled Packets: 0/0
Custom C.GC.l.: Disabled Packets: 0/0
C.W.O.P.: Disabled Packets: 0/0
Custom Web: Idle Last Run: 9:28 PM
Simple Web: Disabled Last Run: N/A
WeatherCat Core
Station Comms: Excellent (100.00%) Cood Data: 143
Comms Errors: 0 Sensor Errors: 0
Webcam: Disabled
WatchDog: Disabled
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Data Export

You can export data manually or on a daily schedule from WeatherCat using the Export

tool. The data is exported as a comma separated values file (.csv), which should ope
directly in your favourite spreadsheet software.

e OO Data Export

n

[ Manual - Scheduled '

Data

®) Export Weather Data At ' 10 Minute Intervals
(O Export Hourly Data

|| Use Tab Delimiters

Period
() Today () Last Month
() Yesterday () This Year
() This Week () Last Year
() Last Week () All Time
() This Month (0 User Specified Date Range
Date Range
From To
July 2013 July 2013
M TWTF S S M TWTF S S
1 2 4 5 6 7 1 2 4 5 6 7
8§ 910111213 14 8§ 910111213 14
15 16 17 18 19 20 21 15 16 17 18 19 20 21
22 23 24 25 26 27 28 22 23 24 25 26 27 28
29 30 31 29 30 31

/' Y /' . Y / Y
( Cancel ) ( Preview ) ( Export... )

Two types of export are available - weather data or hourly data. The weather data is

exported at the period specified, the hourly data consists of hourly minimum, maximum
and average except for accumulated precipitation which is the total accumulated for the

hour. All data is converted to user units.
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Convenience date selectors are available (today, this year, etc.), custom ranges can be
created by clicking the calendars to set the 'from' and 'to' dates. If the date range doesn't
make sense, the export button will be greyed out. The export period can be set for raw
weather data (i.e. every ten minutes). To export a particular day, select the same date on
both calendars.

Daily exports can be selected to run automatically (this feature is off by default) via the
‘Scheduled’ tab. Auto-exports are stored in ~/Documents/WeatherCatExports/year/month/
HourlyData and WeatherData (where ~ is your home directory). A daily export will run at
the first opportunity - WeatherCat doesn't need to be running around midnight for the
export to be processed (for example if WeatherCat is off for the night, the export for
yesterday will happen when it's launched in the morning).

The ‘Preview’ button will show you what will happen when you hit the ‘Export..." button
— the data will not be written to disk during a preview. Be aware that some spreadsheet
software is limited to 65536 rows (i.e. samples).

e OO0 Export preview

WeatherCat Data Export created at 17:39:09 14-Nov-12

Data for Branchalwood follows.

Date, Conditions, Temperature, Dew point, Pressure, Wind speed, Wind gust, Wind direction, Rain/h,
Rain, Humidity, Internal humidity, Internal temperature, Sciar, UV,
2012-11-14T00:06:00,0vercast,8.7,7.0,1017.851,0.805,1.566,90,0.00,296.10,89,48.000,20.5,0,0.0,
2012-11-14T00:16:00,0vercast,8.7,7.0,1017.958,0.000,2.237,59,0.00,296.10,89,48.000,20.4,0,0.0,
2012-11-14T00:26:00,0vercast,8.6,6.9,1017.963,0.805,1.566,60,0.00,296.10,89,47.000,20.3,0,0.0,
2012-11-14T00:36:00,0vercast,8.6,6.9,1018.064,0.000,0.671,50,0.00,296.10,89,47.000,20.3,0,0.0,
2012-11-14T00:46:00,0Overcast,8.5,6.8,1017.963,0.000,0.671,46,0.00,296.10,89,47.000,20.3,0,0.0,
2012-11-14T00:56:00,0vercast,8.5,6.8,1017.963,0.000,0.000,39,0.00,296.10,89,47.000,20.3,0,0.0,
2012-11-14T01:06:00,0vercast,8.5,6.8,1017.968,0.000,0.000,54,0.00,296.10,89,47.000,20.2,0,0.0,
2012-11-14T01:16:00,0vercast,8.5,6.8,1018.070,0.000,0.000,13,0.00,296.10,89,47.000,20.2,0,0.0,
2012-11-14T01:26:00,0vercast,8.4,6.7,1018.075,0.000,0.000,5,0.00,296.10,89,47.000,20.1,0,0.0,
2012-11-14701:36:00,0Overcast,8.4,6.7,1017.973,0.000,0.000,47,0.00,296.10,89,47.000,20.1,0,0.0,
2012-11-14T01:46:00,0vercast,8.3,6.6,1018.080,0.000,0.000,80,0.00,296.10,89,47.000,20.0,0,0.0,
2012-11-14T01:56:00,0vercast,8.4,6.7,1018.283,0.000,0.000,87,0.00,296.10,89,47.000,20.0,0,0.0,
2012-11-14T02:06:00,0vercast,8.4,6.7,1018.390,0.000,0.000,89,0.00,296.10,89,48.000,19.9,0,0.0,
2012-11-14T02:16:00,0vercast,8.5,6.8,1018.288,0.000,0.000,80,0.00,296.10,89,48.000,19.9,0,0.0,
2012-11-14T02:26:00,0vercast,8.5,6.8,1018.288,0.000,0.000,90,0.00,296.10,89,48.000,19.9,0,0.0,
2012-11-14T02:36:00,0vercast,8.5,6.8,1018.395,0.000,0.000,90,0.00,296.10,89,48.000,19.8,0,0.0,
2012-11-14T02:46:00,0vercast,8.6,6.9,1018.293,0.000,0.000,90,0.00,296.10,89,48.000,19.8,0,0.0,
2012-11-14T02:56:00,0vercast,8.6,6.9,1018.293,0.000,0.000,90,0.00,296.10,89,48.000,19.8,0,0.0,
2012-11-14T03:06:00,0vercast,8.7,7.0,1018.299,0.000,0.000,90,0.00,296.10,89,48.000,19.7,0,0.0,
2012-11-14T03:16:00,0vercast,8.8,7.1,1018.096,0.000,0.000,90,0.00,296.10,89,48.000,19.7,0,0.0,
2012-11-14T03:26:00,0vercast,8.9,7.2,1018.197,0.000,0.000,90,0.00,296.10,89,48.000,19.7,0,0.0,
2012-11-14T03:36:00,0vercast,8.9,7.2,1018.202,0.000,0.000,90,0.00,296.10,89,48.000,19.6,0,0.0,
2012-11-14703:46:00,0vercast,9.0,7.1,1018.202,0.000,0.000,90,0.00,296.10,88,48.000,19.6,0,0.0,
2012-11-14703:56:00,0vercast,9.1,7.2,1018.202,0.000,0.000,90,0.00,296.10,88,48.000,19.6,0,0.0,
2012-11-14T04:06:00,0vercast,9.2,7.3,1018.207,0.000,0.000,90,0.00,296.10,88,48.000,19.5,0,0.0,
2012-11-14T04:16:00,0vercast,9.2,7.5,1018.308,0.000,0.000,80,0.00,296.10,89,48.000,19.5,0,0.0,
2012-11-14T04:26:00,0vercast,9.1,7.2,1018.308,0.000,0.000,80,0.00,296.10,88,48.000,19.5,0,0.0,
2012-11-14T04:36:00,0vercast,9.1,7.4,1018.308,0.000,0.000,80,0.00,296.10,89,48.000,19.5,0,0.0,
2012-11-14T04:46:00,0vercast,9.2,7.5,1018.618,0.000,0.000,80,0.00,296.10,89,48.000,19.4,0,0.0,
2012-11-14T04:56:00,0vercast,9.3,7.6,1018.517,0.000,0.000,80,0.00,296.10,89,48.000,19.4,0,0.0,
2012-11-14T05:06:00,0vercast,9.4,7.7,1018.517,0.000,0.000,90,0.00,296.10,89,48.000,19.4,0,0.0,
2012-11-14T05:16:00,0vercast,9.4,7.7,1018.720,0.000,0.000,90,0.00,296.10,89,48.000,19.4,0,0.0,
2012-11-14T05:26:00,0vercast,9.5,7.8,1018.725,0.000,0.671,116,0.00,296.10,89,48.000,19.3,0,0.0,
2012-11-14T05:36:00,0vercast,9.5,7.8,1018.725,0.000,0.000,128,0.00,296.10,89,48.000,19.3,0,0.0,
2012-11-14T05:46:00,0vercast,9.7,8.0,1018.928,0.000,0.000,74,0.00,296.10,89,48.000,19.3,0,0.0,
2012-11-14705:56:00,0vercast,9.6,7.9,1018.832,0.000,0.000,55,0.00,296.10,89,48.000,19.2,0,0.0,
2012-11-14T06:06:00,0Overcast,9.5,7.8,1018.934,0.000,0.000,48,0.00,296.10,89,48.000,19.2,0,0.0,

B T P PP
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Backups
Once per day, WeatherCat will create a backup copy of the WeatherCatData folder.

You can set the time of the backup (20:00 local by default), where the backups are stored
(by default ~/Library/WeatherCatBackups) and how many days backups should be kept for
(default is 7 days).

You can also request admin emails to be sent out when a backup is performed (by default
this is on) - this email will indicate the result of the backup which will either be 'success' or

report an appropriate error message should the backup fail.

You can also manually schedule a backup via the 'Backup' button (the backup will start
within approximately 10 seconds).

e OO Backup

Auto Backup

| Set Backup Path | /Users/stu/Library/WeatherCatBackups

lv)

Daily Backup Time: 22:50 -
Keep Backups For |1 Days @Send Admin Emails
| Backup Now |

Available Backups
Tuesday, 13 November 2012 22:50:07 Greenwich Mean Time

| Restore From Backup |

Data Restore
You can restore the data from a backup copy via the Backup window. A list of backups is

presented, sorted by date - the newest at the top of the list is preselected. Hit the restore
button to restore the data (please be sure before restoring the data that you have enough
data in your data logger to fill in the hole that will be present after the restore is complete).
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During a data restore, WeatherCat is halted and the only available option when the restore
completes successfully is to quit WeatherCat. If the restore fails, your original data will be
untouched and WeatherCat will continue running.

Safe Mode

WeatherCat also supports a special restore mode - hold the 'ctrl' key down when booting
WeatherCat to restore data without fully booting WeatherCat. This is useful if your current
data-set is corrupt.

In 'safe mode', WeatherCat will boot to the Backup window from where a backup set can
be chosen to restore from. No Weather processes will be running in this mode.

Note: It is also possible to edit synthetic channels in safe mode - this is useful if you’ve
introduced an infinite loop in a channel function.

Backup notes

* It is not possible to turn off the daily backup (this is a design decision), you can
however set the length of time to keep backups to 1 day - this effectively limits
WeatherCat to keep just one auto backup.

* The destination for backups can be anywhere, for example a remote volume, but
note that if the target volume is not mounted at time of backup, the backup will fail -
WeatherCat will not 'auto-mount' the target volume.

* Backups run as a low priority background task and will not interfere with normal
WeatherCat operation.

* The backup is a straight copy of your data - the data is not compressed or modified
in any way apart from a 'check’ file that is added to the backup on completion. It is
possible to manually restore a WeatherCat backup by simply replacing the current
WeatherCatData folder with a backup folder (and renaming it to WeatherCatData).

* Only the WeatherCat data folder is backed up - this includes weather data, statistics
data, banner generator data, imagery files, calibration data, channel names, custom
alerts, station maintenance schedule, custom graphs, daily rain edits, additional
custom web uploads. Files excluded include WeatherCat's preferences, any
temporary files (for example the time of the last Wunderground upload), your
custom web page templates and other user data.

* Ifabackup or restore is in progress when WeatherCat is asked to quit, the quit
operation will be held up until the backup/restore completes - you will be notified
via the shutdown window if this is happening.

* Backups have a check file associated with them which is written when the backup
completes - if this check file doesn't exist in the backup (for example the power
went off during the backup operation), the backup will be greyed out in the list of
backups available in the backup window and you won't be able to select it to restore
from.
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Station Options

The facilities available here depend on your weather station hardware. These options can
be accessed from the ‘Tools’ menu under the ‘Station Hardware Options’ menu item.

WS23xx

eV WS23xx Hardware Options

Station Datalogger

~

Set DataLogger Interval: ' 15 Minutes | v]

Your weather station can store historical data in its data log, this is useful
for when WeatherCat is not running. The period set here determines how
often the station stores the information, the lower the time the higher the
resolution but the station will fill its log quicker. Please note that changing
this value also clears any historical data currently in your station.

(] Delete Log After Historical Download

Rain Collector

Area Muliplier: 1.00|

If you've increased the area of your rain collector, enter the multiplier here.
For example, if you've doubled the area of your rain collector, enter 2, if
you've quadrupled the size, enter 4, etc.

Here you can set your data-logger’s logging interval from 1 minute to 2 hours. The
WS23xx series of stations can store 170 samples thus at 15 minute intervals it can store
42.5 hours and at 2 hour intervals, 240 hours (10 days) can be saved.

Note that when setting the archive interval, WeatherCat also clears the data logger.

You also have the option of clearing the data-logger after WeatherCat downloads historical
weather from the station. This can lead to faster down-loads in future.
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WeatherCat also allows you increase the area of your rain collector — this is a common
modification to increase the sensitivity of the rain bucket supplied with the 23xx range.

Davis Monitor/Wizard Options

NeNe Davis Monitor/Wizard Hardware Options

Station Datalogger

Set DatalLogger Interval: ' 15 Minutes ﬂ

Your weather station can store historical data in its data log, this is useful
for when WeatherCat is not running. The period set here determines how
often the station stores the information, the lower the time the higher the
resolution but the station will fill its log quicker. Please note that changing
this value also clears any historical data currently in your station.

Station Time

[Y] Synchronize station clock

WeatherCat can make corrections to your station clock to keep it
synchronized with your computer's clock. If the above box is ticked then
the station clock is synchronized with your Mac's clock at quarter past
midnight every day.

Console Rain

M Clear Console Daily Rain At Midnight

WeatherCat will clear your console's daily rain counter at midnight if this
box is ticked.

Here you can set your data-logger’s logging interval from 1 minute to 2 hours. The Davis
Monitor and Wizard series of stations can store 1560 samples, so at 15-minute intervals it
can store 390 hours (16.25 days) and at 2 hours it can store 3120 hours (130 days).

Note that when setting the archive interval, WeatherCat also clears the data logger.

The other options can set the station’s clock shortly after midnight to the time on your
computer and clear the daily rain held in the console.
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Davis Vantage/Vue Range

Station Datalogger

Set DatalLogger Interval: [ 10 Minutes |4}

Your weather station can store historical data in its data log, this is useful
for when WeatherCat is not running. The period set here determines how
often the station stores the information, the lower the time the higher the
resolution but the station will fill its log quicker. Please note that changing
this value also clears any historical data currently in your station.

™ Delete Log After Historical Download

Station Time

8 Synchronize station clock

WeatherCat can make corrections to your station clock to keep it
synchronized with your computer's clock. If the above box is ticked then
the station clock is synchronized with your Mac's clock at quarter past
midnight every day.

Station Power Status

Transmitter Battery Status

Good B Send Admin Email

T On Power Fault

8 765 43 2Is8

(Test Power System)

Console Voltage

4.71V

ov v 2V 3V 4V SV

The above values are shown if available from your hardware. If your station
is not wireless then the transmitter battery status may show as 'Bad'.

( Set Channel Names )
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Here you can set your data-logger’s logging interval from 1 minute to 2 hours. The Davis
Vantage range can store 2560 samples, thus at 15-minute intervals it can store 640 hours
(26 days) and at 2 hours it can store 5120 hours (213 days).

Note that when setting the archive interval, WeatherCat also clears the data logger.

You also have the option of clearing the data-logger after WeatherCat downloads historical
weather from the station. This can lead to faster down-loads in future.

If ‘Synchronize station clock’ is ticked, WeatherCat will set your station’s clock shortly
after midnight every day.

WeatherCat monitors the Vantage power system including that of remote transmitters. By
default, it will send you an email when it detects either a problem with the station power
supply or a transmitter battery. The ‘Test Power System’ button causes WeatherCat to
simulate various power failures — the display will update, and power fail and power restore
emails will be sent if enabled.

The ‘Set Channel Names’ button brings up a sheet where you can alter the default channel
names as assigned by WeatherCat. These names are used in the Live Data View tool and
custom graphs. Name changes made here will not take affect until WeatherCat is restarted.

Edit a channel name by clicking on a row below. Note that changes to channel names will not take effect until
WeatherCat is restarted.

Channel Name

4
Ext. Humidity

Int. Temperature

Int. Humidity

Dew Point

Pressure

Precipitation Per Hour

Precipitation Daily

Precipitation Total

Wind Speed

Wind Direction

Average Wind Direction

Wind Chill

Wind Speed (10 Min. Average)

Wind Gust (1 Min)

Wind Gust (5 Mins)

Wind Gust (10 Mins) v
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Davis WeatherLink

Station Datalogger

Set DatalLogger Interval: [ 1 Minute ﬁ

Your weather station can store historical data in its data log, this is useful
for when WeatherCat is not running. The period set here determines how
often the station stores the information, the lower the time the higher the
resolution but the station will fill its log quicker. Please note that changing
this value also clears any historical data currently in your station.

() Delete Log After Historical Download

Station Time

8 Synchronize station clock

WeatherCat can make corrections to your station clock to keep it
synchronized with your computer's clock. If the above box is ticked then
the station clock is synchronized with your Mac's clock at quarter past
midnight every day.

Station Power Status

Transmitter Battery Status

___G_oo_d___ 8 Send Admin Email

L L L L L L L | ] On Power Fault
8 7 65 4 3 2IS8S

(Test Power System)

Console Voltage

”

4.53V

ov v 2V 3V 4V sV

The above values are shown if available from your hardware. If your station
is not wireless then the transmitter battery status may show as 'Bad'.

Communications

8 Allow connections to weatherlink.com

If ticked, WeatherCat will allow the data-logger to send data to
weatherlink.com

( Set Channel Names )
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The WeatherLinkIP driver can be used with any Davis hardware that supports the
WeatherLinkIP data-logger. This driver offers all the facilities of the normal Vantage/Vue
driver; the only difference is the option to allow the logger to send data to weatherlink.com
- this is enabled by default.

To connect, select WeatherLinkIP in WeatherCat's communications connection window.
Enter the I.P. address of the data-logger and hit the 'Done' button. By default WeatherCat
uses the default port of 22222; if your logger is set to use another port, use a colon after the
IP address followed by the port - for example 192.168.1.110:22222

If you do not know the I.P. address of your data-logger, a network scanning utility such as
AutoScan-Network (free, available from: http://autoscan-network.com/download/) or
Angry IP Scanner (http://angryip.org/download/#mac) will scan your network and display
all available devices and their I.P. addresses. We suggest setting the data-logger to a fixed
I.P. address via its web browser interface.

For the greatest reliability it is suggested you turn off the upload to weatherlink.com via
the loggers' configuration web page and turn the upload option off in WeatherCat. The
reason for this is when uploading to weatherlink.com, the logger may lock-up if it can't
resolve the weatherlink.com domain name and communications to WeatherCat will be lost.

Virtual VP
The WeatherLink IP driver can be used with Virtual VP.

Normally WeatherCat reads the rain bucket resolution direct from the hardware, but it
appears Virtual VP does not pass this information through (WeatherCat defaults to 0.2mm).
However, it's possible to force the rain bucket resolution to 0.01" via a hidden preference
as follows:

Open a terminal window and enter the following command and hit the return key:

defaults write com.trixology.weathercat VantageRainCollectorOverrideTolInches
YES

This will force the WLIP to set the rain collector to 0.01" resolution. To revert back to
auto-detect enter:

defaults write com.trixology.weathercat VantageRainCollectorOverrideToInches NO

This command only needs to be entered once - it isn't necessary to enter it every time
WeatherCat is launched.

If using Virtual VP, please turn off the ‘Allow connections to weatherlink.com’ option.
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Davis WeatherLinkLive

® WeatherLinkLive Hardware Options

Station Power Status
Transmitter Battery Status

Good
T T T T 1 Send Admin Email
8 76 5 4 3 2 1 On Power Fault

The above values are shown if available from your hardware. If your station is
not wireless then the transmitter battery status may show as 'Bad'.

Set Channel Names

V1.0.2

The WeatherLinkLive station driver is configured as per WeatherLinkIP (see above) - you
enter the IP address and port of the WeatherLinkLive hardware into WeatherCat’s Station
Connection window.

Note that WeatherLinkLive does not contain an accessible data logger and WeatherCat will
interpolate the data for missing periods.

Also note that WeatherCat assumes your ISS is running on channel 1, it also assumes the
anemometer is connected to the ISS.
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WMR928/968 Options

800 WMR968 Hardware Options

Rain Collector

Area Muliplier: 1.00

If you've increased the area of your rain collector, enter the multiplier here.
For example, if you've doubled the area of your rain collector, enter 2, if
you've quadrupled the size, enter 4, etc.

Channel Names

The names set here will be used the next time WeatherCat is
launched.

Channel 1 Temperature: |oft

Channel 2 Temperature: Temperature 2

Channel 3 Temperature: Temperature 3

Channel 1 Humidty: Humidity 1

Channel 2 Humidty: Humidity 2

Channel 3 Humidty: | Humidity 3 ]

__lUse Channel 3 As External Temperature/Humidity

( Cancel ) ( OK )

The Area Multiplier is useful if you have increased the capture area of your rain bucket.

You can edit the extra channel names available on your station - these names are displayed
in the live data view and custom graphs.

You can also pipe channel 3 to be the external temperature and humidity readings, which is
useful if your main thermo/hygro unit is not serviceable.
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WMR200

0.0.0 Oregon Scientific WMR200 Hardware Options

Rain Collector

Area Muliplier: | 1.00 |

If you've increased the area of your rain collector, enter the multiplier here.
For example, if you've doubled the area of your rain collector, enter 2, if
you've quadrupled the size, enter 4, etc.

. Cancel || OK |

V1.13

The only option for this station is the rain collector area multiplier. This is useful if you
have increased the capture area of your rain bucket. Note: Altering this value can cause a
large jump in the daily rain for that particular day. In this case, use a daily rain edit to
correct to the correct value.

Note that although the literature for this station claims up to 10 additional sensors, the
interface to the computer supports only 8. WeatherCat maps extra channels 2 to 9 to its
Aux. Temp. and Aux Hum. channels 1 to 8; a sensor on the WMR200’s channel 10 will not
be seen by WeatherCat.
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WMRS88

000 Oregon Scientific WMR88 Hardware Options

Rain Collector

Area Muliplier: | 1.00

If you've increased the area of your rain collector, enter the multiplier here.
For example, if you've doubled the area of your rain collector, enter 2, if
you've quadrupled the size, enter 4, etc.

. Cancel | | oK |

V1.00

WeatherCat’s WMR 88 station driver supports additional temp/thermo sensors, rain bucket
area multiplication and short forecast.

The only option for this station is the rain collector area multiplier. This is useful if you
have increased the capture area of your rain bucket. Note: Altering this value can cause a
large jump in the daily rain for that particular day. In this case, use a daily rain edit to
correct to the correct value.

Note that as the WMRS88 does not have a data logger, data will be interpolated across
periods when WeatherCat isn’t running.

Also note that the station hardware code sent to CWOP is for a WMR-100.
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Fine Offset WH1080/2080

e OO0 WH1080/2080 Hardware Options

Data Logger Interval: ' § Set

The data logger period in your console can be set from 1 to 59
minutes. Note that setting this value will clear any data
currently in the logger.

Number of records in logger: 1
V1.26

The WH1080/81/2080/1090/91 etc. is sold under a variety of brands such as Ambient
(WS1080/2080), Watson W-8681, Maplin, National Geographic, Elecsa 6975/76 and many
others.

The Hardware Options in WeatherCat allow you to set the data logger interval to any value
from 1 to 59 minutes — we would suggest 5 minutes as a good compromise between
resolution and the amount of time the station can collect data for if not connected to the
computer. 5 minutes gives the logger a capacity of just over 14 days. Note that changing
the logger interval can take up to a minute.

Please note, WeatherCat uses your altitude to calculate relative barometric pressure

with this station — please be sure your altitude is correctly set in WeatherCat’s
preferences.

Page 80



Fine Offset WH3080

e OO WH3080 Hardware Options

Data Logger Interval: ' 5 Set

The data logger period in your console can be set from 1 to 59
minutes. Note that setting this value will clear any data
currently in the logger.

Number of records in logger: 1
V1.05

The WH3080 is sold under a variety of brands such as Signatrol, Watson W-8681-Solar,
Nevada WH3080 and many others. It can be difficult to tell the difference between a
WH1080/2080 and 3080 — if the hardware has displays for solar and u.v. on the console
then it’s a 3080.

The Hardware Options in WeatherCat allow you to set the data logger interval to any value
from 1 to 59 minutes — we would suggest 5 minutes as a good compromise between
resolution and the amount of time the station can collect data for if not connected to the
computer. 5 minutes gives the logger a capacity of just over 14 days.

Please note, WeatherCat uses your altitude to calculate relative barometric pressure

with this station — please be sure your altitude is correctly set in WeatherCat’s
preferences.
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Instromet MetPlus

e OO Instromet Hardware Options

Station Datalogger

Set DatalLogger Interval: [ 1 Minute ¢]

Your weather station can store historical data in its data log, this is useful
for when WeatherCat is not running. The period set here determines how
often the station stores the information, the lower the time the higher the
resolution but the station will fill its log quicker.

Station Time

[QISynchronize station clock

WeatherCat can make corrections to your station clock to keep it
synchronized with your computer's clock. If the above box is ticked then
the station clock is synchronized with your Mac's clock at quarter past
midnight every day.

2

Temperature 2 Input: | Internal Temp

V1.01

The Instromet MetPlus station is available from Instromet - http://www.instromet.co.uk/
MetPlus.html

The MetPlus is a serial based station, a suitable USB to serial converter and driver will be
needed to connect it to your Macintosh (see the section ‘Serial To USB Converters’ earlier
in this manual).

The hardware options in WeatherCat allow you to set the data logger period, whether the
station clock is synchronised daily and the data associated with the temperature 2 input on
the MetPlus PCB.

The temperature 2 input can be configured as wet-bulb, internal temperature or Aux. Temp
1. If set to ‘wet-bulb’, external humidity will be calculated from wet-bulb and external
temperature.
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Setting the temperature 2 input to either 'Internal temperature' or 'Aux. Temp 1' will use the
humitter as external humidity (if fitted). If not fitted, external humidity and derived
channels will not be valid.

Instromet notes

1. The sun sensor is digital - this is wired up to the Solar channel within WeatherCat - if
the sun is shining, the solar channel will be set to maximum (1800W). From this,
WeatherCat will calculate sun hours.

2. When calculating humidity from wet-bulb temperature, a barometric pressure of
1013mb is assumed if the optional barometer is not fitted.

3. The optional barometer, if not fitted, will read 1000mb. Calibration of the barometer can
be performed via WeatherCat’s calibration options.

4. Internal humidity will always read 50% - it may be possible if wet-bulb and humitter
fitted to use the humitter as internal humidity in a later release.

5. Switching off then back on again the ‘Synchronise station clock’ tick-box will cause a
manual synchronisation of the clock.
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Supplied Plug-ins

Live Data
&‘%
[ Channels |

Channel Value 1 Hour Delta Status Sensor Errors

Ext. Temperature 13.722 -0.722 Valid 2
Ext. humidity 83 3 valid n"
Int. temperature 21.889 0.111 Valid

Int. humidity 52 0 Valid

Dew point 10.885 -0.15 Valid

Pressure 1013.779 -0.203 Valid

Precipitation per hour 0 0 Valid

Precipitation daily 0 Valid

Precipitation total 0 Valid "
Wind speed 0 0 Valid

Wind direction 24 -43.858 Valid

Average wind direction 39.917 -27.941 Valid

Wind chill 13.722 -0.722 Valid

Wind speed (10 Min. average) 6 2 Valid

Wind gust (1 Min) 9 Valid

Wind gust (5 Mins) 12 Valid

Wind gust (10 Mins) 12 Valid

Wind gust (15 Mins) 12 2 Valid

Wind gust direction (1 Min) 28 Valid

Wind gust direction (5 Mins) 52 Valid

Wind gust direction (10 Mins) 87 Valid

Wind gust direction (15 Mins) 41 Valid

Solar Radiation 137 -51 Valid v
V0.2 Y

The Live Data tool shows the raw data coming from your station (converted to your units).

It is most useful for checking channel status and errors.

In addition, at the bottom of the list of channels it maintains a count of communications
errors — these errors are split up into time-outs and checksum/CRC errors. These values
can aid fault finding spurious communication issues.
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Current Conditions Calculator

These rules are evaluated from the top down until one matches. The result text

is then set as the current conditions and evaluation stops. You can change the

order of the rules by dragging a rule up or down the list. If no rules match then
'N/A' is returned.

If Rain > 15 mm/h Then Return 'Torrential Rain’

If Rain > 10 mm/h Then Return 'Heavy Rain'
If Rain > 5 mm/h Then Return 'Rain’

If Rain > 1Imm/h Then Return 'Light Rain'
Sunny

If CB > 4500 ft Then Return 'Clear’

If CB > 4000 ft Then Return 'Scattered Clouds'
If CB > 2000 ft Then Return 'Light Clouds'

If CB > 1500 ft Then Return 'Cloudy’

If CB > 600 ft Then Return 'Overcast’

If CB > 0 Then Return 'Heavy Clouds

Delete

[ Defaults )

Current Result: Overcast
Manual Overide | |

Manual Override allows you to manually enter the current conditions which
will remain in force until the time specified below.

Keep In Force Until: 7]

V0.2

This tool allows you to select various channels, take their values, compare them to a given
value and if the result is true then set the current conditions string to a user specified value.
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For example, if the current rain rate is greater than 0.5 inches per hour then set the current
conditions to '"Torrential Rain'. When calculating the current conditions the plug-in runs
through the rules from top to bottom until it finds one that is true. If none are true then the
default result is 'N/A".

NOTE: The channels available are determined by your hardware and a consequence of this
becomes apparent if you change your station hardware. In this case WeatherCat will tell
you the hardware has changed and that you need to check the current conditions rules to
make sure the channels you previously were using are available with your new hardware
(and conversely to check for new channels you can now use). The same applies to custom
alerts and graphs.

Because it is not possible to determine rules for all weather conditions, the tool provides a
feature to override the calculated current conditions with a user provided description of the
current conditions (manual override). This override will stay in force for a user settable
time period via an expiry timer. As a convenience, the expiry timer is set to two hours in
the future when the user conditions are enabled.

When the expiry time is reached, the tool will revert to using the rules to calculate the
current conditions automatically.

This feature 1s useful for weather conditions such as 'snow’' or 'haze', which are difficult to
correctly detect.

NOTE: Manual conditions and their expiry times are not saved; if WeatherCat is quit and
re-launched the manual override conditions will be lost.

Also note that via WeatherCat’s AppleScript interface it is possible to set the current
conditions.

Page 86



Banner Generator

The banner generator can generate an image overlaid with current weather data and upload
it to your Custom Web pages server on a regular basis. The banner can be linked to from
web-pages, forum signatures and so on — instructions are included in the window as per the
image below. Note that items can be nudged into position by first selecting the item to be
moved, then holding down the ALT/Option key whilst using the arrow keys.

® O Banner Generator

Wind Speed: 2 MPH WeatherCat3  Temperature: 3.0°C
Wind Direction: NNW ’ Dew point: 1.2°C

Daily Rain: 0.0 ) Pressure: 1019.50 mb

A

Rain Rate: 0.0 mm/h Trend: Steady
Conditions: Overcast 17 Feb 2018 11:29 PM Humidity: 88%

This simple banner generator allows the creation and periodic uploading of a station banner
you can link to on the web. The banner is a fixed size of 500 x 80 pixels.

Drag an image to the banner above (the image will be scaled to fit - the original image will not
be modified). Add items from the menu below. Drag items to layout your banner. Use the
'Option' and arrow keys for fine control. Right-click on an item to change its attributes via the
contextual menu.

The banner generated will be created and saved at the period set below. It will be saved to
your Custom Web ouput folder as WeatherCatBanner.xxx (where xxx depends on the file
extension). The FTP tickbox below enables the upload of the image to your custom web pages
server each time the image is updated.

Add Item: Custom Text

Generate A New Image Every: 5 Minutes

A
v
A
v

Output File Format:  .jpg

FTP To Custom Web:

V1.5.0
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SQL Driver (Intel build only)

This tool can upload your weather data to a MySQL database opening up a world of
applications not previously available to WeatherCat - charting and analysis for example
(e.g. High-Charts, JpGraph, GraPHPite, pChart and so on).

MO0 WeatherCat SQL Driver

WeatherCat can send your weather data to an SQL server. The data is organised into three tables - Wind, Extra Sensors and WeatherData. The wind data is updated on
every update, the other weather data can be updated less frequently by setting the 'Other Data Update Multiplier' to a value greater than 1. For example if the multiplier
is set to 2, then the wind data is sent on every update, the other data is sent on every other update. This is handy if you have a station which updates the wind data
faster than other data.

Note: The database to use must exist before WeatherCat can use it; the tables are created by WeatherCat. If an error occurs during inital connection or during
operation, error reports are logged in WeatherCat's log window.

Configuration Current Status

o

Wind Update Rate: ; ‘60 | Seconds

Other Data Update Rate Mulitplier: r? 1| (60.0 seconds) Live Transactions: 0
Historical Upload Period:r? 5— Minutes EIVEIACKiSEH0 -
Response Time: 0 (R
Server U.R.L: | Success Rate: N/A
Port: 3306 Bytes Sent: 0

DB User Name: Current Status: Disabled

DB User Password:

Database Name:

The tool features:
*Auto-import of initial data.
*Uploading of historical data.
*Variable rate upload frequency depending on data (fast for wind, slower for other
data), resolution down to 1 second.

The database to use must exist — WeatherCat will not create it. Four tables are created and
maintained in the database - one for wind (WindData), one for common variables
(WeatherData) and one for extra sensors (ExtraData). An additional table is maintained for
maintenance reasons - do not edit this additional table (_WeatherCatPrivate).

If WeatherCat detects the database is new (i.e. has no tables), it will create the tables then
import all of your existing WeatherCat data. The period of the data when uploading
historical data can be set in the tool - the default is 5 minutes. Thereafter, data will be
uploaded to fill in gaps (for example when WeatherCat isn't running or the database server
is not available).

When running in real-time, the wind data can be updated faster than the other data (down
to 1 second) - this is handy if you have a station which updates wind data faster than other
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data (Davis Vantage or Vue for example). The other data is updated at a user settable
multiple of this period.

If you wish to reset the database, stop the SQLDriver, drop all four tables (using something
like phpMyAdmin), then start the SQLDriver again - it'll re-import your weather data.

Notes:
1. If your database is managed via CPanel, be sure to enable external
connections from your I.P. address (normally via RemoteMySQ)

2. Verbose errors are logged to WeatherCat's log window. On error, the
SQLDriver will wait a minute before retrying the transaction.

3. SQLServers can block repeated unauthorised attempts to access. If your
passsword is wrong, or there's some authentication problem, do not repeatedly
keep hitting the 'start’ button, or leave authentication errors repeat. If this does
happen to you, the error reported in WeatherCat's log window should tell you
what you need to do to unblock yourself.

4. The initial import to a new database can take a very long time. For example,
importing 6 years worth of data (Vantage with extra channels) from a MacMini
to a Synology 1512+ at the default 5 minute intervals took ~ 60 minutes at
approximately 250KB's per second. For your entertainment, a progress bar and
percentage complete are displayed during this time. Weather data collected by
WeatherCat during initial import or 'hole filling' will not be lost.

5. At the end of the initial import or uploading of historic data, the SQLDriver
will switch to real-time logging.

6. If the initial import or uploading of historic data is interrupted, it will resume
when the SQLDriver is next able to make contact with the database.

7. The period of historic data uploads is read when the upload is started - if you
want to change the period during an upload, hit the 'Stop' button, change the
period then hit the 'Start' button.

8. The time field in the database tables is in U.T.C.

9. The data size reported in the tools' window is not the database size - merely
the number of bytes transmitted to the server. Typically this is far greater than

the actual data size in the database.
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10. Imagery is not uploaded to the SQL server.

11. When running with live data, the minimum, average and maximum
transaction time is logged in the window - these values can be reset with the

small 'R' button.
12. Tested with MySQL 5.1.49. Should work with other versions of MySQL -
the minimum MySQL version in theory should be 4.1 (not tested).

13. If the server is running locally (i.e. on the same machine as WeatherCat),
you can use 127.0.0.1 in the 'Server URL' field

14. Uses the MariaDB SQL connector - source code and Xcode project for this
plug-in can be found at https://data.trixology.com/downloads/
WeatherCat_SQLDriver.zip.

15. Currently, synthetic channels are not uploaded to the database.
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Meteotemplate
This plug-in can drive the Meteotemplate API.

To use, enter the URL to your Meteotemplate API script and the password you have
defined, then hit the start button.

When running, the plug-in will send the data every minute.

O MeteoTemplate
Configuration Current Status
URL: Reports Sent: 0
Password: Acknowledgments: 0

Response Time: 0
Success Rate: N/A
Bytes Sent: 0

%3 Current Status: Disabled

Get MeteoTemplate

Log Sent Data

The ‘Log Sent Data’ tick box will log all data sent to the console application which can be
useful when checking for errors between the data sent and that received.

Note that the URL to your API script must start with http:// (or https://)

For more information on Meteotemplate, please visit: http://www.meteotemplate.com
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Twitter

This plug-in allows the posting of weather data at predefined times throughout the day to
Twitter.

Each tweet is defined by an editable template - there may be an unlimited number of
tweets.

Each template is made up from one of the following WeatherCat tags:

t12$ - time in 12 hours format

t248$ - time in 24 hour format.

de$ - date in the format d/my

da$ - date in the format m/d/y

STATS - any stat tag that can be processed by WeatherCat including TIME specifiers (see
the tags section of this manual for more details).

Each template also has a list of tweet times associated with it, these times are defined to a
resolution of one minute (i.e. a maximum of 1440 possible times per day). By default, 4
templates are provided - an hourly and 3 daily templates (that are sent just before
midnight).

You can add to, edit and delete the default tweets. You can also save and load the tweets as
sets.

Usage:
When you open the Twitter tool, you will be redirected to Twitter to sign in.

Twitter
Configuration v Sign up for Twitter »
Tweets:
Hourly . » v
Daily Tempd Authorise Trixology V
psilywind  WeatherCat to use C;
Daily Rain
your account?
Trixology
WeatherCat
By Trixology
| l | 4"} ology.c n/WeatherC
O — ] Remember me - Forgot password?
V1.00 ~
- X ‘
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Enter the name and password of the Twitter account your wish to post from and then hit
the ‘Authorise app’ button.

One you have authorised WeatherCat to post, hit the 'Start' button. At the predefined times,
the relevant tweet will be made.

O Twitter

Configuration Current Status

Tweets: Last Report Posted:

Hourly New
Daily Temperature

Daily Wind

Daily Rain

Save

Load

Reports Sent: 0
0 Start Current Status: Stopped
Character count: 0

V1.00

To edit a tweet, double click it. To add or delete tweets, hit the relevant button.

The ‘Save’ button will save all your tweets as a set.
The ‘Load’ button will load a set.

Notes:

1. The Twitter uploader in WeatherCat 3 is compatible with Sylvester settings and saved
sets from WeatherCat 2. (Sylvester was the Twitter uploader used in WeatherCat 2).

2. Should you wish to change the account you are posting from in the future, you'll need
to delete the authorisation data from your keychain. To do this, quit WeatherCat, open
Keychain access, search for 'WeatherCat Twitter' and delete it. Launch WeatherCat and
open the Twitter uploader, it will then ask you to sign in to Twitter again.
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How Do I...
This section details step-by-step instructions to perform common tasks with WeatherCat.

How Do | Change The Units Used By WeatherCat?
Open WeatherCat’s preferences from the File menu then go to the Misc1/Units pane.

How Do | Send Data To Wunderground?

WeatherCat can send real-time data to Wunderground. You will need a Wunderground 1D
and key; if you are not yet a Wunderground member you can get a Wunderground login ID
from within WeatherCat.

O WeatherCat Preferences

Location/Colors  Email m Alerts  Alerts 2  Custom Alerts  Units/Misc1 Misc2  Webcam Imagery  Advanced
Simple Web ~ Custom Web  Custom CGI w CWOP  Additional Services

WeatherCat can deliver weather data to your Wunderground™ personal weather station page. This service is free and
allows you to see your weather data in any web browser. If you do not have an account yet, click on the 'Create Account'
button below then fill in your details and click the ‘Start' button.

Wunderground Personal Weather Station

Configuration

Update Rate In Minutes  ~ 1
(1 to 30 minutes) h Camera I.D.

Rapid Fire Mode Camera Key
Update Rate In Seconds

Station I.D. |:H Start

Password/Key Reports Sent:
Acknowledgments:
Response Time:
Bytes Sent:

Update Rate In Minutes | |5

Current Status

Send Internal Temp. and Hum.
Enable Historical Uploads

Log Historical Uploads

Log Sent Data

o O O O

Current Status: Disabled

Enter your Station ID and password then click the Start button. If you are using a Create Wunderground Account
web-cam you can also enter your camera 1.D./key and set the update rate to upload
your web-cam image to Wunderground.
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1. Open WeatherCat’s Preferences and select the ‘On-Line’ tab.
2. Open the Wunderground PWS tab — it will look like the picture below (PWS is the
abbreviation for ‘Personal Weather Stations”)

3. If you don’t have a Wunderground member 1.D. click on the ‘Create Wunderground
Account’ button. You web-browser will open and take you to the correct page to register
with Wunderground.

4. Once you have a station [.D. and key, enter them into the ‘Station I.D.” and ‘Password/
key’ fields.

5. Click the ‘Start’ button and the ‘Current Status’ pane will start updating. If there is a
problem with your login details or the connection to the Wunderground servers, this will
be indicated in the ‘Current Status’ area. Note that it can take an hour or two after account
creation before Wunderground will start accepting your data - during this time you will
receive a pwd/id error (normally this clears within a few hours of account creation). If you
are still receiving pwd/ID errors after a few hours, check the credentials you have entered.
If these are correct, check with Wunderground as to the service status.

Clicking on the ‘Go To Your PWS Web Page’ button will cause your web browser to open
your Wunderground station page. Note: As of time of writing, your Wunderground station
page may take a day or two before it is active, prior to this you will receive a ‘404 - Page
Not Found’ error.
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How Do | Send Data To The Citizen’s Weather Observer Program (CWOP)?

WeatherCat can send data to CWOP — the procedure is similar to setting up for
Wunderground. You will need a CWOP ID; if you are not yet a CWOP member you can
create a login ID from within WeatherCat.

1. Open WeatherCat’s Preferences and select the ‘On-Line’ tab.

2. Open the CWOP tab — it will look like the picture below.

e WeatherCat Preferences
| Location/Colors Email On-Line | Alerts  Alerts 2 Custom Alerts Units /Miscl Misc2 Webcam Imagery  Advanced !
I Simple Web Custom Web Custom CGI Wunderground PWS cwor |

WeatherCat can deliver weather data to the Citizen's Weather Observer Program. This service is free and allows you to

see your weather data in any web browser; in addition data sent to CWOP is validated and then made available to
various weather organisations world-wide. If you do not have an account yet, click on the 'Create.. Account' button
below, then fill in your details and click the 'Start’ button. If 'Generate WXNOW.TXT file' is checked then the packet

sent to CWOP will be saved in ~/Application Support/WCWeb/

Citizen's Weather Observer Program

Configuration

: O B ... 3
Station I.D. ( Start )
[ Log Operation Stop

| Generate WXNOW.TXT file

Enter your Station ID then click the
Start button.

[ Advanced Settings )

Current Status

Reports Sent: 0
Acknowledgments: 0

Current Status: Disabled

Create CWOP Account

Go To Your CWOP Web Page

3. If you don’t have a CWOP Station I.D. click on the ‘Create CWOP Account’ button.
Your web-browser will open and take you to the correct page to register with CWOP.

4. Once you have a station [.D. enter it into the ‘Station 1.D.’ field.

5. Click the ‘Start’ button.
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The ‘Current Status’ pane will start updating.

If you get the message in the ‘Current Status’ that your ‘Lat/Long is not set’, then follow
the ‘Basic Setup’ section at the start of this manual to enter your location and height into
WeatherCat.

Finally, if you click on the ‘Go To Your CWOP Web Page’ button your web browser will
open your CWOP station page.
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How Do | Use A Webcam With WeatherCat?

WeatherCat can work with any QuickTime compatible camera. It can also work with third
party webcam software via its local file option and with IP based webcams if they make
the image available via http.

To use your camera with WeatherCat:

l.

Nk W

Ensure your camera is plugged in and no other program is using it.

Go to WeatherCat’s preferences and open the ‘Webcam’ tab.

Click on the “Web-cam Enabled’ check box.

Your camera may appear in the camera selector menu, if it does not...

Click on any other pane of the preferences then back on the Webcam pane — this
causes WeatherCat to refresh the list of cameras. If still not there, unplug the
camera, count to 10, plug it back in and repeat.

Check the webcam i1s working by opening the ‘Live Video Preview’ from the ‘Tools
menu.

b

You can now use the webcam image in web pages as described next. The webcam options
will be described in the ‘Preferences’ section later in this manual.
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How Do | Upload Web Pages To a Web Server?

WeatherCat can create web pages in two ways — the fastest method is called the ‘Simple
Web Pages’ which gives you ‘canned’ web pages with very little effort — you just need to
know your FTP log-in details and create a directory on your server for WeatherCat to
upload your files to.

The second method is called ‘Custom Web Pages’. First we will describe the simple web
pages.

Simple Web Pages
By clicking a few buttons, entering some descriptive text and setting up your FTP details
you can put your weather web pages on-line very quickly.

An example of how these web pages look can be found on our web site at the following
URL.:
https://www.trixology.com/live_weather/simple

1. Open WeatherCat’s Preferences and select the ‘On-Line’ tab.
2. Open the Simple Web tab — it will look like the picture below.
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8O0 WeatherCat Preferences

| Location/Colors Email | On-Line | Alerts  Alerts 2 Custom Alerts Units /Miscl Misc2 Webcam Imagery  Advanced

[ Simple Web Custom Web Custom CGI Wunderground PWS cwop |

Use this pane to configure web pages generated by WeatherCat that are then uploaded to your web-site. The
minimum set-up necessary is to check 'Create Web Pages', edit the texts in the 'Texts' tab, set how often you want the
web pages uploaded to your web site and set up the FTP details here. If you wish WeatherCat to modify and upload
your own pages, use the '‘Custom Web' tab of these preferences.

{ Setup | Text !

[ Create Web Pages

Update Web Pages Every: 15 Minutes

Save Pages At: /Users/stu/Library/Application Support/WCWeb Set Save Path
Add WebCam Picture To Web Pages
Picture Size:| 320%240 |% !
__ Or Use The Following URL To A Camera Picture
Add Journal To Web Pages
Enable FTP Upload
FTP User Name: Not Set Edit FTP Details

(98]

Check the Create Web Pages tick-box.

If you have enabled your webcam tick the ‘Add WebCam Picture To Web Pages’
tick-box.

If you wish to display your weather journal on your web site, check the ‘Add
Journal To Web pages’ tick-box.

Click on the ‘Edit FTP Details’ button; a sheet will pop-up (picture below) where
you can enter your FTP details. Be sure the URL ends in a ‘/’ character. You can use
the “Test’ button to perform a test upload. Note that FTPS can be enabled in the
‘Advanced’ tab of WeatherCat’s preferences.
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FTP User Name: MyUserName

FTP Password: eeeescecssse

URL to directory: | ftp:/ /mysite.com/MyWeather/
(Note: This Directory

Must Exist)

(Cancel ) ( Test ) ( oK )

/.

7. When your FTP details are set-up and tested, click the OK button.
8. (Optional) You can add some text describing your weather pages by clicking on the
‘Texts’ tab as per the next picture.
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.00 WeatherCat Preferences

{ Location/Colors Email | On-Line | Alerts  Alerts 2 Custom Alerts Units /Miscl Misc2 Webcam Imagery  Advanced )

[ Simple Web Custom Web Custom CGI Wunderground PWS cwop |

Use this pane to configure web pages generated by WeatherCat that are then uploaded to your web-site. The
minimum set-up necessary is to check 'Create Web Pages', edit the texts in the 'Texts' tab, set how often you want the
web pages uploaded to your web site and set up the FTP details here. If you wish WeatherCat to modify and upload
your own pages, use the '‘Custom Web' tab of these preferences.

[ Setup | Text }

Web Page Title: WeatherCat

Notes: <H4> Page Notes</H4>You can enter information about your station in the 'Notes' field
of WeatherCat's Simple Web preference pane (Text tab). You can use HTML tags and
WeatherCat macro tokens. Useful items might be a description of the location, its latitude
and longitude, which direction the web cam is facing etc.

[ Use Custom Web Page Background Graphic

Set Picture

Upload Now [ Test Web Pages Locally ) ( save Texts )

9. Once you are happy with the texts, press the ‘Save Texts’ button.

10. Press the ‘Test Web Pages Locally’ button. WeatherCat will process your web pages
and open them in your browser.

11. Go back to the ‘Setup’ tab and tick the ‘Enable FTP Upload’ tick-box.

From now on, every 15 minutes WeatherCat will generate the web pages and FTP them to
your web-server.

You can change the upload rate with the ‘Update Web Pages Every’ pop-up menu.

The remaining options will be described in detail in the ‘Preferences’ section of this
manual later.

The simple web pages are designed to give basic web pages for use on your site. For more
complex web pages, using your own design, we need to look at WeatherCat’s custom web
pages facilities.
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Custom Web Pages

WeatherCat can take your own web pages, we will call them ‘templates’, replace any
'tags', with weather data, generate any needed graphics and movies requested by the tags
and then upload the processed files to your web server.

When processing your templates, WeatherCat takes the pages found in your source folder
(set with the ‘Set HTML Source’ button), processes them for tag replacement and then
saves the resultant pages at the save path (set with the ‘Set Save Path’ button).

WeatherCat tags end in the ‘$” symbol, so for example if, in your template file, you had the
tag “‘WCAMS’, WeatherCat would replace it with the current webcam picture (actually it
would replace it with the html code to draw the picture and make sure the webcam picture
was also uploaded as a jpeg file).

WeatherCat tags come in two varieties — high level tags which typically display more than
one item and lower level tags which only display one item but are finer grained and hence
more flexible.

An example high-level tag is ‘CT$’ which is replaced with the current temperature, the
temperature units string and 1 hour delta — it would be printed as ‘46.2°F (0.2)’.

Another high-level tag is JOURNTS which is replaced with the journal text for the station
and STDAILYS is replaced with the daily hourly statistics. STDAILY should normally be
surrounded by pre-formatted tags; i.e. <PRE> STDAILY$ </PRE>

Low-level tags are constructed from the STATS$ keyword and some parameters. The list of
parameters starts and ends with a $ symbol. STATS tags create queries to WeatherCat’s
Stats Manager and are replaced with the result of the query.

The basic format 1s:
STATSITEM:TYPE:PERIODS

ITEM can be one of:

RAIN, DAILYRAIN, RAINDAYS, FROSTDAYS, DAILYSUN, TEMPERATURE,
DEWPOINT, WINDCHILL, HEATINDEX, PRESSURE, SNOW, SNOWDAYS,
WINDSPEED, AVERAGEWINDSPEED, WINDGUST, WINDDIRECTION,
WINDRUN, EXTHUMIDITY, INTHUMIDITY, INTTEMPERATURE, UV, SOLAR or
SUNSHINEHOURS, SNOW or SNOWDAYS.

TYPE can be one of:
CURRENT, 24HRSAGO, MIN, MAX, AVERAGE, TOTAL.

PERIOD can be one of:
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TODAY, YESTERDAY, THISWEEK, LASTWEEK, THISMONTH, LASTMONTH,
THISYEAR, LASTYEAR, THISSEASON, ALLTIME, SINCE9AM and HRS(x) (where x
1s the number of hours). Additional time period specifiers are also available - please see
appendix 4 for complete details.

By appending TIME we can display the time of the event:
STATSITEM:TYPE:PERIOD: TIME$

For example, to find the highest temperature today:
STATSTEMPERATURE:MAX:TODAY $
STATSTEMPERATURE:MAX:TODAY:TIMES.

These tags are rendered as:
8.22
12:10 AM

To find the highest temperature yesterday:
STATSTEMPERATURE:MAX:YESTERDAY'$
STATSTEMPERATURE:MAX:YESTERDAY:TIMES.

These tags are rendered as:
9.39
9:00 PM

CURRENT will display the real-time value of a given item. This is different to CT$ or
CDS etc. as those values are pulled from the database which has a resolution of 1 minute.
In the case of CURRENT, the time field (TODAY, YESTERDAY etc) will be ignored and
can be omitted.

To display the current outdoor temperature:

STATSTEMPERATURE:CURRENTS

This is rendered as:

5.33

CURRENT can also return the value of the following additional sensors (if supported by
your hardware):

LW1, LW2, LW3, LW4 - leaf wetness sensors.

SM1, SM2, SM3, SM4 - soil moisture sensors.

ST1, ST2, ST3, ST4 - soil temperature sensors.

T1, T2, T3, T4, T5,T6, T7, T8 - extra temperature sensors.

H1, H2, H3, H4, H5, H6, H7, HS - extra humidity sensors.

DAILYET, MONTHLYET, YEARLYET - Daily, monthly or yearly evapotranspiration. i.e.
STAT$T1:CURRENTS

This is rendered as:

11.7
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24HRSAGO will display the value of a given item 24 hours ago.

In the case of 24HRSAGO, the time field (TODAY, YESTERDAY etc) will be ignored and
can be omitted.

To display the outdoor temperature 24 hours ago:

STATSTEMPERATURE:24HRSAGO$

This is rendered as:

8.1

DELTAT1 will display the 1 hour change of a given item.

For DELTAL1 the time field (TODAY, YESTERDAY etc) will be ignored and can be
omitted.

***NOTE that wind direction delta is not supported and will return an undefined value***
To display the current outdoor temperature 1 hour change:
STATSTEMPERATURE:DELTAT1S$

This is rendered as:

1.28

DELTACHAR is the same as DELTA1 but rather that returning the numerical value of the
1 hour delta returns one of the following characters: '1 /' —\, | ' which represents > 3

units, > 1.5 units, between 1.5 and -1.5, less than -1.5 and less than -3 units respectively
(encoding is UTF-8 if accessed via the AppleScript interface). Note for pressure, the units
for this comparison are millibars irrespective of the user set units.

DELTACHAR arrows are translated in custom web processing to one of three
arrows, up, right or down. Detail: if the value is rising by 1.5 units or more per
hour then &uArr; is output. If the value is falling by more than 1.5 units or
more per hour then &dArr; is output, otherwise &rArr; is output.

DELTA24 will display the 24 hour change of a given item.

For DELTA24 the time field (TODAY, YESTERDAY etc) will be ignored and can be
omitted.

***NOTE that wind direction delta is not supported and will return an undefined value®**
To display the current outdoor temperature 24 hour change:
STATSTEMPERATURE:DELTA24$

This is rendered as:

0.8

Notes:

SUNSHINEHOURS can only be used with TOTAL (to find the total number of hours over
a given date range)

e.g. Hours of sunshine today = STATSSUNSHINEHOURS:TOTAL:TODAY $

is rendered as:

Hours of sunshine today = 0.52
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DAILYSUN can only be used with MAX (to find the sunniest day in a given date range)
e.g. The sunniest day this year: STATSDAILY SUN:MAX:THISYEAR:TIME$
(STAT$SDAILYSUN:MAX:THISYEARS hours)

is rendered as:

The sunniest day this year: 18 Feb 2012 (0.52 hours)

THISSEASON can only be used with RAIN

e.g. STATSRAIN:TOTAL:THISSEASONS

is rendered as:

91.60

or

STATSRAIN:AVERAGE:THISSEASONS$ RAINUNITS$/h
1s rendered as:

0.0616 mm/h

(The rain season start month is set in the preferences)

DAILYRAIN can only be used with MAX or AVERAGE.
e.g. STATSDAILYRAIN:MAX:THISWEEKS on
STATSDAILYRAIN:MAX:THISWEEK:TIMES$

is rendered as:

2.80 mm on 18 Feb 2012

RAINDAYS can only be used with TOTAL and returns the number of rain days over a
given period.

e.g. STATSRAINDAYS: TOTAL:THISMONTHS

is rendered as:

3

FROSTDAYS can only be used with TOTAL and returns the number of frost days (or air
frosts)over a given period.
e.g. STATSFROSTDAYS:TOTAL:THISMONTHS$

1s rendered as:
8

Extra sensors can only be used with CURRENT. Stats and deltas are not currently
supported for extra sensors - this is planned for a future version.

Tag Errors
In the case of an invalid tag configuration, the tag will either be processed - for example:

Highest wind direction today = STATSWINDDIRECTION:MAX:TODAYS degrees
returns an undefined value and 1s rendered as
'Highest wind direction today = 294.56 degrees'.
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or it may render as an error. For example:

Average wind direction today = STATSWINDDIRECTION:AVERAGE:TODAY'$ degrees
on STATSWINDDIRECTION:AVERAGE:TODAY:TIMES renders as:

Average wind direction today = 255.24 degrees on ***Error - No time available for
averages®**

Dials and graphs can be displayed with the ‘D” and ‘GR’ type tags — for example
DTEMPOS is replaced with the outside temperature gauge. ‘GRTEMPOS’ is replaced with
the simple outside temperature graph.

Custom graphs are displayed by using their web-tag as indicated in their settings.

There are some miscellaneous tags for printing units strings — for example TEMPUNITSS$
is replaced with the string for Temperature units — typical ‘C’ or ‘F’. A listing of all tags
currently available can be found in appendix 4.

Example templates are supplied in the WeatherCat Miscellaneous Files distribution’. A
very simple one, called ‘WeatherCat All Tags’ simply demonstrates all the tags currently
available in WeatherCat.

You can view a live demonstration of this template at:
https://www.trixology.com/live_weather/custom/

Another template, ‘atkinsfamily.org’, written by Todd Atkins, demonstrates a more useful
real world template. We will use the ‘atkinsfamily.org’ template, demonstrate what it looks
like and then put it on-line. You can of course modify it to your needs or create your own
template from scratch.

We will now run through the steps to use one of the supplied templates, later we will look
at how to create your own template.

1. Open WeatherCat’s Preferences and select the ‘On-Line’ tab.

2. Go to WeatherCat’s 'Custom Web Pages' tab of the preferences and, using the 'Set
HTML Source' button, navigate to the 'WeatherCat/Web Templates/atkinsfamily.org'
folder as per the picture below. This tells WeatherCat where to find the pages to be
processed (see picture below).

3. Press the 'Test Web Pages Locally' button.

7 Available for download from our web-site.
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M OO WeatherCat Preferences

( Location/Colors Email On-Line | Alerts  Alerts 2 Custom Alerts Units /Miscl Misc2 Webcam Imagery  Advanced )

! Simple Web | Custom Web | Custom CGI =~ Wunderground PWS = CWOP !

WeatherCat can take your web pages, replace various tags in them with weather data, graphs, dials and the web-cam
picture and then save the pages for uploading via FTP. Click 'Show Help' to display help for the Custom Web Pages
and a reference describing each tag WeatherCat can process.

—_———
(" Show Help )

[~ Main | Additional Files

'"HTML Source' is the folder in which your HTML source files can be found. 'Save Pages At' is the folder where
WeatherCat will put the HTML after replacing the tags. If 'Enable FTP Upload' is checked, then WeatherCat will FTP the
files to your web server. Note that all items are uploaded in a flat hierarchy on the server.

™ Enable Custom Web Pages

Set HTML Source ) HTML Source: /Users/stu/Desktop/WeatherCat090B100/Web Templates/

atkinsfamily.org

. r—— g _—
Set Save Path Save Pages At: /Users/stu/Library/Application Support/WeatherCatCustomWeb/

] Enable FTP Upload
Update Web Pages Every:
15 Minutes v

(" Edit ETP Detaile )
FTP User Name:  Not Set Edit FTP Details M Sync. To Weather Fetch

{_Test Web Pages Locally )

Figure 45 - Custom Web Example

WeatherCat will process the template, generate the pages and required objects then open
them in your web browser. WeatherCat tries to open all documents that are to be uploaded,
so you may find a CSS file opened in a text editor, and if you are using a webcam and have
used webcam tags in your template, these pictures and movies will open in your graphics
editor and QuickTime Player.

Examine the results and edit the template to suit your needs. After each change to a
template file, save it and then press the ‘Test Web Pages Locally’ button to see how your
changes look when processed.

A complete list of WeatherCat tags can be found at Appendix 4, or by pressing the ‘Show
Help’ button in the Custom Web tab of WeatherCat’s preferences. At this point you may
want to create your own template — more details can be found below. NOTE: Whenever
you change templates, you need to delete the old processed files found in WeatherCat’s
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Save Path folder, otherwise the old objects will be opened every time you test your
template.

When you are happy with the results, you may now want to put your pages on the web as
follows.

1. Press the 'Edit FTP Details' button and configure WeatherCat to FTP to your server (as
shown previously in the Simple Web pages); you can test the FTP connection from the FTP
dialog box that appears. Note that the directory to upload to must exist on the server -
WeatherCat will not create the directory or the path to the directory.

2. After testing you can FTP, select the 'Enable FTP Upload' check box. WeatherCat will
now update your pages at the periods set with the 'Update Web Pages Every' pop-up menu.

Notes:
1. Never put any items in the Save folder - the folder set with the 'Set Save Path' button.
The contents of this folder may be deleted by WeatherCat.

2. You do not have to enable FTP for the custom web pages - you may just want them
saved on your disk for use by another program or served from your Mac via the web server
that comes with OS X. (Available from OS X’s System Preferences (under Sharing->Web
Sharing)).

3. If you start receiving warning emails from WeatherCat with regards to ‘FTP Overload’ it
means you may be generating web pages faster than they can be uploaded (typically these
problems are spurious in nature).

4. FTPS can be enabled in the ‘Advanced’ tab of WeatherCat’s preferences.

How Do | Create A Custom Web Template?

1. Create a folder somewhere for your web pages - for example in your Documents folder
and call it something like "Weather Pages Source".

2. Referring to WeatherCat's tags reference at Appendix 4, create your web pages in your
preferred web page editor and save them in your Weather Pages Source folder. Wherever
you want a weather item to appear in your pages, insert the relevant tag, for example if you
want the webcam image inserted, use the WCAMS tag.

3. WeatherCat will look in files with extensions
of .htm, .html, .htx, .css, .xml, .txt, .php, .shtml, .stm, and .shtm for tags to replace. All

other types of file are not processed but are uploaded.

Now continue as above for the pre-constructed templates.
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Additional WebTag Resources

A full reference for WeatherCat tags can be found in Appendix 4 of this manual.

Finally, the WeatherCat Web Templates forum can be found at:
https://athena.trixology.com/index.php?board=5.0
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How Do | Upload Data to UKWN or NZWN?

Custom Web templates are provided that allows WeatherCat to upload data to the UK
Weather Network (http://www.ukwx.net) and New Zealand Weather Network (http://
www.localweather.net.nz/smf/new-zealand-local-weather-network/). These sites work by
reading a file from your web site at periodic intervals.

The templates can be found in the ‘Web Templates’ folder of the WeatherCat
Miscellaneous Files distribution3; simply copy the relevant template file into your custom
web source directory.

WeatherCat will now process and upload the file to your web site at the periods specified
in WeatherCat’s Custom Web preferences. Alternatively, you can upload the files more
frequently with the Custom Web ‘Additional Files’ feature.

If you do not have a custom web site (and don’t plan on having one), set one up using just
the UKWN or NZWN template as the only file that is processed.

8 This can be downloaded from our website.
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How Do | Set Up A Weather Alert?
WeatherCat can send emails and run items on your Mac (for example AppleScripts) when
an alert triggers.

Predefined Alerts
WeatherCat comes with four pre-defined alerts — Ice, Rain, Clear Sky and Rain Start. To
set up one of these alerts proceed as follows:

—

Open WeatherCat’s preferences and go to the ‘Alerts1’ or ‘Alert2’ tab.

2. Click on which actions you wish WeatherCat to perform when the alert triggers —
‘Send Email’ or ‘Launch User Item’.

3. Adjust any optional parameters, such as how heavy the rain needs to be.

Yo re WeatherCat Preferences

I Location/Colors Email On-Line Alerts Alerts 2 Custom Alerts Units /Miscl Misc2 Webcam Imagery Advanced !

WeatherCat contains three in-built alerts. Each alert can be configured to send an email and/or launch an item such
as an Apple Script™.

Ice Alert
[Zl Send Email
(| | m—
| Launch User Item (_ Setitem )
Path:

Rain Alert

|1 Send Email Trigger If: | Showers Or Worse ﬂ

[ Launch User Item (" set Item )

Path:

Clear Sky Alert

™ Send Email  Trigger If: | Clear 4) & [(Night %)
[ Launch User Item ( set Item )

Path:

For details of the individual alerts, please see the ‘WeatherCat Preferences’ section later in
this manual.
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Custom Alerts

WeatherCat allows you to create and edit an unlimited number of custom alerts. To create a
new alert follow these steps:

1. Open WeatherCat’s preferences and select the ‘Custom Alerts’ tab.

2. Click the ‘New’ button.

3. In the resultant sheet, select the criteria for the alert.

4. Select the actions you wish to perform when the alert triggers and when the alert
clears.

5. When you are happy with the Alerts settings, click the ‘OK’ button. The alert is now
active.

The custom alerts are described in more details in the ‘WeatherCat Preferences’ later in
this manual.
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How Do | Control My Environment with WeatherCat?

There’s no ‘right’ way of doing this — WeatherCat provides facilities for external programs
to monitor the data.

The first option is to use the WXNOW.TXT file generated by WeatherCat when it is
uploading to CWOP. This file is generated every time WeatherCat reports to CWOP and
can be parsed periodically.

The second option is to use WeatherCat’s custom web facilities to periodically parse an
XML template to produce the data you need.

The third way is to use the Custom Alerts to run scripts.
The fourth way is via WeatherCat’s AppleScript interface. This provides access to the
current weather data and WeatherCat’s status via AppleScript properties. Please see

appendix 1 for a full description of this interface.

The fifth way is to use WeatherCat’s rich client protocol interface - please see appendix 7
for more details.

The sixth way is to use WeatherCat’s SDK to write a native plug-in. Please see the
WeatherCat SDK available as a separate download from our web-site.

Page 114



How Do | Use AppleScript With WeatherCat?
WeatherCat makes all channels and status information available via its AppleScript
interface.

Here’s a very quick example of how to use AppleScript to speak the current temperature as
it changes.

First, open the AppleScript editor program (/Applications/Utilities/ AppleScriptEditor.app)
— you should be presented with a screen looking like:

®no Untitled (@)

Events Replies |

| Description | Event Log-| y
Z

Figure 46 - AppleScript Editor
Page 115



Now, paste the following AppleScript code into the window:

tell application "WeatherCat"
set oldCurrentTemperature to 40 -- set old temperature to something sensible

repeat -- run around this loop forever, once every 10 seconds
set currentTemperature to ExternalTemp -- read temperature from
WeatherCat
if oldCurrentTemperature # currentTemperature then
tell current application
say "Current temperature is"
say currentTemperature as string
end tell
end if
set oldCurrentTemperature to currentTemperature -- save the current
temperature so we can check for a change next time around
the loop
delay 10
end repeat
end tell

The window should now look like:
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tell application "WeatherCat"
set oldCurrentTemperature to 40 -- set old temperature to something sensible

repeat -- run around this loop forever, once every 10 seconds
set currentTemperature to ExternalTemp -- read temperature from WeatherCat
if oldCurrentTemperature = currentTemperature then
tell current application
say "Current temperature is"
say currentTemperature as string
end tell
end if
set oldCurrentTemperature to currentTemperature -- save the current
temperature so we can check for a change next time around the loop
delay 10 |
end repeat
end tell

Events Replies |

[ Description M p
2,

If you now hit the ‘Run’ button in the AppleScript Editor, the temperature will be spoken
every time it changes (if WeatherCat isn’t running it will be launched when you press the
‘Run’ button).

Finally, you can save the script as an application from the AppleScript Editor via ‘Save
As...” from its File menu.

For more information on WeatherCat’s AppleScript interface, please see Appendix 1.
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How Do | Send Data In Real Time To A Server On The Internet?

The Custom CGI feature allows you to transmit real-time weather data to a server on the
Internet in an efficient fashion.

We have supplied two simple php scripts by way of example (found in the ‘Server Scripts’
folder of the WeatherCat Miscellaneous Files distribution). The first takes the data from
WeatherCat and saves the data as a text file on your server. The second displays the data in
a web page.

To set up WeatherCat for Custom CGI follow these steps.

1. In the WeatherCat Miscellaneous Files distribution®, open the ServerScripts folder found
at the top level and upload the following two scripts and text file to your server:

a). submit_weather.php

b). watch_weather.php

c). weather data.txt

(You may need to set the permissions of the files as appropriate for your server.)
The submit_weather script is the script WeatherCat sends the current weather data to.

The watch weather script is loaded in your browser to see the current weather data.
The weather data.txt file is where the submit weather script stores the data.

9 This can be downloaded from our website
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e WeatherCat Preferences

( Location/Colors Email | On-Line | Alerts Alerts 2 Custom Alerts Units /Miscl Misc2 Webcam Imagery = Advanced )

(

Simple Web Custom Web | Custom CGI Wunderground PWS cworp !

WeatherCat can deliver data to your own custom CGI running on your web server as frequently as you like. WeatherCat
performs an html 'get' on the url below with the current weather data appended as parameters. For example, if the
URL to your script is: "http:/ /www.myserver.com/submit_weather.php? WeatherCat will append (data below is
example data):
'‘&dateutc=2011-02-18+2%3A21%3A27&winddir=230&windspeedmph=12&windspeedmphav_10m=12&windgustmp
h=12&windgustdir=189&windgustmph_l0m=23&windgust_dir_10m=167&humidity=90&dewptf=29&tempf=32.2&ra
ininch=0&rain24hinch&baroinch=30.2&action=update' and then send it. Note that if a value isn't available it will not
be included.

Custom CGI

URL To CGI:  http://www.myserver.com/submit_weather.php?ID=joeblog&PASSWORD =xXxxXXX

Current Data:

[ISend Time As Local Cumrent Status
[ Reports Sent: 0
Update Rate @ 5 In Seconds Acknowledgments: 0
Response Time: 0
( start ) Bytes Sent: 0
Stop Current Status: Disabled

2. Enter the URL to the submit_weather.php script into the URL in the CustomCGI
preferences - enter it exactly as above, just change the URL to your script. You'll probably
only have to modify the www.yourserver.com part of the URL. The script by default
expects the user name to be joeblog and the password to be xxxxxx.

3. Hit the start button.

4. In your web browser open http://www.yourserver.com/watch weather.php

If all has gone well, you should see live weather from your weather station.

If not, check the URL's and the location of the scripts on your server. Check if your
hosting provider allows you to run scripts; also check where you should put them.
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5. IMPORTANT: When everything is running correctly, edit the submit_weather
script to change the user name and passwords!

Notes

1. Please feel free to modify the scripts to suit your needs. The submit weather script can
be modified to save the data in any format you require - for example some flash based
gauges need XML formatted data.

2. You may have other scripts you want to drive - you can write CGI's in whatever
language you prefer - we have used PHP here as a simple example.

3. Any CGI you write must take the data as formatted by WeatherCat - you cannot change
the format of the data WeatherCat sends.

4. The data WeatherCat is sending is displayed live in the Custom CGI preferences tab as it
1s transmitted.

5. We may add further data items to the request in the future, so your CGI should be able
to handle new parameters - even if it’s just to ignore them until you can update the CGI.

6. If a data item is not available (because, for example that particular sensor is
unserviceable) it may not be sent - your script needs to deal with this.

Please see our web templates forum at https://athena.trixology.com/index.php?board=5.0
for discussion of this feature.
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How Do | Use WeatherCat Client Programs?

A small client program for WeatherCat that can run on any Mac on either your local
network or over the Internet is available from our web-site in the WeatherCat
Miscellaneous Files download. All you need to do is copy the client to the computer you
wish to run it on and launch it (the client will run on OS X 10.6 or later). Within a couple
of seconds it will pick up the data stream from WeatherCat and display weather gauges in
real time. If you wish to connect to a WeatherCat server running over the Internet, open
the preferences on the client and enter the URL to the server, then hit the connect button.

You can run more than one client at a time; you can also run the client on the same
machine as WeatherCat is running on.

WeatherCat uses a fixed port in the range 49250 to 49255 to serve data to clients*. If you
are running WeatherCat on a machine with a firewall and the client is not working on other
machines on your network then opening ports 49250 to 49255 on the machine WeatherCat
is running on should allow the client to see WeatherCat and work correctly.

Similarly for access from the Internet, you will need to ‘port forward’ these ports to the
local I.P. address of the machine WeatherCat is running on in your Firewall (it’s best if the
machine running WeatherCat has a fixed I.P. address. Check with your router
documentation how to forward a range of ports).

It’s likely your ‘Internet’ I.P. address will change over time; a dynamic D.N.S. company
can aid here. They can provide a domain name that tracks your I.P. address over time so

rather than having to know your I.P. address, you can use your ‘domain name’ to connect.

*Note that in previous versions of WeatherCat, the port range was 49250 to 49254.

Page 121



iOS Clients

Poohbah Industries have made available clients for 10S devices that, like the Mac client,
can work either over the local network or the Internet.

9)
]

18:09 o
Edit WeatherCat

04/02/2018, 18:09:08

External temperature 2.6°C
»

External humidity 89 %

Internal temperature 20.3°C
o

Internal humidity 41 %
«

Dew point 0.9°C
'»

Relative pressure 1032.91 mb
-

Precipitation per hour 0.00 mm/hr
b

Precipitation per day 0.60 mm/day
D

Wind speed 0.0 mph
D ]

Wind gust 0.0 mph
T—)

Wind run 0.2 mi
D

Wind direction SE 134°
N\ o

Wind chill 2.6°C
‘»

Solar radiation 0
b ]

UV Index 0.0

Classic Channels Reports Dial-A-Stat More

To download the 10S clients please go to: http://itunes.com/app/poohbahindustries

Support for the 10S client is provided via the WeatherCat iOS Client Forum
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WeatherCat Preferences

This section details all of WeatherCat’s options. We suggest you read this section to fine-
tune WeatherCat to your requirements and to get an understanding of the various options
and facilities available in WeatherCat.

Location/Colours
This tab allows you to set up your location details and adjust some of the drawing options.

e OO WeatherCat Preferences

[Localion/Colors | Email On-Line  Alerts  Alerts 2 Custom Alerts Units /Miscl Misc2 Webcam Imagery = Advanced

This pane allows you to set your station name, latitude, longitude and elevation. ‘Graph Drawing' sets various
parameters for the basic graphs WeatherCat can draw.

Station Details

Enter station name, elevation, latitude and longitude in degrees, minutes &
hundredths of a minute. You must click ‘Set Details' for these details to be registered.

Weather Station Name

Local ‘-‘
Lat: 52 44 0 ¢] Elevation: 130 Metres

Set Details ‘ Delete Data

Lon: O .0

Drawing/Basic Graphs

Graph Background Color ‘ E ‘ Graph Line Width —g—
. Graph BG Blending S
_] Missing Data Color - L
Graph FG Blending ==(g=
Basic Graph Scale (Days) : : :
Missing Data Style | Solid Line [ ]

56 28 14 7

o

Basic Graph Display Filter
off
Gauges

[ -
Background [:] ‘ Fill ‘ Cradient 3 —3]
Frame ‘ - ‘ Text ‘ - ‘ Pointer ‘ - ‘ Pointer Shadows @
Frame | | Secondary | |
widh “97 mercury | [ ~rcincer | NI

Please see the basic setup section of this manual for a description of the Location details.
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Basic Graphs/Gauges Colours

These areas of the preferences allows the colour of various elements within WeatherCat to
be changed.
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Preferences — Email

S NN WeatherCat Preferences

( Location/Colors | Email | On-Line  Alerts  Alerts 2 Custom Alerts Units /Miscl Misc2 Webcam Imagery = Advanced )

WeatherCat can send various email messages when certain events occur. Weather alerts and records, test emails, data
emails, administrative emails can all be sent. All email is sent to the addresses in the 'Admin Addresses' field. The
addresses declared in the 'Users Addresses' field do not receive administrative emails. The address fields can take
one or more email addresses, seperated by commas.

Email

SMTP Server

SMTP Server Port 25

User Password () Authentication

Email 'From' Field weatherbox@trixology.com

Admin Addresses Test Now )
User Addresses Test Now )

Daily Data Email

M Send Temperature M Send Pressure
# send Dewpoint # Send Windspeed

User Text (Included in all Emails)

Sent from my Mac

@ Email Forecasts @ Email Reports M Email New Records @ Send Admin Emails

SMTP Server:
Enter the address of the SMTP server you wish to use to send email.

Port:
Enter the port on the SMTP server to use. Normally this is 25.

User and Password:

If your mail server requires it, enter your username and password in these fields.
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Authentication:

Tick this if your server is set to use authentication — typically this takes the form of SSL or
TLS. WeatherCat automatically negotiates the best method to use.

Admin Addresses:

Enter the address(es) you would like all of WeatherCat’s alerts and other emails sent to;
multiple addresses are separated by commas. After entering an email address you can test
it 1s working with the ‘Test Now’ button. WeatherCat will try to send a test email and
notify you of the results. If the test fails an error message will be displayed.

The Admin Email addresses receive all emails sent from WeatherCat. If WeatherCat
detects a problem it tries to send admin emails to these address. For example if WeatherCat
detects the CWOP task is no longer responding, it will send an email to the Admin
addresses and try to restart the task. The results of the restart will be emailed again to the
Admin addresses.

User Addresses:

All emails apart from Admin emails are sent to these addresses. Again you can test them
with the ‘Test Now’ button.

Email Forecasts

If this tick-box is ticked, and your hardware support forecasts, WeatherCat will email the
current forecast at 7 a.m., 4 p.m. and midnight. This feature is currently supported by
WS23xx’s, WMR200’s, Davis Vantage and Vue.

Email Reports

If this tick-box is ticked, every 24 hours, WeatherCat will email the daily report. On the
last day of the month it will also email the monthly report.

Email new Records

When this option is selected, whenever a new weather record is set, WeatherCat will send

out an email detailing the record that has been broken; for example:
****New Low Pressure Record for MyStation! Previous low was 983.07mBar on 2012-09-16 17:41:12
+0000. New low is 982.06mBar****

Sent from WeatherBox

WeatherCat checks for the following types of new record emails:

1. New all time records.

2. New annual records.

3. New monthly records (i.e. the hottest May temperature on record).
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Send Admin Emails

When this option is selected, if WeatherCat has a problem it thinks you should be notified

of, it will send an email to the Admin email addresses.

Daily Data Email

This section allows you to set WeatherCat to send you an email with a tab-delimited data
set covering the previous 24 hours weather data. You can select which items of data you
want sent. The format of the message is as follows (we have snipped out most of the data

as indicated by °..."):

WeatherCat Daily Data Message.

Posted at 00:00:03 17-Feb-12
Data for My Station follows:

Temperature
6 6 6 6 6 6
6

Dewpoint
2 2 2 2 2 2
2

Windspeed
2 2 2 2 2 2
2

Pressure

1025 1025 1025 1025 1025 1025

1025 ..

User Text: Sent from Fellini

END MESSAGE

The data included in the email is spaced at 1-minute intervals, thus there are 1440 entries
(24 hours x 60 minutes per hour) for each variable sent. The email is sent shortly after

midnight each day.

User Text

Any text entered here is sent with all emails. You might for example want to use it to

indicate from which machine the message was sent.

Page 127



Preferences — On-Line
This tab is split into a number of sub-panes and covers the settings for all of WeatherCat’s
on-line features.

Simple Web

8 00 WeatherCat Preferences

| Location/Colors Email m Alerts Alerts 2 Custom Alerts Units/Miscl Misc2 = Webcam Imagery | Advanced |

Sl SES Custom Web | Custom CGI | Wunderground PWS | CWOP | Additional Services |

Use this pane to configure web pages generated by WeatherCat that are then uploaded to your web-site. The
minimum set-up necessary is to check 'Create Web Pages', edit the texts in the Texts' tab, set how often you want the
web pages uploaded to your web site and set up the FTP details here. If you wish WeatherCat to modify and upload
your own pages, use the 'Custom Web' tab of these preferences.

seup T

[ | Create Web Pages

Update Web Pages Every: | 15 Minutes

Save Pages At: /Users/stu/Library/Application Support/WCWeb | Set Save Path |

Add WebCam Picture To Web Pages

Picture Size:| 320*240 + |

Or Use The Following URL To A Camera Picture:

Add Journal To Web Pages

Enable FTP Upload

FTP User Name: Not Set Edit FTP Details |

Create Web Page
This option enables and disables all web related functions of the Simple Web pages.

Update Pages Every:
WeatherCat will generate and upload pages as per the time period set here.

Set Save Path:
Before WeatherCat uploads web pages to your web server it has to create and save them

somewhere. The default location is ~/Library /Application Support/WeatherCatWeb. We
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suggest you leave this as set. However, if you are serving the web pages via personal Web
Sharing you may need to change this location (with the ‘Set Path’ button) to suite your
local server. Typically this will be the ‘Sites’ folder in your home directory. Please make
sure the user running WeatherCat, has write permissions to wherever you set this path.

Add Web Cam Pictures To Web Pages
WeatherCat can add a web cam picture to your web pages. You can use either your own
web cam, or you can link to someone else’s web cam pictures.

Please see the section ‘How Do I Use A Web-cam With WeatherCat’ for details of setting
up your webcam.

Alternatively, by clicking the ‘Or use the following URL...’ checkbox and entering the
URL to the web cam picture you wish to use, WeatherCat will generate the required
HTML code to link to the picture. Typically web cam’s can be found on Internet Search
sites such as http://www.google.com

WeatherCat can only link to picture based images; for example .jpg and .png files; Java
based web cam images probably won’t work.

Add Journal To Web Pages
If this option is checked WeatherCatl will upload a page for the journal and add a link to
the main page.

Enable FTP Upload
If this option is ticked then WeatherCat will FTP the web pages up to your web server. You
need to set the FTP login and server path via the ‘Edit FTP Account’ button.

Edit FTP Account

This button allows you to set and edit your FTP login name, password and the path on the
server to where the web pages should be sent. A test button allows you to perform a test
upload to the server.

About FTP

For WeatherCat to be able to upload the web pages to your server, the full path must
already exist. For example if the path to upload your pages should be:
ftp://ftp.myserver.com/www/WeatherCatWeb/

then the directory WeatherCatWeb must exist before WeatherCat can upload to it.

To prevent possible problems with Firewalls WeatherCat always uses PASV mode when
establishing an FTP connection.
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Simple Web - Text

e 00 WeatherCat Preferences

{ Location/Colors Email | On-Line | Alerts  Alerts 2 Custom Alerts Units /Miscl Misc2 Webcam Imagery  Advanced )

[ Simple Web | Custom Web ~ Custom CGI  Wunderground PWS ~ CWOP |

Use this pane to configure web pages generated by WeatherCat that are then uploaded to your web-site. The
minimum set-up necessary is to check 'Create Web Pages', edit the texts in the Texts' tab, set how often you want the
web pages uploaded to your web site and set up the FTP details here. If you wish WeatherCat to modify and upload
your own pages, use the ‘Custom Web' tab of these preferences.

[ Setup | Text |}

Web Page Title: WeatherCat

Notes: <H4> Page Notes</H4>You can enter information about your station in the 'Notes' field
of WeatherCat's Simple Web preference pane (Text tab). You can use HTML tags and
WeatherCat macro tokens. Useful items might be a description of the location, its latitude
and longitude, which direction the web cam is facing etc.

[ Use Custom Web Page Background Graphic

Set Picture

Upload Now ( Test Web Pages Locally ) ( Save Texts )

This tab allows you to set the title of your web pages, add notes that are displayed on the
page and set a custom background graphic. Please note that the texts are not automatically
saved, you must press the ‘Save Texts’ button to commit the changes to your web pages.

Test Web Pages Locally

This button will cause WeatherCat to generate the web pages and display them in your
default browser. This is a useful time saver when checking edits to the pages without have
to upload them to your web site first.
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Custom Web - Main

S NN WeatherCat Preferences

( Location/Colors Email | On-Line | Alerts Alerts 2 Custom Alerts Units /Miscl Misc2 =~ Webcam Imagery  Advanced )

[ Simple Web | Custom Web | Custom CGI  Wunderground PWS ~ CWOP |

WeatherCat can take your web pages, replace various tags in them with weather data, graphs, dials and the web-cam
picture and then save the pages for uploading via FTP. Click 'Show Help' to display help for the Custom Web Pages
and a reference describing each tag WeatherCat can process.

Show Help

[ Main | Additional Files

"HTML Source' is the folder in which your HTML source files can be found. 'Save Pages At' is the folder where
WeatherCat will put the HTML after replacing the tags. If 'Enable FTP Upload' is checked, then WeatherCat will FTP the
files to your web server. Note that all items are uploaded in a flat hierarchy on the server.

- [ Enable Custom Web Pages

Set HTML Source | HTML Source: [Users/stu/Desktop/WeatherCat090B100/Web Templates/
atkinsfamily.org

Set Save Path Save Pages At: /Users/stu/Library/Application Support/WeatherCatCustomWeb/

__ Enable FTP Upload

Update Web Pages Every:

15 Minutes v

FTP User Name: Not Set Edit FTP Details ¥ Sync. To Weather Fetch

(Test Web Pages Locally )

WeatherCat can take your web page templates, replace WeatherCat tags within the files
and upload the resultant file and related objects to your web-server.

Show Help

This button will open a window containing basic help for custom web pages and a
reference to the tags WeatherCat can use in custom web pages:
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(<O N&) Custom Web Help

WeatherCat Custom Web Pages Help -
™
WeatherCat can take your web pages, replace any special tokens, or tags', with weather data and then upload |
the new files to your web server. '
!
To set up WeatherCat follow these steps: '
!
1. Create a folder somewhere for your web pages - for example in your Documents folder and call it '
something like "Weather Pages Source". !
!
v_q, 2. Referring to WeatherCat's tag reference, create your web pages in your preferred web page editor and '
é save them in your Weather Pages Source folder. Where-ever you want a weather item to appear in your pages, W
2 | insert the relevant tag, for example if you want the web-cam image inserted, use the WCAMS tag.
&
] 3. You can put other items in your source folder to be uploaded to your web site - for example images.
% WeatherCat will look in files with extensions of .htm .html .htx .css .xml .txt .php .shtml .stm and .shtm for tags
T | to replace. All other types of file are not processed but are copied to the output folder.
4. Go to WeatherCat's 'Custom Web Pages' pane of the preferences and using the 'Set HTML Source'
button navigate to your 'Weather Pages Source' folder as per the picture below. This tells WeatherCat where to
find the pages to be processed.
[Z] Enable Custom Web Pages
K ot HTMI-Sonrce-)
(_ Set HTML Source ) HTML Source: [Users/stu/Documents/Weather Pages Source v

Enable Custom Web Pages
This option enables and disables all web-related functions of the Custom Web pages.

Set HTML Source
Sets the source folder for your template.

Set Save Path

Before WeatherCat uploads web pages to your web server it has to create and save them
somewhere. The default location i1s ~/Library/Application Support/
WeatherCatCustomWeb. We suggest you leave this as set. However, if you are serving the
web pages via personal Web Sharing you may need to change this location (with the ‘Set
Path’ button) to suit your local server. Typically this will be the ‘Sites’ folder in your home
folder. Please make sure the user running WeatherCat has write permissions to wherever
you set this path.

Enable FTP Upload
If this option is ticked then WeatherCat will FTP the web pages up to your web server. You
need to set the FTP login and server path via the ‘Edit FTP Account’ button.

Note also that the Simple Web Pages and Custom Web Pages are independent of each other
including the FTP; you can run both simultaneously and to different servers if need be.
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Update Web Pages Every:
WeatherCat will process and upload pages as per the time set here. Custom web pages can
be uploaded more frequently than the Simple Web pages.

Sync. To Weather Fetch

If this option is ticked, WeatherCat will wait until it takes a weather sample before
processing the custom web pages. This ensures your pages are processed with the very
latest data and statistics.

For details of setting up a template and the tags you can use, please see the ‘How Do I
Create A Custom Web Template’ section of this manual.
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Custom Web — Additional Files

e WeatherCat Preferences

| Location/Colors Email On-Line | Alerts  Alerts 2 Custom Alerts Units /Miscl Misc2 Webcam Imagery  Advanced )

|" Simple Web | Custom Web | Custom CGI = Wunderground PWS  CWOP !

WeatherCat can take your web pages, replace various tags in them with weather data, graphs, dials and the web-cam
picture and then save the pages for uploading via FTP. Click 'Show Help' to display help for the Custom Web Pages
and a reference describing each tag WeatherCat can process.

——
{ ShowHelp )

[ Main | Additional Files |

In addition to processing a folder of files periodically, WeatherCat can also independently process individual files.
This is useful for parts of your web-site you want updated more frequently or for on-line services that take a
processed file from your web-site periodically. To add a new file, click the 'Add' button below, to delete a file,

highlight an item and click the 'Delete’ button. To edit a file, double-click it.

(" Delete ) Add

WeatherCat's Custom web feature can process additional files independent of the main
custom web processing. For each file, the processing period can be set from between 0.1 to
10000 minutes and the file, once processed, can be optionally uploaded to your custom
web-site. This is useful for faster updates for certain parts of your web-site or generating
files for on-line services that can pick up the processed file from your custom web-site.

Notel: With the ability to process and upload files as fast as once every 6 seconds there is
the potential for:

a). Using far more bandwidth than you thought you'd use.

b). Being identified as a denial of service attack by your FTP server (this can be
extremely embarrassing).

c). Generating files faster than WeatherCat can actually process them (this is dependent
on your hardware and tags used - for example a webcam tag can take many seconds to
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process as WeatherCat waits for the image to settle down). WeatherCat is protected against
files being generated faster than they can be processed - it will log a message to the
console log in this case.

Note2: If Custom web is synchronised to weather sampling, additional files will not be
processed whilst custom web is waiting for the sync (i.e. additional files are queued whilst
custom web is waiting for sync).
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Custom CGl

e OO WeatherCat Preferences

[ )|

Location/Colors Email | On-Line | Alerts Alerts 2 Custom Alerts Units /Miscl Misc2 Webcam Imagery = Advanced

(

Simple Web ~ Custom Web | Custom CGlI | Wunderground PWS = CWOP |

WeatherCat can deliver data to your own custom CGI running on your web server as frequently as you like. WeatherCat
performs an html 'get' on the url below with the current weather data appended as parameters. For example, if the
URL to your script is: "http:/ /www.myserver.com/submit_weather.php?' WeatherCat will append (data below is
example data):
'‘&dateutc=2011-02-18+2%3A21%3A27&winddir=230&windspeedmph=12&windspeedmphav_10m=12&windgustmp
h=12&windgustdir=189&windgustmph_l0m=23&windgust_dir_10m=167&humidity=90&dewptf=29&tempf=32.2&ra
ininch=0&rain24hinch&baroinch=30.2&action=update' and then send it. Note that if a value isn't available it will not
be included.

Custom CCI

URL To CGI:  http://www.myserver.com/submit_weather.php?ID=joeblog&PASSWORD =xxxXXX

Current Data:

[} Send Time As Local CUTERERGLS
[ Reports Sent: 0
Update Rate @ 5 In Seconds Acknowledgments: 0
Response Time: 0
( start ) Bytes Sent: 0
Stop Current Status: Disabled

The Custom CGI tab of the On-Line preferences allows you to send weather data in real-
time to a server on the Internet. Please see the ‘How Do I...” section for a tutorial on how
to use this feature, here we will describe the preferences.

URL To CGI

Enter the URL to your CGI script here including any static parameters needed such as the
user name and password. WeatherCat will append the real time data to the request as it
runs.

Update Rate

Here you can set how often WeatherCat makes the request. You can set times as low as 0.1
second.
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Current Status
The Current Status Area indicates how many requests have been made (Reports Sent), how

many acknowledgements have been received, the instantaneous and average response
times and the number of bytes actually sent.

The Current Stats field indicates any problems with the CustomCGI — a range of errors can
be reported here which can aid in diagnostics, if there are no errors, ‘Running’ is shown.
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Wunderground PWS

WeatherCat can upload your weather data to Wunderground. Please see the ‘How Do ...’
section of this manual for details on how to set up the preferences on this tab. The section
will detail the individual preferences.

Location/Colors ~ Email m Alerts

Simple Web Custom Web

WeatherCat Preferences

Alerts 2 Custom Alerts Units/Misc1 Misc2 Webcam Imagery Advanced

Custom CGI CwWOoP Additional Services

WeatherCat can deliver weather data to your Wunderground™ personal weather station page. This service is free and
allows you to see your weather data in any web browser. If you do not have an account yet, click on the 'Create Account'
button below then fill in your details and click the ‘Start' button.

Wunderground Personal Weather Station

Configuration

Update Rate In Minutes
(1 to 30 minutes)

Rapid Fire Mode

Update Rate In Seconds

Camera I.D.
Camera Key

Update Rate In Minutes (| |5

Station I.D. Start
Current Status

Password/Key Reports Sent: 0
Acknowledgments: O
Send Inte?rnaI.Temp. and Hum. Response Time: 0
Enabl? Hls.torlcal Uploads Bytes Sent: 0
Log Historical Uploads i

Log Sent Data Current Status: Disabled

Enter your Station ID and password then click the Start button. If you are using a Create Wunderground Account

web-cam you can also enter your camera 1.D./key and set the update rate to upload
your web-cam image to Wunderground.

Update Rate In Minutes

How often WeatherCat should upload data to Wunderground. WeatherCat can run in two
modes — normal or RapidFire. Normal mode can update at a maximum rate of once per
minute, RapidFire can update as fast as 1 second. We would recommend RapidFire set at
about 5 seconds for good performance.

Rapid Fire Mode

Enables WeatherCat’s RapidFire mode.
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Update Rate In Seconds
If RapidFire mode is enabled, how often in seconds WeatherCat should upload the data.

Enable Historical Uploads

WeatherCat will upload missing records to Wunderground if it determines the last upload
was more than 32 minutes ago. Historical records are uploaded at 5-minute intervals and
all valid channels are uploaded. This can happen if for example WeatherCat was not
running, your Internet stops working or the Wunderground servers go temporarily off-line.

If WeatherCat has not been running for a period of time, the historical upload to
Wunderground will be held off until WeatherCat has read the missing data from your data-
logger.

You can cancel a historical upload by disabling historical uploads, waiting a few minutes
until real time operation resumes then re-enabling the feature to cover periods when
WeatherCat isn’t running in the future

If it appears WeatherCat is not transmitting live data to Wunderground, it may be
uploading historical data. You can check this is the case by enabling logging of the
historical uploads and checking WeatherCat’s log window.

Log Historical Uploads
If this is ticked, historical upload progress is logged to WeatherCat’s log window.

Send Internal Temp. And Hum.
If this is ticked, internal temperature and humidity data will be sent (if available from your
station).

Upload Webcam Image

WeatherCat can upload your webcam image to Wunderground. Enable this tick-box, enter
your Wunderground Camera ID and set the update rate in minutes. Note that the webcam
must be enabled in the Webcam tab of WeatherCat’s preferences.

You can get a Wunderground camera [.D. from your Wunderground members’ page.
Current Status
The Current Status Area indicates how many reports have been made (Reports Sent), how

many acknowledgements have been received, the instantaneous and average response
times and the number of bytes actually sent.
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The Current Stats field indicates any problems with the Wundergound PWS task — a range
of errors can be reported here which can aid in diagnostics, if there are no errors,
‘Running’ is shown.

Programmatic access to WeatherCat’s Wunderground status can be obtained via the
AppleScript interface.
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Citizen’s Weather Observer Program

WeatherCat can upload your weather data to the Citizen’s Weather Observer Program
(CWOP). Please see the ‘How Do I...” section of this manual, for details on how to set up
the preferences on this tab. The section will detail the individual preferences.

e WeatherCat Preferences

I Location/Colors Email On-Line Alerts Alerts 2 Custom Alerts Units /Miscl Misc2 Webcam Imagery  Advanced

I Simple Web Custom Web Custom CGI Wunderground PWS cwor |

WeatherCat can deliver weather data to the Citizen's Weather Observer Program. This service is free and allows you to
see your weather data in any web browser; in addition data sent to CWOP is validated and then made available to
various weather organisations world-wide. If you do not have an account yet, click on the 'Create.. Account' button
below, then fill in your details and click the 'Start’ button. If '‘Generate WXNOW.TXT file' is checked then the packet
sent to CWOP will be saved in ~/Application Support/WCWeb/

Citizen's Weather Observer Program

Configuration Current Status
Station I.D. ( Start ) Reports Sent: 0
) h——
. Acknowledgments: 0
|_ Log Operation Stop
| Generate WXNOW.TXT file Current Status: Disabled

Enter your Station ID then click the
Start button.

Create CWOP Account

(" Advanced Settings ) (" Go To Your CWOP Web Page )

Station ID
Enter your CWOP station ID here.

Log Operation
If ticked, WeatherCat will report CWOP transmissions in its log window.

Current Status

Shows the current status of the CWOP task — as with other WeatherCat on-line tasks, a
range of errors can be reported here which can aid in diagnostics. If there are no errors,
‘Running’ is shown along with the CWOP server WeatherCat last contacted.
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Advanced Options

This button opens a sheet with additional options for CWOP. Normally you shouldn’t need
to touch these but occasionally things at CWOP change (servers for example) so you may
need to adjust the data that is sent.

CWOP - Advanced Settings

This is the list of servers and their ports in the order WeatherCat will try when connecting to

CWOP.

Server 1 | cwop.aprs.net | Port 14580
Server 2 first.aprs.net Port 14580
Server 3 second.aprs.net Port 14580
Server 4 third.aprs.net Port 14580
Server 5 fourth.aprs.net Port 14580

Up.ﬁ;:: @ 10 Minutes (This time period is randomised by up to +5%)

Passcode: -1 Just the passcode - do not enter ‘vers ' etc

Data To Omit

You may not want to send sensor data you know to be inaccurate to
CWOP (for example a faulty external temperature sensor). These check-
boxes tell WeatherCat which data you DO NOT want to send.

! Wind __ Rain | Humidity
__| Temperature || Pressure
4 A 4 A
. Restore Factory Defaults ) ( Cancel ) ( OK )

Server 1 through 5

WeatherCat tries the CWOP servers, via the respective port in the order listed here. Only
change these if you are sure of the new settings. If in doubt, ask on the WeatherCat support
forum.

Update Time

Periodically CWOP changes their advice about how often to report — at the time of
publication it is 10 minutes, if it changes you can adjust the time here.
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Passcode
If you need to use a passcode, enter it here.

Data To Omit

Data sent to CWOP is ingested by various weather organisations — MADIS is typical.
From here the data is further disseminated to other organisations, such as The Weather
Underground. Because of the importance placed on your data you may not want to
transmit certain data if you know there is a problem with that data. The check boxes here
allow you to disable certain items until such time that the data is good again. A typical
example might be anemometer wind damage.

Restore Factory Defaults
Restores all the advanced settings back to defaults.

Programmatic access to WeatherCat’s CWOP status can be obtained via the AppleScript
interface.
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Additional Services
WeatherCat can upload your weather data to additional services.

[ ] WeatherCat Preferences

Location/Colors Email Alerts Alerts 2 Custom Alerts Units/Misc1 Misc2 Webcam Imagery Advanced

Simple Web  Custom Web  Custom CGI  Wunderground PWS  CWOP [REGERTLETEETT

WeatherCat currently supports these additional on-line services. Click a service below to open the settings for

_/'N-_
Iiiiil
Met Office III

weathar '

AWEKAS

2

Y3y

Click the service you wish to configure/view to open it.
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Met Office WOW (World Of Weather)
This tool can upload your weather data to the Met Office WOW website.

e OO MetOfficeWOW

Configuration Current Status

Reports Sent: 0

(<)

Update Rate In Minutes - |15 e
Response Time: 0

Site1.D: | Success Rate: N/A
PIN: eecees Bytes Sent: 0

- Current Status: Disabled
Log Sent Data |_

(" Create A MetOfficeWoW Account )

Go To Your MetOfficeWoW Page

You can create an account from within the tool. When you have your Site I.D. and PIN,
enter them into the relevant fields then hit the ‘Start’ button.

Notes:

1) Soil moisture is uploaded from soil moisture sensor #1.

2) Soil temperature is uploaded from soil temperature sensor #1 (soil temperature appears
as grass temperature on the WOW site).

3). The Met-Office recommends upload intervals of at least 15 minutes (which is the
default on a new installation) - WeatherCat will allow down to 1 minute intervals should
the Met-Office recommend more frequent uploads in the future.
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PWSWeather

This tool can upload your weather data to the PWSWeather website.

800

PWSWeather

Configuration

Update Rate In Seconds @ 300

Station I.D:

Password: eesccccccce
—

Log Sent Data |_

—

.'EW'.M! Stop

Ty
[ Start )

Current Status

Reports Sent: 0
Acknowledgments: 0
Response Time: 0

Success Rate: N/A
Bytes Sent: 0

Current Status: Disabled

(" Create A PWSWeather Account )

Go To Your PWSWeather Status

You can create an account from within the tool. When you have your Station [.D. and
Password, enter them into the relevant fields then hit the ‘Start’ button.
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WeatherCloud
This tool can upload your weather data to the WeatherCloud website.

e OO0 WeatherCloud

Configuration Current Status

Reports Sent: 0
Update Rate In Minutes: @ 10 Acknowledgments: 0
Response Time: 0

WeatherCloud I.D.:
758637b97f4 Success Rate: N/A

WeatherCloud Key: seeececccccccs

Bytes Sent: 0
Log Sent Data ¥ Current Status: Disabled
Stop | Start | | Create A WeatherCloud Account |

| Go To Your WeatherCloud Status |

V1.0.0

You can create an account from within the tool. When you have your WeatherCloud I.D.
and Key, enter them into the relevant fields then hit the ‘Start’ button.

Note: When creating your device on the WeatherCloud web-site, the ‘Link type’ should be
‘WeatherCat’.
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AWEKAS
This tool can upload your weather data to the AWEKAS website.

O AWEKAS

Configuration Current Status

Reports Sent: O

Update Rate In Seconds Acknowledgments: 0

Response Time: 0

User Name: |trauts Success Rate: N/A

Password: eeeececcceece Bytes Sent: 0

Current Status: Disabled
Log Sent Data

Start Create An AWEKAS Account

A'X“AWE KAS Automatic Weather Map System

find out whot the weother s doing

You can create an account from within the tool. When you have your AWEKAS user name
and password, enter them into the relevant fields then hit the ‘Start’ button.

More information about AWEKAS can be found at: www.awekas.at

Notes;

a) The AWEKAS uploader honours the minimum upload period set by the AWEKAS
server (as defined by your account level). If your update rate is set too fast, WeatherCat
will automatically slow it down to the rate requested by the AWEKAS server.

A message will be logged to WeatherCat's log window if this happens.

b). The uploader uploads everything except the current conditions up to position 23 in the
AWEKAS protocol including snow, solar, uv, sun hours and soil temperaturel (assuming
the relevant hardware is present on your station - if not present the relevant values will be
omitted). Current conditions are not sent as the protocol does not allow machine calculated
conditions.
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Preferences — Alerts 1

e WeatherCat Preferences

| Location/Colors Email On-Line | Alerts | Alerts 2 Custom Alerts Units /Miscl Misc2 Webcam Imagery  Advanced |

WeatherCat contains three in-built alerts. Each alert can be configured to send an email and/or launch an item such
as an Apple Script™.

Ice Alert
™ send Email
M AT
|_'Launch User Item (_ Set Item
Path:

Rain Alert

[_!Send Email  Trigger If: | Showers Or Worse T]

[ Launch User Item (set Item )
Path:
Clear Sky Alert
[Z[Send Email Trigger If: | Clear ﬂ & | Night ﬂ
[ Launch User Item (set Item )

Path:

The Alerts tab contains pre-configured alerts for Ice, Rain and Clear Sky. The Alerts 2 tab

contains a Rain Start alert (a single tip of the rain bucket).

These alerts share the following characteristics:

* A send email tick box; if ticked WeatherCat will send a pre-configured email if the
alert triggers.

A ‘Launch User item’ tick-box. If ticked WeatherCat will launch the item you’ve set
with the ‘Set Path’ button. This could be an application, AppleScript or anything else
the Finder can launch.
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Ice Alert
This alert sends a warning email as the temperature falls below 4°C and then an alert email
and launches the user item as the temperature falls below 1°C.

Rain Alert
You can customise this alert by setting the level of rain required to trigger the alert. You
can set it to: ‘Showers Or Worse’, ‘Light Rain Or Worse’ or finally ‘Rain or worse’.

Clear Sky Alert

You can set the sensitivity of this alert to either ‘Clear’ or ‘Light Cloud/Clear’. In addition
you can set it to only trigger during the night (1900 to 05:59) or day (06:00 to 18:59), or at
any time. This alert might be useful if you’re an amateur astronomer.
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Preferences — Alerts 2

Rain Start Alert

This pane currently contains one alert — the Rain Start alert.

This alert can be used to watch for a single tip of your rain bucket. It works by monitoring
the rain from your station; if the rain increases (i.e. the bucket has tipped) the alert is
triggered and a timer is started. Subsequent tips whilst the timer is running restart the
timer. The alert is cleared if the timer expires or (if enabled) a rain rate is detected before
the timer expires.

(NN WeatherCat Preferences

| Location/Colors Email On-Line  Alerts | Alerts2 | Custom Alerts Units /Miscl Misc2 Webcam Imagery  Advanced

Rain Start Alert

[ Send Email When Triggered
[ Run User Item When Triggered ( Set Item

Clears After: 1200 Seconds Or | If Rain Rate Is Detected

[ Send Email When Cleared
[ Run User Item When Cleared Set Item

This alert can be used to watch for a single tip of your rain bucket. It works by monitoring the rain from your
station; if the rain increases (i.e. the bucket has tipped) the alert is triggered and a timer is started - the timer
is set to the number of seconds set above. Subsequent tips whilst the timer is running restart the timer. The
alert is cleared if the timer expires or (if enabled) a rain rate is detected before the timer expires.
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Preferences - Custom Alerts

The basics of setting up custom alerts are covered in the ‘How Do I...” part of this manual.
This section details the individual options available when programming custom alerts and

goes into more detail.

e

WeatherCat Preferences

I Location/Colors Email On-Line Alerts Alerts 2 Custom Alerts

Units /Miscl Misc2 Webcam Imagery  Advanced !

Use this pane to set up an unlimited number of custom alerts. Click ‘New' to create a new alert. Highlight an existing
alert and click 'Edit' to change its parameters or highlight an alert and click 'Delete’ to delete the alert.

HIGH WIND 40
Solar 500
Strong solar 1000
Rain 0.1
Heavy rain 10
Twenty

Very Hot 25
Blizzard

Storm Warning
Pressure Fall
Pressure Rise
Solar 10

New

( Edit )

4 N
[ Delete )

Figure 63 - Preferences - Custom Alerts

This tab allows you to create, edit and delete custom alerts. Press ‘New’ to create a new
alert, ‘Edit’ to edit the selected alert or ‘Delete’ to delete the selected alert.

Creating and editing custom alerts

Pressing ‘New’ in the ‘Custom Alerts’ tab of the preferences creates a new alert. The alert

will have template email texts already configured.
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New Custom Alert

Rule Name: |Blizzard

Triggering
If | Temperature Is || Less Than ANE ‘C | And |
| Windspeed Is 4+ || Greater Than +| 20 MPH | And %
| Rain Rate Is + || Greater Than ] [0.1] mm

Then Perform The Following Actions...
[ JLaunch | SelectItem | Launch Path

(M Send An Email With The Following Text
WeatherCat Rule 'N$' triggered at tS.

Weather conditions for LS:

Current Conditions: C$

Note: You can use the following substitutions in the email text: NS=Alert name, L$=Location, tS=Local time and date, C$=Conditions, T
S=Temperature, D$=Dew point, WS=Wind speed, WdS=Wind direction, P$=Pressure, ITS=Internal Temperature, HIS=Heat Index, RS =

Rain rate, SS$=Solar radiation, US=UV. dT$ = Temperature change, dDS = Dew point change, dWS$=Wind speed change, dPS=Pressure
change, dITS = Internal temperature change, dHIS = Heat index change, dS$=Solar radiation change, dUS=UV change.

Clearing
Debounce Time: Perform The Following Actions When The Conditions That Caused The

Alert have Been Clear For 120 Minute(s)
[ |Launch | SelectItem | Launch Path

(¥ Send An Email With The Following Text
WeatherCat Rule 'N$' cleared at tS.

Weather conditions for LS:

Current Conditions: C$
Note: You can use the same substitutions as for when the alert triggers.

| Cancel | | Test \[ OK ]

You can enter the alert name and then up to three conditions that need to match the current
conditions for the alert to trigger. If the alert triggers you can set an item to launch and/or

send an email.

Similarly, when the alert clears you can set an item to launch and/or send an email alert.

For an alert to clear, WeatherCat needs to see the conditions that caused an alert to be not
present for a period of time (the de-bounce time). This can be 0 if you want the alert to

clear immediately.

This de-bounce time can be used to ensure the alert doesn't clear if the variable is a little
unsteady - for example if we have an alert to trigger at 7°C and above and the temperature
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becomes 7°C then the alert will trigger. Now it's possible for the temperature to drop to
6.9°C before moving back to 7°C - the de-bounce time can stop the alert clearing during
this period. All custom alerts default to 2 hours; you will need to edit them to set the
clear times you want.

Custom Alerts Email Macro Expansions

The text of the alert email can have macro expansions as follows:
* NS - The rule name.
® LS$ - the location being monitored
* t$ - the local time
* (S - the current conditions
* T§$ - the current temperature
* DS - the current dew point
* WS - the current wind speed
* WdS - the current wind direction
* PS§ - the current pressure
* ITS - the current internal temperature
* IHS - the current internal humidity
* HIS - the current heat index
* RS - the current rain rate
* S§ - the current solar radiation (if supported by your station)
* US - the current U.V. index (if supported by your station)
* dTS$ - the current hourly change in temperature
* dDS - the current hourly change in dew point
* dWS - the current hourly change in wind speed
* dPS$ - the current hourly change in pressure.
* dITS - the current hourly change in internal temperature
* dIHS - the current hourly change in internal humidity
* dHIS - the current hourly change in heat index
® dS§ - the current hourly change ins solar radiation
* dUS - the current hourly change in U.V. index

The rule text is editable on a rule-by-rule basis. For example if you entered ‘Current
Conditions = C§’, if the current conditions were sunny when the alert was triggered, the
email as sent would read ‘Current Conditions = sunny’.

Testing of Custom Alerts

You can test the alert before committing it by pressing the ‘Test’ button in the New/Edit
custom alert dialog above.

Here you can enter values for each of the three variables, then press the ‘Test’ button. The
result is indicated in the ‘Result:” text field. You can use this test dialog in conjunction with
the ‘New/Edit’ custom alert dialog box to fine-tune the alert to your requirements.
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Please enter test data below then hit the 'Test' button to see the results of the rule.

Current Conditions ' sunny

Current Variable 1 :] Variable 1 change :]
Current Variable 2 :I Variable 2 change :I

Result: Test Not Run

Current Variable 3 :’ Variable 3 change :’

Custom Alerts Programming Example

WeatherCat allows you to set up to three conditions that must be matched before the alert
triggers. These conditions are evaluated strictly top to bottom. As an example, let’s look at
the following alert:
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Edit Custom Alert 'Blizzard'

Rule Name: Blizzard

Triggering
If | Temperature Is ﬂ | Less Than = BES ‘C | And |5 ]
| Windspeed Is ﬂ | Greater Than ke 20 MPH | And |3 }
| Rain Rate Is ﬂ | Greater Than ks 0.1 mm

Then Perform The Following Actions...
— f—
|_!Launch ] Launch Path

Select Item )

# Send An Email With The Following Text
YWeatherCat Rule 'N$’ riggered att$. A

YWeather conditions for L$: m

Current Conditions: C$ X

Note: You can use the following substitutions in the email text: NS=Alert name, L$=Location, t$=Local time and date, C$=Conditions, T
§=Temperature, DS =Dewpoint, WS=Windpseed, P$=Pressure, ITS$=Internal Temperature, HIS=Heat Index, RS = Rain Rate, S§=Solar
Radiation, US=UV. dT§ = Temperature change, dD$ = Dewpoint change, dW$=Windspeed change, dP$=Pressure change, dITS = Internal
Temperature change, dHIS = Heat Index change, dS$=>Solar Radiation change, dUS=UV change.

Clearing
Debounce Time: Perform The Following Actions When The Conditions That Caused The
Alert have Been Clear For 120 Minute(s)

M AP
|_JLaunch [ Select Item ) Launch Path

# Send An Email With The Following Text
WeatherCat Rule 'N$' cleared att$. A

Weather conditions for L$: @

Current Conditions: C$
Note: You can use the same substitutions as for when the alert triggers.

( Cancel ) [ Test ) ( 0K )

Lets assume the temperature for location 1 is 4°C, the wind speed is 18 miles per hour and
the rain rate is 0.2 inches per hour. When evaluating this alert WeatherCat first checks the
temperature; it compares it to 3°C and finds it is greater, so sets the result of the first part
of the IF to ‘False’. Next it checks if the wind speed is greater than 20 miles per hour. It
isn’t so sets the result of the second part of the IF to ‘False’. Finally it checks it checks if
the rain rate 1s greater than 0.1 mm per hour; it is so sets the result of the third part of the
rule to ‘True’.

WeatherCat now takes the results of the first and second parts and logically AND’s them

together — a ‘False’ anded with a ‘False’ gives a ‘False’ result. Next it AND’s the result of
the third part with the intermediate result of the first and second parts — a ‘False’ AND’d
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with a ‘True’ is a False. This final result is tested and if ‘True’ the condition is triggered.
In this case the final result is ‘False’ and so the alert is not triggered.

Lets assume that an hour later that the wind speed has increased to 19 miles per hour, the
temperature has dropped to 2 °C and the precipitation is still 0.2 mm’s per hour. Now the
temperature comparison evaluates as ‘True’ and the rain comparison also evaluates as
“True’ but the wind speed criteria still isn’t met — nothing happens.

The wind keeps increasing however and ten minutes later the wind speed increases above
the 20 miles per hour set in the alert. At this point, all the criteria evaluates as ‘True’ and
the alert triggers.

In this particular case, the Alert would send the following email:

To: test@trixology.com
Subject: ***WeahterCat 'Blizzard Alert' Triggered***

*¥**Custom Alert for My Station Triggered***
WeatherCat Rule 'Blizzard Alert' triggered at 20:16:16 21-Jan-12.

Temperature: 2 °C Dewpoint: 1 °C Windspeed: 26.0 MPH Pressure: 1003.72 mb

User Text: Sent from WeatherBox
WeatherCat TimeStamp: 20:16:17 21-Jan-12

<END MESSAGE>

Five minutes later, the wind speed drops below 25 miles per hour. Because the de-bounce
time is set to 120 minutes, WeatherCat notices the drop in wind speed but does not clear
the alert yet, instead the alert changes to the ‘clearing’ state. WeatherCat continues to
monitor the wind speed over the de-bounce period (the next 115 minutes in this case) and
if the wind speed does not increase above 20 miles per hour, then the alert will clear.
However, if the wind speed does increase to over 20 miles per hour, WeatherCat resets the
de-bounce timer.

Hence, the alert will not clear until the conditions that caused it to trigger in the first place
have been clear for the de-bounce time — in this case 120 minutes.

Had we set the de-bounce time to 0 minutes, then the alert would clear as soon as any of
the conditions it requires to be met are no-longer true. Thus, if you want an alert to clear

immediately, set the de-bounce time to 0 minutes.

Once an alert has cleared, it is then ready to re-trigger.
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To sum up: Alerts in WeatherCat have 3 possible states — triggered, clearing and cleared.
Alerts will trigger immediately the conditions they are dependent upon are true. Alerts will
clear once the conditions they are dependent on have been clear for the de-bounce time.
Once an alert has cleared it can retrigger immediately.

If you are using alerts to post notifications via email and you find you are receiving emails
pretty much constantly as the alert triggers and then clears, increase the de-bounce time in
those alerts. This will ensure WeatherCat treats lulls in the conditions that are causing the
alert as part of the same event.

Editing Alerts

WeatherCat’s custom alerts monitor the weather on a continuous basis. The latency within
WeatherCat from the time data received from your station matches a particular alert and
the alert actually reacts is in the order of 10 seconds. Because each alert is monitoring the
weather there is a warm-up time associated with the alerts — in WeatherCat this warm up
time is about a minute. Thus custom alerts are not running for the first minute after
WeatherCat is launched.

When you modify an alert, the modifications are carried out live and the editing can affect
the trigger state of an alert.

For example if we have a very simple alert that triggers if the external temperature is
below 4°C and the current external temperature is 5°C - the alert is not triggered. If we
then edit that alert so it triggers if the external temperature is below 6°C, the alert will
trigger within 10 seconds of the OK button being pressed after making the modifications in
the alert’s settings. Similarly, if the de-bounce time is set to 0, the alert will clear
immediately if edited so that the trigger conditions are no-longer true.

The only exception to this operation is when you add or delete a new alert. In this case, the
alerts will start to reset. As noted above, this takes about a minute and when the alerts are
finished resetting, any alerts that were previously triggered will trigger again as they have
been reset.

Alert Deltas

Weather data deltas can be used in custom alerts — for example to test if the barometric
pressure is falling at a rate greater than a given amount (a storm alert). In general the delta
used is the one-hour delta actually measured over an hour — i.e. WeatherCat subtracts the
reading obtained one hour ago from the current value to calculate the current one-hour
delta.

The exceptions to this rule are Solar Radiation, U.V. and rain rate. These variables can

change so quickly that WeatherCat uses a one-hour delta calculated over a 10 second
period so as to be able to react to the very fast changes these variables can exhibit.
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Alert Persistence

Alerts in WeatherCat are persistent across reboots of WeatherCat. This means that if an
alert is triggered when WeatherCat is quit, if the alert is still triggered when WeatherCat
reboots, it will not re-trigger. The exception to this is if WeatherCat is updated — all
triggered states are cleared if WeatherCat detects it has been updated.
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Preferences — Units/Misc1

® 0 WeatherCat Preferences

Lecation/Colors Email On-Line  Alerts Alerts2  Custom Alerts JRSuE S Misc2  Webcam  Imagery  Advanced

This pane controls weather units, speech, the dock icon, the floating graphic and some WeatherCat monitoring
parameters. ‘Units' sets which units to use for each of the basic data types. ‘Speech’ will speak the relevant items once
every 15 minutes. '‘Dock Icon Shows' sets which readings to display in WeatherCat's dock icon. ‘Floating Graphic'
controls an image that floats above all other windows and indicates the current weather conditions. ‘WeatherCat
System' control's whether WeatherCat monitors itself for faults, and whether to at ically check whether a new
update is available.

Units Weather Speech
Temperature:  °c B - Linked “|Current [ ] Time
Dewpoint: | °c B | Change

Pressure:  mBar  |&)
Rain
Windspeed:  kmm [

Wind Direction:  Compass | Rain Season Begins: F:)agi Season Offset:
Precipitation: = mm 2 vanay | 10
. Rain Day Value: Annual Rain Offset:
: | Feet
Height: | Fee B 102 00

Time: 12 Hr

Dock Icon Shows

Temperature Wind Speed

Dew Point Wind Direction 5.0 : Dock Icon Update Time
Wind Chill Precipitation SCEEIES

Pressure Current Conditions [ Dock Text Color

Update Time
Floating Graphic Statistics Window Weather Facts
~/On Font Size: | 10 | Weather Facts Editor
WeatherCat

| Monitor & Re-launch WeatherCat

Units

This area allows you to select a unit for a given measurement. For example, you might
want your temperature and dew point displayed in °F, the pressure in inches of Mercury
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and the wind speed in kilometres per hour. Note that the units selected apply right
throughout WeatherCat, including custom alerts, reports, graphs, gauges and so on.

The temperature and dew point may be linked together to make relative humidity readings
easier to interpret. Note that when linked, the dew point units will become the same as the
temperature units.

Also note that the Temperature Units are also used for wind chill, heat index and other
temperature related channels.

Dock Icon Shows

The dock icon in Weather can show any of 9 different items or if nothing is selected, it
shows WeatherCat’s default icon. The dock icon update time is programmable from 1
second to 59 seconds; this time is how quickly WeatherCat flips from one item, say the
temperature, to the next. If the current data is not valid, the data in the dock icon is given a
red hue.

Floating Graphic
WeatherCat can display a floating current conditions graphic on the Desktop.

Wishaw, North Lanarkshire ) ) )
' The ‘floater’ displays a graphic representation of the

O . . . .
<Y, current conditions for a given location.

»

Weather Speech

WeatherCat can speak the current weather (as it samples), and the changes (i.e. falling,
steady, rising) along with the time or a combination of any or all of these items.

‘Only If Change’ forces WeatherCat to only speak if something has changed since the last
sample was taken; if nothing has changed, WeatherCat will be silent.
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Rain

Rain Season Begins

For use with the rain web-tag, WeatherCat allows you to specify when the rain season
starts (normally either January or July depending on your location).

It can be used as per the following examples:
Highest rain rate this season = STAT$RAIN:MAX:THISSEASON$ RAINUNITS$/h on
STAT$RAIN:MAX: THISSEASON: TIME$

Average rain rate this season = STAT$RAIN:AVERAGE:THISSEASON$ RAINUNITS$

Rain this season = STAT$RAIN:TOTAL:THISSEASON$ RAINUNITSS$

Rain Season Offset
The Rain Season Offset is added to the result of the following web-tag and only affects the
CURRENT rain season total result - it will not affect any other web-tag or rain time scale

(for example THISYEAR):
STAT$RAIN:TOTAL : THISSEASON$

Annual Rain Offset
This can be used to correct the annual rain web-tag (STATSRAIN: TOTAL: THISYEARS) and the
annual rain as displayed in the stats window in the first year of running WeatherCat.

Be sure to set this to 0 on the 1st of January if you do have an offset programmed.

Rain Day Value
This value is used by WeatherCat when calculating rain days. Any day with a daily rain
greater than this amount is a rain day.

Weather Facts Editor

This button will open the weather facts editor. Weather facts are small facts that can be
displayed on your custom web site with the WEATHERFACTSS tag. A new weather fact is
selected from the currently running set of facts daily or on a restart of WeatherCat.
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Facts can be added and deleted. In addition, the currently running facts can be saved and
loaded allowing the creation of sets (you might for example have a set for Christmas,
seasons of the year and so on).

O @® Weather Facts Editor

Use this tool to add, edit and delete weather facts. Entries here are displayed in your
custom web pages via the WEATHERFACTS tag. Double click an item to edit it.

New

A fire rainbow is an extremely rare phenomeno...

#2  The city with the world's highest annual rainfall... Delete
#3 Spain experienced a giant hailstorm in January...
#4 Colorado's city of Silver Lake received the large...
#5 A rainbow was visible for 6 hours (from 9am to...
#6 The most rain to fall in a single 24 hour period i...
#7 The wettest place in the world (based on the y...
#8 In New York in 1988 the temperature stayed ab...
#9 The worlds greatest temperature range at a sin...
#10 The highest temperature recorded in the world...
#11  The lowest temperature recorded in the world i...
#12  Yuma in the state of Arizona has over 4,000 ho...
#13  The strongest ever recorded wind was on Mt W...
#14  The world's largest snowflake was recorded in...
#15 On 14th April, 1986 Bangladesh was hit by the... Save Set

Load Set

Monitor & Re-launch WeatherCat

This option tries to keep WeatherCat running. We cannot guarantee WeatherCat will never
crash hence this option, if ticked, will launch a small background process, which monitors
WeatherCat. If WeatherCat unexpectedly quits it will be automatically re-launched within
20 seconds thus guaranteeing no lost data or frozen web pages. Changes to this option take
effect immediately. This option also allows WeatherCat to monitor itself for hang-ups. If a
hang is detected, it will reboot itself.
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Preferences - Misc 2

® O WeatherCat Preferences

Location/Colors ~ Email  On-Line  Alerts Alerts 2 Custom Alerts  Units/Misc1 m Webcam Imagery  Advanced

This pane contains various miscellaneous items.

FTP Station Maintenance
Log FTP Operations WeatherCat Can send you a periodic maintenance
reminder email. Click the ‘Set Mainenance Details’
Station Calibration button below to configure/edit this feature.
Set Calibration Data Set Maintenance Details
Misc Graphics Options Temperature Type Gauges - Initial Maximum
Basic Graph Shadows Initial Max.
Basic Graph Dotted Wind Gust Graph of
| Calculate Live Wind Run Vector
High Res On-Screen Basic Graphs °C 20
Blue Thermometers If Below Feezing You can set the initial maximum for temperature type
Enable Solar/U.V. Gauges gauges. If the current value or the max daily value
5 o s il -scale.
Wind direction plot style: Shortest... B exceeds the value set here, the gauge will auto-scale,
Day Types

Heating/Cooling Degree Days
You can set ‘Day Types' that are shown in the Year

Over Year data - for example a 'wind day’ might be Base Temperature (HDD): 18.3 e
counted as any day where the wind run exceeded a
certain value. Base Temperature (CDD): 18.3 °C
Set Day Types | Show on Year Over Year Statistics
Sampling

The sampling rate sets how often WeatherCat saves the weather data to your disk. A faster sampling rate gives better
resolution but also uses more space on disk.

With ‘Adaptive’ enabled WeatherCat will save the data at the period you specify but will also save more regularly if the
weather changes between samples; this can give high resolution data and save disk space. When determining if the
weather has changed, WeatherCat does not take into account the wind.

Sampling Rate: 2 Minutes B Adaptive

Log FTP Operations
If ticked, WeatherCat will log every file uploaded to its log window.

Set Calibration Data
Opens the calibration window:
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O 0 0O Calibration

' Channel Offset
Ext. temperature 0.000
Ext. humidity 0.000
Int. temperature 0.000
Int. humidity -11.000
Pressure 0.000
Wind direction 0.000

Wind speed multiplier (average): v1.2

Wind speed multiplier (gust): | 1.0

Note that weather related processes are stopped ' Cancel | [ 0K |
whilst this window is open.

This allows fixed offsets to be applied to channels where this makes sense (for example it
doesn't make sense on solar radiation, precipitation or wind speed not on derived data such
as dew point (with is a function of humidity and temperature)).

Multipliers are available for both wind gust and wind speed (average).

Note that whilst the calibration window is open, weather sampling and weather related
processes are halted until the window 1is closed. This avoids recording possibly incorrect
data whilst adjustments are made - the gauges/live data view will continue to run and
reflect the offsets applied in the calibration window. Processes that are halted include:
sampling, web pages, alerts, Wunderground, CWOP & Custom CGI.

If there is no activity, the calibration window will close after 10 minutes, weather
processing will be restarted and any changes made will be discarded. This avoids the
problem where the phone rings, you take the message and rush out of the house on an
important errand.

Multipliers are available for average wind speed (10 minute) and gust wind speed (this
includes instantaneous, 1 minute, 5 minute, 10 minute and 15 minute gust periods).

Anemometer Height Compensation
For anemometer height compensation, only the average multiplier should be adjusted.
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Height compensation values are available at the Met-Office's web site; see the 'Observer's
Handbook' (chapter 5, section 5.2.2) at:
http://www.metoffice.gov.uk/archive/observers-handbook-4th-edition-reprint

The height compensation multipliers for anemometers located over land are copied below
for heights up to 30m.

Anemometer height of:
Im=1.37, 2m=1.28, 3m=1.22, 4m=1.18, Sm=1.14, 10m=1.00, 15m=0.93, 20m=0.87,
25m=0.83, 30m=0.81

Station Maintenance

WeatherCat can send out periodic maintenance emails. When you click the Set
Maintenance Details button the following sheet appears:
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http://www.metoffice.gov.uk/archive/observers-handbook-4th-edition-reprint

Set Start Date

March 2012
M TWTTFS S

1 2 3 4
5 6 70 91011
12 13 14 15 16 17 18
19 20 21 22 23 24 25
26 27 28 29 30 31

And Then Every | Month 44

Send an email to admin addresses with the following text:

This is the periodic maintenance email from WeatherCat. A

Below we have put together an example maintenance schedule m
which you can edit to suite your needs.

1. Clean out rain gauge - check for and clear leaves, insects,
cobwebs etc. Ensure smooth and correct operation of any
mechanical parts.

2. Check all instruments for damage and general operation.
Check anemometer bearings for play and smooth operationas v

>

.
(oK

( )
e Cancel )

You can set the date of the initial reminder and the period between subsequent reminders.
You can edit the default text we have supplied by clicking anywhere in the text box.

On the specified date WeatherCat will send you a reminder email and again at the periods

specified.

Basic Graph Dotted Wind Gust Graph

If ticked, when graphing wind gust (plotted on the wind basic graph along with the average
wind speed) WeatherCat will draw a dotted line rather than a solid line.

Calculate Live Wind Run Vector

If ticked, WeatherCat displays on the wind run gauge the instantaneous wind run vector.
This tick-box also affects any WeatherCat client wind run gauges.
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High-Res On Screen Basic Graphs

If ticked WeatherCat always draws on-screen simple graphs using all samples available. If
not ticked, on horizontal scales greater than 24 hours, WeatherCat skips samples to speed
up the drawing.

Blue Thermometers If Below Freezing

If ticked, thermometer-type gauges are drawn in blue if the temperature is below freezing.
This option is also present in the client.

Temperature Type Gauges — Initial Maximum

You can set the initial maximum value for thermometer-type gauges here. If the
temperature exceeds the value set here, the gauge will auto-scale. At midnight, the scale
will reset to the value set here (if possible).

Wind direction plot style

You can choose the plotting style for the basic wind direction graph. Available choices are
Lines, Shortest Path and Dots.

Day Types

These are custom day types displayed in the 'Year Over Year' statistics; for example a
'Wind Day' might be a day where the wind run is greater than 100 miles. Day types are
specified in the Misc 2 pane of WeatherCat's preferences via the 'Set Day Types' button.

Click the ‘Set Day Types’ button to open the Day Types editor.
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Use this tool to add, edit and delete day types. Entries here are
displayed in the Year Over Year statistics. Double click an item
to edit it.

Windy Day (Daily wind run greater than 100 miles)

Hit the ‘New’ button to create a new day type, or double click an existing item to edit it.
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000 Day Types Editor

It is this type of day...

If | Wind Run/Day +| | Is Greater Than | 100

Title: | Windy Day (Daily LNind run greater than 100 miles)

[ ok |

. Cancel

——T e Q—

' Delete | . New |

Heating/Cooling Degree Days

Individual base temperatures can be set for both heating degree days and cooling degree
days in the preferences (these temperatures also affect HDD's and CDD"s on NOAA
reports). Tick the ‘Show On Year Over Year Statistics to display these values on the year
over year statistics.

Sampling

The sampling rate sets how often WeatherCat saves the weather data to your disk. A faster
sampling rate gives better resolution but also uses more space on disk. The sampling rate
can be set to between 1 and 30 minutes.

WeatherCat will align its sampling to the local time — for example if you set WeatherCat to
sample at 5 minute intervals, then the samples will be taken at 5 past the hour, 10 past, 15
minutes past and so on. This feature can be used in conjunction with the Custom Web
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Pages ‘Sync. To Weather Fetch’ option to ensure data on your custom web pages is
updated at the same times each hour assuming the custom web update rate is set to less
than or the same as the sampling rate.

With 'Adaptive' enabled WeatherCat will save the data at the period you specify but will
also save more regularly if the weather changes between samples; this can give high-
resolution data and save disk space. When determining if the weather has changed,
WeatherCat does not take into account the wind. With adaptive enabled WeatherCat will
sample at a rate between once per minute and the period you have set in the Sampling Rate
pop-up menu.
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Preferences - Webcam

@ WeatherCat Preferences

Location/Colors Email On-Line Alerts Alerts 2 Custom Alerts Units/Misc1 Misc2 Imagery Advanced

WeatherCat can capture images from your web-cam at predetermined intervals. These images can be used to create time-lapse movies
of the weather (these can be uploaded to your web-site). You can overlay the current weather conditions along with the time and date
onto the web-cam image. These overlays will be present on movies, local images and images uploaded to your web-site. Images
uploaded to Wunderground have no overlay apart from the time. NOTE: The times set here relate only to how often media is captured. It
doesn't affect image capture for web pages or Wunderground (see the Wunderground preferences). Daily movies are stored in your ~/
Movies/WeatherCatMovies folder.

Web-cam Enabled
Image Source
USB Camera:
° Local File: Set Path | [Users/test/Cameralmage/image.jpg

Image From URL:

Overlay
Capture Options
g = Overlay Time

Capture Image Every: Minute B Overlay Current Data
Source Image Size: | 12807960 u Add 1 Hour Deltas
Disable Webcam At Night ST AEIRET I -
Please Set Header Text in Web (
Media

Time-lapse Movies

Create Movies

Movie Size: | 3207240 %]

Movie Length Per Hour Of Capture Inter-frame Dissolve

15 Secs. off

Log Informational Web-Cam Messages Show Image Preview

WeatherCat can capture images from your camera at predetermined intervals. These
images can be uploaded to web-pages and the Weather Underground. It can also create
time-lapse movies from the captured images which again can be uploaded to your web-site
via tags.

The webcam can be directly plugged in and controlled by WeatherCat or you can pick up

an image from a local file (updated by third party webcam software for example) or from a
URL, which is useful for IP based cameras with in-built web severs.

You can also overlay the current weather conditions along with a header and time/date
onto the webcam image. These overlays will be present on movies, local images and
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images uploaded to your web site. Images uploaded to Wunderground have no overlay
apart from the time and header text.

The Webcam preferences contain the master enable for the webcam — the ‘Web-cam
Enabled’ tick-box. If this isn’t ticked then webcam images and movies will not be
available.

Image Source

As noted above, WeatherCat can capture an image from a locally connected camera, a
local file or from a URL. Available locally connected USB cameras are listed in the
‘Camera’ pop-up menu.

Note that the resolution of images from either a URL or file should be 72 DPI.

Capture Image Every

If the webcam is enabled then a picture is taken at the period specified here. This also
specifies how frequently a frame is added to movies. 30 seconds to a minute is a good
starting point.

Source Image Size

The ‘Source Image Size’ pop-up menu selects the size WeatherCat should try to capture
the image at. For locally connected USB cameras, WeatherCat will try to adjust the camera
to the resolution selected here (Note: Depending on your camera, the resolution may not
exactly match the resolution set here - the camera will pick the closest match it has
available).

For images captured from a local file or URL, WeatherCat will use the image size as it
finds it.

For use on your custom web pages there are various web-tags to produce a scaled image
from the initial capture.

Disable Webcam At Night

I this option is selected, the webcam will stop capturing 1 hour after sunset and restart 1
hour before sunrise. Similarly movie creation will stop and start at these times (if movies
are enabled).

Movie Size

This pop-up menu specifies the frame size of the time-lapse movie. We strongly suggest
you do not make this larger than the ‘Camera Image Size’ to avoid image degradation.
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The larger the movie size the larger the movies and the more time it will take to process
each frame as it is captured. Start with an initial size of 320x240, especially if you are
uploading the movie to your web site.

Overlay
These options control overlay elements for images and movies.

Create Movies

If enabled, WeatherCat will create both a 1 hour time-lapse movie and a daily 24 hour
movie every hour. Frames will be recorded at the rate specified by the ‘Capture An Image
Every’ pop-up menu. Note that movie creation is a processor intensive task and can cause
your computer’s fans to spin up for a period of time as the movie is being created.

Time-lapse movies are available for use in custom web pages by using the MOVIES or
DIALY MOVIES tags.

MOVIES will upload a 1 hour movie covering the previous hour on the first upload after
the hour. The file uploaded by this tag is called ‘WeatherCatlhrMovie.mp4'.

DAILY MOVIES will upload the current daily movie on the first upload after the hour.
The file uploaded by this tag is called 'WeatherCatDailyMovie.mp4'. The daily movie is
created every hour as the day progresses and includes all frames captured since either
midnight or 1 hour before sunrise (if the disable webcam at night option is on).

Daily movies (not 1 hour movies) are archived at ~/Movies/WeatherCatMovies as they are
created. Year and month folders are created to aid organisation. Note, WeatherCat never
deletes archived movies.

Movie Length Per Hour

This sets the amount of time 1 hour of movie takes to play back. The default is 15 seconds.
Changes made here will take affect the next time the movie is created.

Inter-frame dissolve

This option (default off) creates additional frames to smoothly dissolve between one
captured frame and the next. This can result in smoother looking movies if the capture rate
is slow. Please note that enabling inter-frame dissolve will increase the movie size
significantly.
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Preferences — Imagery

(NN WeatherCat Preferences

| Location/Colors Email On-Line = Alerts = Alerts 2 Custom Alerts Units /Miscl Misc2 Webcam | Imagery | Advanced

WeatherCat can download satellite imagery, maintained as 3 channels. Enter the URL and update rate for each
channel. In addition, the imagery can be chosen to be the desktop background picture.

Channel 1 URL http://image.weather.com/images/sat/europesat_tZ] ( Preview )

Update Every | 6 Hours e ] ™ Enabled

Channel 2 URL  http://www.goes.noaa.gov/GIFS/WCIR.JPG Z] ( Preview )

Update Every | 6 Hours s ] [ Enabled

Channel 3 URL http://www.usatoday.com/weather/twc_images/aua ( Preview )

Update Every | 6 Hours s ] ["JEnabled

Preview

Use As Desktop Picture | None Iy

WeatherCat can fetch and store up to three ‘channels’ of imagery in its database. The
satellite imagery window (Tools menu) can either display the most recent imagery as a
static image, as a movie loop, or, as you scroll about the data from WeatherCat’s Daily
View window, the historical image for that time and date (assuming it is present in your
database).

If no imagery is available in the database for a given date and time, WeatherCat will
display colour bars.

For each channel you can either set one of the supplied imagery URL’s or enter your own.
The preview buttons show the image for a given URL. The update menus specify the
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period between each fetch of the imagery for each location; these generally range from
every 2 hours to every 6 hours.

Note: Because of the storage requirements for satellite imagery, we recommend an
imagery update interval of 2 hours or greater.

The ‘Use As Desktop Picture’ menu can set the imagery for any of the channels as the
Desktop picture on the main monitor as the imagery is updated.
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Preferences — Advanced

0] WeatherCat Preferences

Location/Colors Email On-Line Alerts Alerts 2 Custom Alerts Units/Misc1 Misc2

NOAA Report Logging
NOAA High Temp: 32.0 °C Speak Log Entries
NOAA Low Temp: -17.8 °C

Startup/Shutdown Actions
When WeatherCat Has Finished Starting Up, Launch The Following Item:

Clear Item Set Item
When WeatherCat Is Shutting Down, Launch The Following Item:

Clear Item Set Item

Wait For Seconds For Shutdown Items To Complete

Station Comms Fail Actions
Run User Item On Unrecoverable Station Comms Fail

Set Item

Play Sound On Unrecoverable Station Comms Fail

Set Sound

Repeat Every: 60 Seconds

Webcam Imagery -ﬁ

Quit Check

WeatherCat monitors communications to your station. If they fail WeatherCat will try to restart the comms. If this is not successful
WeatherCat will send out admin emails. These controls allow you to run a user item (for example an AppleScript) and/or play a

repeating sound when WeatherCat detects comms have failed and the failure is not recoverable.

FTPS Options

Use FTPS
Skip Certificate Checking

NOAA High and Low Temps

These values are used to compute days greater than or lower than these temperatures in

NOAA style reports.

Speak Log Entries

This will speak log window entries apart from weather data updates (these can be enabled
from the Misc 1 pane of the preferences). The speech is not buffered and will skip to the

latest entry to keep up with log output as necessary.
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Startup/Shutdown Actions

WeatherCat has startup and shutdown items that are run as WeatherCat completes startup
or is about to shutdown (Preferences->Advanced). These items are designed to launch
scripts that launch or quit other scripts/processes thus synchronising WeatherCat with
external programs. The startup item is launched after WeatherCat has taken the first
sample, thus guaranteeing the data is ready.

Quit Check

If enabled, WeatherCat needs to be told twice in 5 seconds to quit (otherwise
the shut down is aborted).

Note, if enabled, this feature will cause an error to be returned to any
AppleScript trying to quit WeatherCat ('User Cancelled') on the first quit
command. To quit WeatherCat from an AppleScript, handle the error in your
script and tell it to quit twice - for example:

tell application "WeatherCat"
try
quit
end try
try
quit
end try
end tell

Station Commes. Fail Actions

This option can run a User Item — for example an AppleScript and/or play a sound if
WeatherCat detects communications to the weather station have irretrievably failed.

FTPS Settings

If ‘Use FTPS’ is enabled, WeatherCat will attempt to negotiate an FTPS connection to the
server (explicit FTPS, or FTPES (RFC 4217)). If the server does not support FTPS,
WeatherCat will fall back to FTP.

Note: With FTPS enabled, some servers may not respond with a certificate that can be
validated, either because the server is misconfigured (the wrong certificate for the domain
1s being used), or your Mac does not recognise the certificate authority. In this case
WeatherCat will log the following message: ""FTPS ERROR (60) - Server
certificate issue - couldn't verify the legitimacy of the server.".
The 'Skip Certificate Checking' tick box, if ticked, will skip certificate validation. In this
case, the connection will still be encrypted, but less secure in that the identity of the server
will not be validated. Only select this option if you are sure of the identity of the server.
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WeatherCat and Data

General

WeatherCat stores its database in your ~/Library folder, for example: /Users/John/Library/
WeatherCatData/

Within the WeatherCatData folder will be a folder for each location. Within each of these
folders lives the actual data organised by year and month folders.

WeatherCat data is held in simple text-based files that can be viewed or edited in any text
editor. These files are given a ‘.cat’ extension, for example ‘6 WeatherCatData.cat’, and
each file holds the data for a month; in this example June.

Each .cat file is commented at the top with the layout of the data making the data format
more human friendly and easy to edit should you need to. Each sample takes up one line
in the file and is simply appended to the current file. The data format uses a simple key/
value coding — if a channel is not present on your hardware, it isn’t recorded.

WeatherCat also maintains hourly statistics files — these are maintained by WeatherCat as
each sample is taken and are given a ‘.hrs’ extension, for example
‘6_WeatherCatData.cat.hrs’.

Important Note: If you edit a .cat file, delete the corresponding .hrs file. WeatherCat will
rebuild the .hrs when it launches. Never edit a .cat with WeatherCat running — always quit
WeatherCat before editing the data.

The satellite imagery is stored in WeatherCat’s database on disk at: ~/Library/WeatherCat/
Locationl/Imagery as jpeg files. Each file is named ‘Imagery hh mm dd mm yy,jpg’ to
aid identifying each file by date.

Custom Rules

WeatherCat saves your custom rules in the same ‘~/Library/WeatherCatData’ folder in a
text based XML format.

Custom Graphs

WeatherCat saves your custom graphs in the same ‘~/Library/WeatherCatData’ folder in a
text based XML format.

Custom Gauges

WeatherCat saves your custom gauges in the same ‘~/Library/WeatherCatData’ folder in a
text based XML format.
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Custom Text Windows

WeatherCat saves your custom text windows in the same ‘~/Library/WeatherCatData’
folder in a text based XML format.

Journal

WeatherCat saves your journal entries in the ‘~/Library/WeatherCatData’ folder again in a
text based XML format.
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Appendices
Appendix 1 - WeatherCat AppleScript Interface

This interface exposes station data and WeatherCat status information to your scripts/
applications.

The interface provides both simple data access for quick and dirty access and a more
flexible interface based on the notion of a ‘working channel’ which can save many lines of
code in your AppleScripts.

The interface also provides access to status information and allows the setting of the
current conditions as displayed and logged.

Simple Data Access

Properties are provided to access the real-time value of any channel available on your
hardware, along with the current 1 hour delta for that channel. These are named as you
would expect - for example CurrentConditions returns a string with the current
conditions and AverageWindSpeed returns the current average wind speed. These
properties contain values converted to the units you have selected in WeatherCat's
preferences.

In the following list, the name of the property is in bold, this is followed by the ‘type’ of
data where ‘text’ means the property is a string, ‘real’ means the property is a number and
‘boolean’ means the property is either ‘true’ or ‘false’. An ‘r/o’ following the type means
the property is read only —i.e. you cannot set it.

The following properties are currently available:

CurrentConditions (text) : Returns the current conditions. Can also be used to set the
current conditions - see below under ‘Miscellaneous Properties’ for more details.

ExternalTemp (real, r/0) : Returns the current external temperature in the units as set in
WeatherCat's preferences for temperature

DewPoint (real, r/0) : Returns the current dew point in the units as set in WeatherCat's
preferences for temperature

Pressure (real, 1/0) : Returns the current barometric pressure in the units as set in
WeatherCats preferences for pressure
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WindSpeed (real, 1/0) : Returns the current wind speed in the units as set in WeatherCat's
preferences for wind speed

AverageWindSpeed (real, r/0) : Returns the current average wind speed in the units as set
in WeatherCat's preferences for wind speed

WindGust (real, r/0) : Returns the current 10 minute wind gust in the units as set in
WeatherCat's preferences for wind speed

WindDirection (real, r/0) : Returns the current wind direction in degrees
AverageWindDirection (real, r/0) : Returns the current average wind direction in degrees

PrecipitationPerHour (real, r/0) : Returns the current precipitation per hour in the units as
set in WeatherCat's preferences for precipitation

PrecipitationDaily (real, r/0) : Returns the current daily precipitation in the units as set in
WeatherCat's preferences for precipitation

Precipitation (real, r/0) : Returns the current raw precipitation in the units as set in
WeatherCat's preferences for precipitation

WindChill (real, 1/0) : Returns the current wind chill in the units as set in WeatherCat's
preferences for temperature

ExternalRH (real, r/0) : Returns the current external humidity

InternalTemp (real, r/0) : Returns the current internal temperature in the units as set in
WeatherCat's preferences for temperature

InternalRH (real, r/0) : Returns the current internal humidity

SolarRadiation (real, r/0) : Returns the current solar radiation in watts per metre squared
(if fitted)

UVIndex (real, r/0) : Returns the current U.V. index (if fitted)

T1 (real, r/0) : Returns the current extra temperature sensor 1 value in the units as set in
WeatherCat's preferences for temperature (if fitted)

T2 (real, r/0) : Returns the current extra temperature sensor 2 value in the units as set in
WeatherCat's preferences for temperature (if fitted)

T3 (real, 1/0) : Returns the current extra temperature sensor 3 value in the units as set in
WeatherCat's preferences for temperature (if fitted)
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T4 (real, r/0) : Returns the current extra temperature sensor 4 value in the units as set in
WeatherCat's preferences for temperature (if fitted)

TS5 (real, r/0) : Returns the current extra temperature sensor 5 value in the units as set in
WeatherCat's preferences for temperature (if fitted)

T6 (real, r/0) : Returns the current extra temperature sensor 6 value in the units as set in
WeatherCat's preferences for temperature (if fitted)

T7 (real, r/0) : Returns the current extra temperature sensor 7 value in the units as set in
WeatherCat's preferences for temperature (if fitted)

T8 (real, r/0) : Returns the current extra temperature sensor 8 value in the units as set in
WeatherCat's preferences for temperature (if fitted)

H1 (real, r/0) : Returns the current extra humidity sensor 1 value (if fitted)

H2 (real, r/0) : Returns the current extra humidity sensor 2 value (if fitted)

H3 (real, r/0) : Returns the current extra humidity sensor 3 value (if fitted)
H4 (real, 1/0) : Returns the current extra humidity sensor 4 value (if fitted)
HS (real, r/0) : Returns the current extra humidity sensor 5 value (if fitted)
H6 (real, r/0) : Returns the current extra humidity sensor 6 value (if fitted)
H7 (real, r/0) : Returns the current extra humidity sensor 7 value (if fitted)
H8 (real, r/0) : Returns the current extra humidity sensor 8 value (if fitted)
LW1 (real, r/0) : Returns the current leaf wetness sensor 1 value (if fitted)
LW?2 (real, 1/0) : Returns the current leaf wetness sensor 2 value (if fitted)
LW3 (real, r/0) : Returns the current leaf wetness sensor 3 value (if fitted)
LW4 (real, r/0) : Returns the current leaf wetness sensor 4 value (if fitted)
LT1 (real, 1/0) : Returns the current leaf temperature sensor 1 value in degrees C (if fitted)
LT2 (real, 1/0) : Returns the current leaf temperature sensor 2 value in degrees C (if fitted)

LT3 (real, r/0) : Returns the current leaf temperature sensor 3 value in degrees C (if fitted)
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LT4 (real, 1/0) : Returns the current leaf temperature sensor 4 value in degrees C (if fitted)
SM1 (real, r/0) : Returns the current soil moisture sensor 1 value (if fitted)

SM2 (real, r/0) : Returns the current soil moisture sensor 2 value (if fitted)

SM3 (real, r/0) : Returns the current soil moisture sensor 3 value (if fitted)

SM4 (real, r/0) : Returns the current soil moisture sensor 4 value (if fitted)

ST1 (real) : Returns the current soil temperature sensor 1 value in degrees C (if fitted)
ST2 (real) : Returns the current soil temperature sensor 2 value in degrees C (if fitted)
ST3 (real) : Returns the current soil temperature sensor 3 value in degrees C (if fitted)

ST4 (real) : Returns the current soil temperature sensor 4 value in degrees C (if fitted)

Deltas

Properties are also provided to get 1-hour deltas for major data types. In the case of
barometric pressure Weathercat also provides a 3-hour delta. Note that unconverted deltas
are also provided (see WeatherCat’s dictionary for full details).

ExternalTempDeltal (real, r/0) : Returns the external temperature 1-hour delta in the
units as set in WeatherCat's preferences for temperature

DewPointDeltal (real, r/0) : Returns the current dew point 1-hour delta in the units as set
in WeatherCat's preferences for temperature

PressureDeltal (real, r/0) : Returns the current barometric pressure 1-hour delta in the
units as set in WeatherCat's preferences for pressure

PressureDelta3 (real, r/0) : Returns the current barometric pressure 3-hour delta in the
units as set in WeatherCat's preferences for pressure

WindSpeedDeltal (real, r/0) : Returns the current wind speed 1-hour delta in the units as
set in WeatherCat's preferences for wind speed

AverageWindSpeedDeltal (real, r/0) : Returns the current average wind speed 1-hour
delta in the units as set in WeatherCat's preferences for wind speed

WindGustDeltal (real, r/0) : Returns the current 10 minute wind gust 1-hour delta in the
units as set in WeatherCat's preferences for wind speed
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WindDirectionDeltal (real, r/0) : Returns the current wind direction 1-hour delta in
degrees

PrecipitationPerHourDeltal (real, r/0) : Returns the current precipitation per hour 1-hour
delta in the units as set in WeatherCat's preferences for precipitation

PrecipitationDeltal (real, r/0) : Returns the current raw precipitation 1-hour delta in the
units as set in WeatherCat's preferences for precipitation

WindChillDeltal (real, r/0) : Returns the current wind chill 1-hour delta in the units as set
in WeatherCat's preferences for temperature

ExternalRHDeltal (real, r/0) : Returns the current external humidity 1-hour delta

InternalTempDeltal (real, r/0) : Returns the current internal temperature 1-hour delta in
the units as set in WeatherCat's preferences for temperature

InternalRHDeltal (real, r/0) : Returns the current internal humidity 1-hour delta

SolarRadiationDeltal (real, r/0) : Returns the current solar radiation 1-hour delta in watts
per metre squared (if fitted)

UVIndexDeltal (real, r/0) : Returns the current U.V. index 1-hour delta (if fitted)
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Working Channel

The above properties provide simple access to most channel data, but if you wanted access
to a channel not directly provided, for example the Daily E.T. on a Vantage, or if you
wanted to scan all channels on a regular basis, for example to save the data in a database or
to display the data somewhere else, you’ll have to write a lot of lines of (laborious and
repetitive) code.

To make it easier to write more complex and useful scripts, WeatherCat provides the

notion of a 'working channel'. When the working channel is set to a valid channel number,
all future calls to working channel properties use the working channel number.

NumberOfChannels (integer, 1/0) : Returns the number of channels present on the current
hardware.

WorkingChannel (integer) : Set or read the channel used in WorkingChannelxxxx
properties. Channel numbers run between 1 and NumberOfChannels.

WorkingChannelValue (real, r/0) : Returns the real time converted value of the working
channel.

WorkingChannelValueUnconverted (real, r/0) : Returns the real time unconverted value
of the working channel.

WorkingChannelStatus (boolean, r/0) : Returns whether the working channel is currently
valid.

WorkingChannelName (text, r/0) : Returns the name of the working channel.
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Channels within WeatherCat are numbered as follows:

external_temperature 1

dewpoint 2

windchill 3

pressure 4

windspeed_instantaneous 5

windspeed_average_10mins 6

winddirection_instantaneous 7

winddirection_average 8

precipitation_per_hour 9

precipitation_daily 10
precipitation_raw (station dependent) 11
external_rh, 12
internal_rh, 13
internal_temperature 14
windgust_1mins 15
windgust_5mins 16
windgust_1@mins 17
windgust_15mins 18
windgust_dir_1mins 19
windgust_dir_5mins 20
windgust_dir_1@mins 21
windgust_dir_15mins 22
solar_radiation_WM2 23
uv_index 24
aux_temperature_1 25
aux_temperature_2 26
aux_temperature_3 27
aux_temperature_4 28
aux_temperature_5 29
aux_temperature_6 30
aux_temperature_7 31
aux_temperature_8 32
aux_rhl 33
aux_rh2 34
aux_rh3 35
aux_rh4 36
aux_rh5 37
aux_rho6 38
aux_rh7 39
aux_rh8 40
leaf_wetnessl 41
leaf_wetness?2 42
leaf_wetness3 43
leaf_wetness4 44
soil_moisturel 45
soil_moisture2 46
soil_moisture3 47
soil_moisture4 48
leaf_temperaturel 49
leaf_temperature?2 50
leaf_temperature3 51
leaf_temperature4 52
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soil_temperaturel 53

soil_temperature2 54
soil_temperature3 55
soil_temperature4 56
monthly rain 57
yearly rain 58
daily et 59
monthly et 60
yearly et 6l

(For WeatherCat SDK users, these channel numbers are defined in StationPlugInProtocol.h)

Please note: NumberOfChannels may return more than 61. Channels above 61 are not yet
documented.

Working Channel Example

repeat with thelncrementValue from 1 to NumberOfChannels
set WorkingChannel to thelncrementValue
set wcname to WorkingChannelName
set wcvalue to WorkingChannelValue
set wcstatus to WorkingChannelStatus
-- do whatever you do with the data here

end repeat

Miscellaneous Properties

WeatherCatASIFVers (real, r/0) : Returns the version number of WeatherCat's
AppleScript interface. Return 5 for WeatherCat 2.2.0 onwards.

StationDriverStatus (boolean, r/0) : Returns the station driver status where true means all
OK, false means communications have failed to the hardware and WeatherCat was not able
to rectify the situation.

The CurrentConditions property is writable; this allows the current conditions within
WeatherCat to be controlled by AppleScript which can offer extended capabilities to
calculate the current conditions. When text is written to this property it becomes the active
current conditions for 10 minutes. In this situation the Current Conditions Calculator
window will append '(Ext)' to its display to show the current conditions are being
controlled externally.

Example:
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tell application "WeatherCat"
if ExternalTemp > 80 and WindSpeed > 20 then
set CurrentConditions to "Warm but windy"
end if
end tell

Assuming the temperature was greater than 80 and the wind speed greater than 20 then the
current conditions calculator will be displaying:

Current Result: Warm but windy (Ext)

The CWOPState property provides detailed information about the state of WeatherCat's
CWOP driver. CWOPState returns an integer, which will be one of the following values
(these values are guaranteed not to change in the future):

CWOP_starting=0 States 0 to 92 are used to time the startup of WeatherCat's
CWOP driver.

CWOP_start=92

CWOP_disabled=100 CWOP is disabled in the preferences.

CWOP_ok=200 Normal state if all OK and not in any other state.

CWOP_transmitting=210 Transmitting packet

CWOP_server1=250 Using CWOP server 1

CWOP_server2=251 Using CWOP server 2

CWOP_server3=252 Using CWOP server 3

CWOP_server4=253 Using CWOP server 4

CWOP_server5=254 Using CWOP server 5

CWOP_good_response=255  Packet acknowledged by CWOP

CWOP_bad_data=400 Error in weather data (sensor error). If the error is permanent,
omit the sensor in WeatherCat's advanced CWOP preferences.

CWOP_no_station_name_error=500 CWOP station ID in the CWOP preferences is empty. The

CWOP driver will stop.
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CWOP_no_password_error=510 Currently not in use (reserved for future use)

CWOP_no_response=710 Couldn't find a CWOP server (server down or DNS error).
Temporary fatal.

CWOP_error_no_reply=711  Server found but did not reply. WeatherCat will try again.

CWoP_error_latlong=720  Latitude/Longitude not set in the preferences - can't send. The
CWOP driver will stop.

CWOP_internet_down=800  WeatherCat was not able to open a TCP/IP socket. WeatherCat
will retry shortly.

CWOP_server_busy=801 The CWOP server refused WeatherCat's connection request;

WeatherCat will try another server.

The CWOP state can change rapidly. Normally when working, the state will be switching
between cwop_transmitting (logging into the server), CWOP_serverX (where X is 1 through 5)
(logged into server X - see WeatherCat's advanced CWOP preferences for the server
addresses), CWOP_good_response (packet sent with no errors) and cwop_ok (all done, last
packet transmitted OK, idle waiting for next transmission).

Normal running state can be determined by examining the CWOPState and if it's between
200 and 399, all is good.

Many CWOP error states are spurious in nature; WeatherCat will try to correct the problem
either by selecting another server, waiting for a small period of time and trying again or
restarting its CWOP driver.
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The WundergroundState property. This property provides detailed information about the
state of WeatherCat's Wunderground driver. WundergroundState returns an integer value,
which will be one of the following values (these are guaranteed not to change in future):

wunderground_starting=0

wunderground_start=90

wundergound_disabled=100

wunderground_ok=200

wunderground_ok_historical=201

wunderground_transmitting=210

wunderground_receiving=211

wunderground_bad_data=400

wunderground_no_station_name_error=500

wunderground_no_password_error=510

wunderground_reception_error=700

wunderground_no_response=710

wunderground_error_no_reply=711

States 0 to 90 are used to time the start-up of

WeatherCat's Wunderground driver.

Wunderground is disabled in the preferences.
Normal state if all OK and not in any other state.
Normal state if all OK and uploading historical data
and not in any other state.

Transmitting packet

Receiving reply from Wunderground

Error in weather data (sensor error). Will retry.
Wunderground station ID in the Wunderground
preferences is empty. Correct station ID.
Wunderground password in the Wunderground
preferences is empty. Correct the password.
WeatherCat couldn't decode the reply from
Wunderground. WeatherCat will retry.
WeatherCat timed out whilst waiting for the reply
from Wunderground. WeatherCat will retry.
WeatherCat received an empty reply from

Wunderground. WeatherCat will retry.

wunderground_error_could_not_transmit=712 WeatherCat couldn't open a connection to

wunderground_pwd=720

Wunderground. WeatherCat will retry.
Wunderground did not recognise station ID or

wrong password. Correct log-in details.
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wunderground_internet_down=800 The Internet is taking a nap. WeatherCat will retry.
wunderground_error=990 General Wunderground error state not represented

by any other state. WeatherCat will retry.

Like the CWOP state, the Wunderground state can change very rapidly. Normally when
working, the state will be switching between wunderground_transmitting (sending data to the
Server), wunderground_receiving (receiving a reply from Wunderground), wunderground_ok
(transaction complete with no errors).

Like the CWOP state, normal running state can be determined by examining the
wundergroundState property and if it's between 200 and 399, all is good.

Many Wunderground error states are spurious in nature; WeatherCat will try to correct the
problem either by waiting for a small period of time and trying again or by restarting its
Wunderground driver.

Status values 0 through 90 are used to delay Wunderground start-up by approximately 90
seconds when WeatherCat starts up - this is the countdown you can observe in
WeatherCat's Status window just after it has started.

The MailFailed property. This is set if WeatherCat failed to send an email. It is cleared
when a mail is successfully sent.

The FTPFailed property. This is set if WeatherCat failed to FTP a file. It is cleared when a
file is successfully FTP'd.

CommsCount (real) : Returns the current number of good packets WeatherCat has
received from the hardware.

CommsErrorsTO (real) : Returns the current number of communications errors(time-
outs) WeatherCat has detected whilst communicating with the hardware.

CommsErrorsVA (real) : Returns the current number of communications
errors(validation) WeatherCat has detected whilst communicating with the hardware.

SensorErrors (real) : Returns the current number of sensor errors WeatherCat has detected
whilst communicating with the hardware.

UnixBootTime (real) : Returns the time WeatherCat was booted as the number of seconds
elapsed since the first instant of 1 January 1970 GMT

Page 193



UpTime (real) : Returns the number of seconds elapsed since WeatherCat was launched
WCldentifier (text, r/0) : Returns WeatherCat's version and build number.

SunriseTime (text, r) : Return todays sunrise time as a string (WeatherCat 2.1.0 onwards).
SunsetTime (text, r) : Return todays sunset time as a string. (WeatherCat 2.1.0 onwards).

DaylightTime (text, r) : Return todays daylight time as a string. (WeatherCat 2.1.0
onwards).

FTPOverdriven (bool, r) : Set when FTP is being overdriven (files being generated faster
than they can be uploaded). (WeatherCat 2.1.0 onwards).

RunCustomWeb (bool, w) : Cause WeatherCat to process the custom web pages if the
parameter passed is true. (WeatherCat 2.1.0 onwards).

PrecipUnits (integer, r) : Returns 0 if precipitation units are metric, 1 if imperial. (V2.2.0
onwards)

TemperatureUnits (integer, r) : Returns 0 if temperature units are Centigrade, 1 if
Fahrenheit. (V2.2.0 onwards)

WindSpeedUnits (integer, r) : Returns 0 if wind speed units are km/h, 1 if MPH, 2 if
knots, 3 if m.s. (V2.2.0 onwards)

PressureUnits (integer, r) : Returns 0 if pressure units are mB, 1 if inHg. (V2.2.0
onwards)

Queries

Query (text, w) : Set the current query as a STATS tag query - i.e.
STATSTEMPERATURE:AVERAGE:TODAY $

QueryResult (real, r) : Read the result of the current query.

Example:

tell application "WeatherCat"
set Query to "STATSTEMPERATURE:AVERAGE:YESTERDAY$"
set result to QueryResult

end tell

QueryResultString (text, r) : Read the result of the current query as a string. (V2.2.0
onwards)
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Example:
tell application "WeatherCat"
set Query to "STATSTEMPERATURE:MAX:TODAY:TIMES"
set result to QueryResultString
end tell
result will contain a string representation of the time of the occurrence (formatted as per
WeatherCat's user settings)

General AppleScript Tips

1. If you are continuously calling WeatherCat from a loop in your script, it is wise to insert
a delay in your loop so as not to cause 100% processor usage.

2. There are many good books available on AppleScript. In addition there is almost an

infinite amount of information on the world wide web. For help with AppleScript syntax
and usage, your favourite search engine is your best friend.
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Appendix 2 — Example Email Settings

1. Your Local ISP
SMTP Server: Normally something like smtp.yourisp.com or mail.yourisp.com

Port: Normally 25 (Check with your ISP if port 25 doesn’t work)
User: Blank

Password: Blank

Authentication: Not checked

Note: Check with your ISP if this doesn't work - they may require authentication checked,
user, password and a different port.

2. MobileMe/iCloud
SMTP Server: smtp.mail.me.com

Port: 587
User: Your iCloud user name (not username(@icloud.com)
Password: Your iCloud password - note you’ll need an application specific password for

WeatherCat if you are using two factor authentication with your Apple ID. For more
information please see: https://support.apple.com/en-us/HT204397

Authentication: Checked
Note: The email 'From' field in WeatherCat MUST be one of your registered email

addresses. For example if your iCloud email address is fred@icloud.com then enter
fred@icloud.com into WeatherCat's Email 'From' field.

3. GMail or GoogleMail
SMTP Server: smtp.gmail.com or smtp.googlemail.com (depending on your location)

Port: 587

User: username(@gmail.com or username@googlemail.com
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Password: Your GMail/GoogleMail password. Note, you may need an application specific
password to use with WeatherCat. See https://support.google.com/accounts/answer/
185833?hl=en for details.

Authentication: Checked
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Appendix 3 - Common USB to Serial Converter Drivers

Davis CP210x (WeatherLink USB) — http://www.silabs.com/products/mcu/Pages/
USBtoUARTBridgeVCPDrivers.aspx
(Download VCP Driver Kit (version 5 is current at time of writing)).

PL2303 based converters - http://www.prolific.com.tw/eng/downloads.asp?id=31 (Note:
login required)

FTDI — These are frequently found bundled with WS2350’s - http://www.ftdichip.com/
Drivers/VCP.htm

NOTE: Mac OS High Sierra 10.13 introduces a new feature that requires user approval
before loading new third-party kernel extensions. Go to System Preferences - Security &
Privacy and click Allow.
https://developer.apple.com/library/content/technotes/tn2459/_index.html
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Appendix 4 - WeatherCat Web-Tags Reference

This appendix details WeatherCat tags that can be used in custom web pages.

WeatherCat tags are case sensitive and end in a dollar symbol "$". For example WCAMS$
is correct whereas wcam$ is incorrect and will not work. Where a tag takes parameters,
there must be no spaces between the tag and parameter or between successive parameters.

Where a tag takes parameters, there must be no spaces between the tag and parameter or

between successive parameters.

For example HTML please see the file ‘index.html’ found in the WeatherCat AllTags
folder of the Web Templates folder of WeatherCat’s distribution.

WeatherCat Tag

Description

Example

CURRENT READINGS

CT$

Replaced with the
current temperature,
temperature units and
hourly change in
brackets.

Temperature is CT$

CD$

Replaced with the
current dew point, dew
point units and hourly
change in brackets.

Dew point is CD$

CWCS$

Replaced with the
current wind chill, wind
chill units and hourly
change in brackets.

Wind chill is CWC$

CX$

Replaced with the
current wind direction
and units.

Wind direction is: CX$

CW$

Replaced with the
current average wind
speed and units.

Average wind speed is CW$

CG$

Replaced with the
current wind gust and
units.

Wind gust is CG$
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CP$

Replaced with current
barometric pressure,
units and hourly

Current pressure is CP$

CR$

Replaced with current
hourly precipitation
rate, units and hourly
change.

Current hourly precipitation is CR$

CC$

Replaced with current
conditions (when
available)

Current conditions: CC$

CF$

Replaced with current
forecast (Vantage/Vue/
WLIP/WS23xx only
currently)

Current forecast: CF$

CSF$

Replaced with current
short forecast (Vantage/
Vue/WLIP only
currently)

Current short forecast: CSF$

CU$

Replaced with the time
of the last valid data

Time of data: CU$

WDTEXTS$

Replaced with the
current 16 sector 10-
minute average wind
direction as text

Current Wind Direction: WDTEXTS$

WDDEGREES$

Replaced with the
current 10-minute
average wind direction
as degrees

Current Wind Direction: WDDEGREES$

DOMWDTEXT$

Replaced with the
current 16 sector
dominant wind
direction (today) as text

Dominant Wind Direction:
DOMWDTEXT$

DOMWDDEGREES$

Replaced with the
current dominant wind
direction (today) as
degrees (V1.1.3
onwards)

Dominant Wind Direction Today:
DOMWDDEGREESS$

DOMWDDEGREES(PERIOD)$

Replaced with the
current dominant wind
direction over PERIOD
as degrees (V1.1.4
onwards)

Dominant Wind Direction today since
9AM:
DOMWDDEGREES(TODAYSINCE9)$
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WINDBEARINGFROM10$

The 'lowest' clockwise
bearing in the last 10
minutes rounded down
to nearest 10 degrees
(V1.1.4 onwards).

WINDBEARINGFROM10$:
WINDBEARINGFROM10$

WINDBEARINGTO10$

The 'highest' clockwise
bearing in the last 10
minutes rounded down
to nearest 10 degrees
(V1.1 .4 onwards).

WINDBEARINGTO10$:
WINDBEARINGTO10$

WINDROSES$

Replaced with a list of 8
windrose values
(starting at north and
running clockwise,
every 45 degrees)

Windrose 8: WINDROSES$

WINDROSE45$

Replaced with a list of
45 windrose values
(starting at north and
running clockwise,
every 8 degrees)

Windrose 45: WINDROSE45$

BTTEXTS

Replaced with the
current barometric trend
as text

Current Barometric Trend: BTTEXTS$

RS$

Rain storm value
(Vantage/Vue/WLIP)

Current rain storm value: RS$
RAINUNITSS$

RSD$

Rain storm start date
(Vantage/Vue/WLIP)

Current rain storm start date: RSD$

RLD$

Last significant (0.6mm
or more) rain date and
amount

Last known rain date: RLD$

RLDi$

Last significant (0.6mm
or more) rain date (ISO
8601 format)

Last known rain date: RLDi$

AT_Aus$

Replaced with the
current apparent
temperature (Australian
version)

Apparent temperature is AT_Aus$

AT _US$

Replaced with the
current apparent
temperature (US
version)

Apparent temperature is AT_US$

HUMIDEX$

Replaced with the
current humidex

Humidex is HUMIDEX$
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CPS$

Replaced with the
current potential solar
radiation

Current potential solar radiation is CPS$

MISC ITEMS

WEATHERFACTS$

Replaced with a
interesting weather fact/
note. A new fact is
generated daily at
random.

WEATHERFACTS$

JOURNTS

Replaced with the
journal text.

Station journal
JOURNTS

COUNTEDJOURNTS$nnnn$

Replaced with the latest
nnnn journal entries

(where nnnn is 1 to
9999).

Last 5 station journal entries
COUNTEDJOURNTS 5%

STRECORDS$

Replaced with station
records as preformatted
text (enclose in <PRE>
and </PRE> HTML
tags.

Records: STRECORDS$

STRECENTS$

Replaced with recent
statistics as
preformatted text
(enclose in <PRE> and
</PRE> HTML tags.

Recent: STRECENTS$

STDAILY$

Replaced with the
current daily statistics
as preformatted text
(enclose in <PRE> and
</PRE> HTML tags.

Daily Statistics: STDAILY$

STMONTHLY 1$

Replaced with the
current monthly
statistics (part 1) as
preformatted text
(enclose in <PRE> and
</PRE>HTML tags.

Monthly Statistics (part 1):
STMONTHLY1$

STMONTHLY?2$

Replaced with the
current monthly
statistics (part 2) as
preformatted text
(enclose in <PRE> and
</PRE> HTML tags.

Monthly Statistics (part 2):
STMONTHLY2$
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STMONTHLY$

Replaced with the
current monthly
statistics (all) as
preformatted text
(enclose in <PRE> and
</PRE> HTML tags.

Monthly Statistics: STMONTHLY $

STYEAROVERYEARS

Replaced with the year
over year statistics as
preformatted text
(enclose in <PRE> and
</PRE> HTML tags.

Year Over Year Statistics:
STYEAROVERYEARS$

STTHISMONTHOVS$

Replaced with monthly
overview. Note: this tag
outputs preformatted
text and should be
enclosed in <PRE></
PRE> tags. (V24.0
onwards)

This month overview:
STTHISMONTHOVS

STLASTMONTHOVS$

Replaced with monthly
overview for last
month. Note: this tag
outputs preformatted
text and should be
enclosed in <PRE></
PRE> tags. (V24.0

Last month overview:
STLASTMONTHOV$

STNOAAMOS

Replaced with the
current NOAA report
for this month as
preformatted text
(enclose in <PRE> and
</PRE>HTML tags.

Current NOAA monthly report:
STNOAAMOS

STNOAAPRMOS$

Replaced with the
NOAA report for the
previous month as
preformatted text
(enclose in <PRE> and
</PRE> HTML tags.

NOAA monthly report for last month:
STNOAAPRMOS

STNOAAYRS

Replaced with the
current NOAA report
for this year as
preformatted text
(enclose in <PRE> and
</PRE> HTML tags.

Current NOAA annual report:
STNOAAYRS
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STNOAAPRYRS Replaced with the NOAA yearly report for last year:
NOAA report for the STNOAAPRYRS
previous year as
preformatted text
(enclose in <PRE> and
</PRE> HTML tags.
Llat$ Station latitude Station latitude: Llat$
Llong$ Station longitude Station longitude: Llong$
Lelevf$ Station altitude in feet | Station altitude in feet: Lelevf$
Lelevm$ Station altitude in Station altitude in metres: Lelevm$
metres
D$ Date and time Date: D$
UT$ Uptime Uptime (days:hours:minutes): UT$
t12$ Time (12 hour clock) Time: t12$
t24% Time (24 hour clock) Time: 24$
t12s$ Time with seconds (12 | Time: t12s$
hour clock)
t24s$ Time with seconds (24 | Time: t24s$
hour clock)
da$ Date in the format of Date: da$
month/day/year
de$ Date in the format of Date: de$
day/month/year
ISO8601DATESS Causes all dates/
times in STATS tag
to be output in
ISO8601 format.
Can appear
anywhere in the file
and affects the
whole file.
SUNRISELOCALS$ Sunrise local time Sunrise today: SUNRISELOCALS$
SUNSETLOCALS$ Sunset local time Sunset today: SUNSETLOCALS$
SUNRISEUTCS$ Sunrise time UTC Sunrise today (UTC): SUNRISEUTC$
SUNSETUTC$ Sunset (UTC) Sunset today (UTC): SUNSETUTC$
DAYLIGHTTIMES$ Hours:Minutes of Daylight time today: DAYLIGHTTIME$

daylight today
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SUNRISELOCALI1$

Sunrise local time
tomorrow

Sunrise tomorrow: SUNRISELOCALI1$

SUNSETLOCALI1S$

Sunset local time
tomorrow

Sunset tomorrow: SUNSETLOCALI1$

SUNRISEUTC1$

Sunrise time UTC
tomorrow

Sunrise tomorrow (UTC):
SUNRISEUTC1$

SUNSETUTC1$

Sunset (UTC)
tomorrow

Sunset tomorrow (UTC):
SUNSETUTCI1$

DAYLIGHTTIMEIS$

Hours:Minutes of
daylight tomorrow

Daylight time tomorrow:
DAYLIGHTTIME1$

DOTSEPARATORSS

Switches off localised
decimal separators
whilst processing
STATS tags across a

page

WEBCAM

WCAMS$

Replaced with the
current web-cam picture
at the resolution as set
in the web-cam
preferences.

Current web-cam picture at camera
resolution
WCAMS$

WCAM3208.

Replaced with the
current web-cam picture
at a horizontal
resolution of 320. The
vertical resolution is a
nominal 240 pixels but
this is dependent on
your camera as the
aspect ratio is always
maintained. We also
provide WCAM6408S,
WCAMB8O00$ and
WCAM1280%

Current web-cam picture scaled to 320
pixels horizontal resolution (camera is
running at 640%480)

WCAM320$

MOVIE$

Replaced with a link to
the last time-lapse
movie.

Latest time-lapse movie:
MOVIE$

DIALS AND GAUGES

DALLS$

Replaced with all dials.
(Also available is
DALLCS$ which is
replaced with all dials
and comms counts)

DALLS$
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DWINDD$ Replaced with current | DWINDD$
wind direction dial.

DWINDSS$ Replaced with current | DWINDS$
wind speed dial.

DWINDRS$ Replaced with current | DWINDR$
wind run dial.

DBARO$ Replaced with current | DBARO$
barometer dial.

DCLOUDBS$ Replaced with current | DCLOUDBS$
calculated cloud base
dial.

DSOLARS$ Replaced with current | DSOLARS$
solar meter.

DTEMPOS$ Replaced with current | DTEMPO$
outside temperature
meter.

DDEW$ Replaced with current | DDEW$
dew point meter.

DWINDCHS$ Replaced with current | DWINDCHS$
wind chill meter.

DHEATI$ Replaced with current | DHEATI$
heat index meter.

DHUMOS$ Replaced with current | DHUMOS$
outside humidity meter.

DTEMPI$ Replaced with current | DTEMPI$
inside temperature
meter.

DHUMIS$ Replaced with current | DHUMIS$
inside humidity meter.

DRAIN1$ Replaced with current 1 | DRAIN1$
hour rain rate meter.

DRAIN24$ Replaced with current | DRAIN24$
24 hour rain rate meter.

DUVS$ Replaced with current | DUVS$
U.V. meter.

CUSTOMGAUGE$1$ Replaced with CUSTOMGAUGES$1$

custom gauge #1.
Up to 16 custom
gauges may be
defined.
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GRAPHS - BASIC

GRTEMPO$

Replaced with current
outside temperature
graph.

GRTEMPO$

GRDEW$

Replaced with current
dew point graph.

GRDEW$

GRHUMO$

Replaced with current

outside humidity graph.

GRHUMO$

GRWINDCH$

Replaced with current
wind chill graph.

GRWINDCHS$

GRHEATI$

Replaced with current
heat index graph.

GRHEATI$

GRSOLARS$

Replaced with current
solar radiation graph.

GRSOLARS$

GRUV$

Replaced with current
U.V. graph.

Note: There's no U.V.
sensor on the station
here.

GRUVS$

GRWINDDS$

Replaced with current
wind direction graph.

GRWINDDS$

GRWINDS$

Replaced with current
wind speed graph.

GRWINDS$

GRPRESSURES$

Replaced with current
barometric pressure
graph.

GRPRESSURES$

GRCLOUDBS$

Replaced with current
calculated cloud base
graph.

GRCLOUDBS$

GRRAIN1$

Replaced with current 1
hour rain rate graph.

GRRAINIS

GRRAIN24$

Replaced with current
daily rain rate graph.

GRRAIN24$%

GRHUMI$

Replaced with current

internal humidity graph.

GRHUMI$

GRTEMPIS$

Replaced with current
internal temperature
graph.

GRTEMPI$

GRAPHS - CUSTOM
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Custom Graphs - an unlimited
number of custom graphs can be
generated - here's an example -

Replaced with custom
graph #1.

CUSTOMGRAPHS$1$

example - CUSTOMGRAPH$3$

graph #3.

CUSTOMGRAPHS$1$

Custom Graphs - here's another Replaced with custom | CUSTOMGRAPH$2$
example - CUSTOMGRAPHS$2$ | graph #2.

Custom Graphs - here's another Replaced with custom | CUSTOMGRAPHS$3$

UNITS

TEMPUNITSS$ Replaced with the Temperature units are set to:
current temperature TEMPUNITSS$
units.

RAINUNITS$ Replaced with the Rain units are set to: RAINUNITS$
current rain units.

PRESSUREUNITS$ Replaced with the Pressure units are set to:
current pressure units. | PRESSUREUNITS$

HEIGHTUNITS$ Replaced with the Height units are set to:
current height units HEIGHTUNITSS

WINDSPEEDUNITS$ Replaced with the Wind speed units are set to:
current wind speed WINDSPEEDUNITS$
units.

Individual Stats

The STAT tag is used to create a query that is sent to WeatherCat’s statistics system and the
result of the query replaces the text of the tag. The STAT tag takes a list of parameters
which starts and ends with a $ symbol.

The basic format is:

STATSITEM:TYPE:PERIOD$

ITEM can be one of:
RAIN

DAILYRAIN
RAINDAYS
FROSTDAYS
DAILYSUN
TEMPERATURE
DEWPOINT
WINDCHILL
HEATINDEX

Either rain rate or accumulated rain
(depending on the query context)

Total rain on a daily basis

How many rain days over a given period
How many frost days over a given period
Total sun on a daily basis

External temperature

Dew point
Wind chill
Heat index
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PRESSURE
WINDSPEED
AVERAGEWINDSPEED
WINDGUST
WINDDIRECTION
WINDRUN
EXTHUMIDITY
INTHUMIDITY
INTTEMPERATURE
uv

SOLAR
SUNSHINEHOURS
AT US

AT AUS

HUMIDEX

SNOW

SNOWDAYS

T1 through T8

H1 through H8

LWI1 through LW4
SM1 through SM4
ST1 through ST4
SYNI1 through SYNS5

TYPE can be one of:

CURRENT
24HRSAGO
MIN

MAX
AVERAGE
TOTAL

PERIOD can be one of:

TODAY

Barometric pressure

Wind speed (context sensitive - see notes below)
Average wind speed (10-minute)

Wind gust (10-minute)

Wind direction

Wind run

External humidity

Internal humidity

Internal temperature

U.V. radiation

Solar radiation

Sunshine hours

Apparent Temperature (U.S. Calculation)
Apparent Temperature (Australian Calculation)
Humidex

Accumulated snow

How many snow days over a given period.

Extra temperature sensors 1 to 8
Extra humidity sensors 1 to 8
Leaf wetness sensors 1 to 4
Soil moisture sensors 1 to 4
Soil temperature sensors 1 to 4
Synthetic channel data.

Real time value

The value 24 hours ago.
Minimum

Maximum

Average

Total

SINCE9AM (Period covers from ‘now’ until the previous 9 a.m.)

YESTERDAY
THISWEEK
LASTWEEK
THISMONTH
LASTMONTH
THIS YEAR
LAST YEAR
THISSEASON
ALLTIME
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HRS(x) (Period covers x number of hours from ‘now’—i.e. HRS(1) means the last
hour.)

HRSAGO(x) (Pulls out a value x hours ago - see notes below).

DELTAHRS(x) (Pulls out the delta across the specified period - see notes below).
DAYSAGO(x) (Period covers the day x days previous —i.e. DAYSAGO(1) means
yesterday.)

RAINSTORM (Period covers the current rain storm period - see notes below).
OR a user defined date range (see ‘User Defined Date Ranges’ below)

By appending TIME we can display the time of the event:
STATSITEM:TYPE:PERIOD: TIME$

For example, to display the highest temperature today:
STATSTEMPERATURE:MAX:TODAY$

To display the time of highest temperature today:
STATSTEMPERATURE:MAX:TODAY:TIMES$

Thus the follow code:
Highest temperature today: STATSTEMPERATURE:MAX:TODAY$ at
STATSTEMPERATURE:MAX:TODAY:TIMES.

Is rendered as:
Highest temperature today is 15.72 at 12:01 AM.

We can use the TEMPUNITSS tag to display the temperature units, so the complete line of
code would look like:

Highest temperature today: STATSTEMPERATURE:MAX:TODAY$ TEMPUNITS$
at STATSTEMPERATURE:MAX:TODAY:TIMES.

Example:

To find the highest temperature yesterday:
STATSTEMPERATURE:MAX:YESTERDAY'$
STATSTEMPERATURE:MAX:YESTERDAY:TIMES.

These tags are rendered as:
23.17
5:39 PM

Notes:

CURRENT will display the real-time value of a given item — these queries are replaced
with the data value at the time of the query. This is different to the higher level tags such as
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CTS or CDS etc. as those values are pulled from the database which has a resolution of 1
minute.

In the case of CURRENT, the time field (TODAY, YESTERDAY etc) will be ignored and
can be omitted.

To display the current outdoor temperature:
STATSTEMPERATURE:CURRENTS$
This is rendered as:

12.17

CURRENT can also return the value of the following additional sensors:

LW1, LW2, LW3, LW4 - leaf wetness sensors.

SM1, SM2, SM3, SM4 - soil moisture sensors.

STI1, ST2, ST3, ST4 - soil temperature sensors.

T1, T2, T3, T4, TS5, T6, T7, T8 - extra temperature sensors.

H1, H2, H3, H4, H5, H6, H7, HS - extra humidity sensors.

DAILYET, MONTHLYET, YEARLYET - Daily, monthly or yearly evapotranspiration
SYN1 through SYNS - synthetic channels.

Example:
Current Soil Moisture 1: STAT$SM1:CURRENT$ Centibar<BR>

24HRSAGO will display the value of a given item 24 hours ago.

In the case of 24HRSAGO, the time field (TODAY, YESTERDAY etc) will be ignored and
can be omitted.<BR>

To display the outdoor temperature 24 hours ago:

STATSTEMPERATURE:24HRSAGO$

24HRSAGO may only be used with the following data types:

TEMPERATURE, WINDCHILL, HEATINDEX, DEWPOINT, EXTHUMIDITY,
PRESSURE, WINDSPEED, WINDGUST, AVERAGEWINDSPEED,
WINDDIRECTION, RAIN (in this case the rain rate), INTTEMPERATURE,
INTHUMIDITY, SOLAR, UV., SNOW, SYNI1 through SYNS5.

HRSAGO(x) This time period specifier which will pull out a single value x hours ago -
for example:

STATSTEMPERATURE:HRSAGO(1)$ will return the temperature value an hour ago
whereas STATSTEMPERATURE:HRSAGO(0.5)$ will return the temperature value half
an hour ago.

This tag is useful for building things such as scrolling historical data-sets either for direct
display (for example in a table) or further processing on the server (for example graph
generation).

The upper limit on the parameter x is the start of your data set. Negative values or values
off the start of your data-set will return 'N/A".
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HRSAGO(X) can also be used in a STATS tag with an operation type of MIN/MAX/
AVERAGE. This will pull out the minimum, maximum or average for the hour. Hours in
this case refers to wall-clock hours, and not the 60 minutes x hours ago from the time of
the call. E.g. If the time is 21:50 and HRSAGO(24) is called, the data returned will be for
the hour 21:00 to 21:59 24 hours ago.

Example: STATSTEMPERATURE:MAX:HRSAGO(12)$ will return the maximum
temperature for the hour 12 hours ago.

RAINSTORM The period of time specified by RAINSTORM is the period between a rain
rate being detected and now. The rainstorm period ends when there has been 24 hours with
no rain rate. If there is no rain storm period, the tag will display as 'N/A’.

E.G:

STATSTEMPERATURE:MAX:RAINSTORMS$

will display the maximum temperature during the rain storm period or N/A if there is no
rain storm period currently active.

Note this tag is different to the Davis definition of a rain storm in that starts when the
console detects 2 tips of the bucket rather than a rain rate being detected.

SUNSHINEHOURS can only be used with TOTAL (to find the total number of hours
over a given date range)

e.g. Hours of sunshine today = STATSSUNSHINEHOURS:TOTAL:TODAY $

1s rendered as:

Hours of sunshine today = 0.52

DAILYSUN can only be used with MAX (to find the sunniest day in a given date range)
e.g. The sunniest day this year: STATSDAILYSUN:MAX:THISYEAR:TIME$
(STATSDAILY SUN:MAX:THISYEARS hours)

1s rendered as:

The sunniest day this year: 18 Feb 2012 (0.52 hours)

THISSEASON can only be used with RAIN

e.g. STATSRAIN:TOTAL:THISSEASONS

1s rendered as:

92.20

or

STATSRAIN:AVERAGE:THISSEASONS$ RAINUNITS$/h
1s rendered as:

0.0613 mm/h

(The rain season start month is set in the preferences)
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DAILYRAIN can only be used with MAX or AVERAGE.
e.g. STATSDAILYRAIN:MAX:THISWEEKS on
STATSDAILYRAIN:MAX:THISWEEK:TIME$

1s rendered as:
3.40 mm on 18 Feb 2012

RAINDAYS can only be used with TOTAL and returns the number of rain days over a
given period.
e.g. STATSRAINDAYS: TOTAL:THISMONTHS

1s rendered as:
3

FROSTDAYS can only be used with TOTAL and returns the number of frost days (or air
frosts)over a given period.
e.g. STATSFROSTDAYS:TOTAL:THISMONTHS$

1s rendered as:
8

AT _US, AT_AUS and HUMIDEX are currently limited to a query range of 1 year back in
time.

Deltas

DELTAHRS(x) This time period specifier will pull out the delta across the specified time
period - for example:

STATSTEMPERATURE:DELTAHRS(1)$ will return the temperature delta over the last
hour whereas STATSTEMPERATURE:DELTAHRS(0.5)$ will return the temperature
delta over the last half an hour.

DELTA1 and DELTA24 are deprecated as of version 3 of WeatherCat. These tags are
retained for backwards compatibility, but going forward new templates should use
DELTAHRS(x).

Notes: The upper limit on the parameter x is the number of hours ago to the start of your
data set. Negative values or values off the start of your data-set or in the future will return
"N/A'.

DELTAT1 (deprecated, see DELTAHRS(x)) will display the 1-hour change of a given item
(i.e. the current value — the value an hour ago).

For DELTAL1 the time field (TODAY, YESTERDAY etc) will be ignored and can be
omitted.

***NOTE that wind direction delta is not supported and will return an undefined value®**
To display the current outdoor temperature 1 hour change:
STATSTEMPERATURE:DELTA1$

This is rendered as:

-0.28
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DELTAZ24 (deprecated, see DELTAHRS(x)) will display the 24-hour change of a given
item (i.e. the current value — the value 24 hours ago).

For DELTA24 the time field (TODAY, YESTERDAY etc) will be ignored and can be
omitted.

***NOTE that wind direction delta is not supported and will return an undefined value***
To display the current outdoor temperature 24 hour change:
STATSTEMPERATURE:DELTA24$

This is rendered as:

3.2

Deltas may only be used with the following data types:

TEMPERATURE, WINDCHILL, HEATINDEX, DEWPOINT, EXTHUMIDITY,
PRESSURE, WINDSPEED, WINDGUST, AVERAGEWINDSPEED,
WINDDIRECTION, RAIN (in this case, the rain rate), INTTEMPERATURE,
INTHUMIDITY, SOLAR, UV, SYNI1 through SYNOS.

User Defined Date Range
Date ranges are specified as yyyy-mm-dd/yyyy-mm-dd. The time range runs from the first
minute of the first date to the first minute-1 of the second date.

Example:
STATSTEMPERATURE:MIN:2010-12-01/2011-04-01$TEMPUNITS$

Finds the lowest temperature between 1st December 2010 and 1st April 2011 and displays
it along with the time of the occurrence. The above example would display as:

-154°C
You can also use a user defined date range with the time tag to print the time/date of a

query result. For example, to print the time and date of the above query:
STATSTEMPERATURE:MIN:2010-12-01/2011-04-01: TIMES$

The above example would display as a localised time and date - e.g. '8 December 2010
06:35 AM'.

Tag Errors
Note that some configurations of STATS tags are invalid - in this case WeatherCat will
either allow the tag to be processed - for example:

Highest wind direction today = STATSWINDDIRECTION:MAX:TODAYS degrees
returns an undefined value and is rendered as

'Highest wind direction today = 329.00 degrees'.

or it may render as an error; for example:
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Average wind direction today = STATSWINDDIRECTION:AVERAGE:TODAY'$ degrees
on STATSWINDDIRECTION:AVERAGE: TODAY:TIMES renders as:

Average wind direction today = 83.78 degrees on ***Error - No time available for
averages™**

Latest Tags And More Information

WeatherCat is continually evolving; for an up-to-date list of tags, please see:
https://live.trixology.com/custom

In addition, the WeatherCat Web Templates forum offers hints, tips and templates:
https://athena.trixology.com/index.php?board=5.0
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Appendix 5 — File Extensions Processed By Custom Web Page Processing

The following file types will be processed by WeatherCat for tag replacement when
processing custom web page:

Jhtm

Jhtml

Jhtx

.CSS

xml

txt

-.php
.Shtml

.Stm

.Shtm

All other file types will be uploaded but not processed for tag replacement.
Note that when processing tags which generate html links to files, for example graphs or

gauges, only the filename will be generated if the file is php, in all other cases, html code
to link to the file will be generated.
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Appendix 6 — Uninstalling WeatherCat

Drag the WeatherCat application to the trash.

To delete files created by WeatherCat, drag the following folders and files to the trash
(some of these may not exist):

~/Library/WeatherCatData

~/Library/WeatherCatBackups

~/Library/Application Support/WeatherCatCustomWeb

~/Library/Application Support/WeatherCatMedia

~/Library/Application Support/WeatherCatTemp

~/Library/Application Support/WeatherCatWeb
~/Library/Preferences/com.trixology.weathercat.plist

(where ~ 1s your home directory).

Note that on OS X 10.9 or later, the Library folder is hidden. You can make it visible again

via the following terminal command:
chflags nohidden ~/Library/
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Appendix 7 - WeatherCat Rich Client Protocol (RCP)
The RCP provides an interface to fetch various objects from WeatherCat.

This interface runs over http and supports the following logical sections, or domains:
discovery

webtag

data

image

help

All replies are in the form of an NSDictionary (or plist/xml). The protocol runs over http
on port 49255 and advertises itself on Bonjour as "WeatherCat Rich Client Protocol Server'
- _wcreps._tep.

A typical request might be (these can be run in any web browser for testing):
http://localhost:49255/webtag/STATSTEMPERATURE:CURRENTS$
(replace 'localhost' with the address of the machine running WeatherCat)

Replies are typically of the form:
<plist version="1.0">
<dict>

<key>result</key>
<string>5.8</string>
<key>error</key>
<integer>0</integer>
<key>errorDescription</key>
<string>0OK</string>
<key>serverTime</key>
<string>2017-03-27 22:17:00 +0000</string>
<key>processTime</key>
<string>0.00217700</string>
</dict>

</plist>

The returned dictionary will contain the following keys:

result - the result of the query (as a string)

error - a negative error number or 0 if no error. If there is an error, the result value will be
set to "0".

errorDescription - a human readable english language description of the error, or 'OK' if
no error.

serverTime - the time on the server in UTC

processTime - how long the request took to process in seconds.
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Programmatically an RCP call can be made with the following code: (Objective-C, in this
example a call to process a webtag):

NSDictionary* myDict=[NSDictionary dictionaryWithContentsOfURL: [NSURL
URLWithString:@"http://address of machine running WeatherCat:49255/
webtag/stat$TEMPERATURE : CURRENTS” ] 1];

myDict will then contain the keys and values as described above.

Alternatively, calls can be made from a website as long as port 49255 is made available
from the network WeatherCat is running on (if the web server is external to that network).

Domain: discovery

channelList

Returns an array of dictionaries as the result which contains all active channels. Each
dictionary contains the following keys:

channelName - the name of the channel (string).

channelNumber - the channel number (integer)

channelType - enumeration, station_channel type (integer)

channelBasicType - base channel type (integer) - for example temperature, wind speed,
pressure etc

channelValid - 1 if valid (integer)

The channel types are as defined in the 'station_channel type' enumeration found in the
WeatherCat SDK header 'StationPlugInProtocol.h'

channelBasicType is defined as:

NONE 0 //Not applicable or not known.

TEMPERATURE 1 //External temperature

PRESSURE 2 //Barometric pressure

WINDSPEED 3 //Wind speed

WINDDIRECTION 4 //Wind direction

PRECIPITATION 5 //Rain

RH 6 //Relative humidity

CLOUDBASE 7 //Coud base

SOLAR _RAD 8 //Solar radiation

UV 9 //U.V. Index

LEAF_WETNESS 10 //Leaf Wetness

SOIL MOISTURE 11 //Soil moisture

C02 12 //co2

NO_UNITS 20 //Synthetic channels with no units

NO _UNITS 1DP 21 //Synthetic channels with no units, display to 1 decimal
point

NO UNITS 2DP 22 //Synthetic channels with no units, display to 2 decimal
points

NO UNITS 3DP 23 //Synthetic channels with no units, display to 3 decimal
points
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getChannelOfType

Given a channel type, returns the channel number of the found channel (as an integer). If
the channel type is not found, -1 will be returned as the channel number and the error will
be set to -3.

e.g. http://address of machine running WeatherCat:49255/discovery/getChannelOfType/4
(get the pressure type channel - see the 'station_channel type' enumeration found in the
WeatherCat SDK header 'StationPlugInProtocol.h' for the channel types).

customGraphList

Returns an array of dictionaries describing the custom graphs available. Each dictionary
contains the following keys:

name - the name of the custom graph (string)

UID - the unique identifier for the graph (integer). Used for retrieving the image of the
custom graph

customTextWindowsList

Returns an array of dictionaries describing the custom text windows available. Each
dictionary contains the following keys:

name - the name of the custom text window (string)

UID - the unique identifier for the custom text window (integer). Used for retrieving the
image of the custom graph

alertsList

Returns an array of dictionaries describing the alerts and their status. Each dictionary
contains the following keys:

name - the name of the alert (string)

triggered - the alert triggered status (bool)

systemData
Returns a dictionary of useful data such as sampling period, comms data, version
information etc.

Domain: data

getChannelValue

Returns the value of the given channel.

Example:

http://address of machine running WeatherCat:49255/data/getChannel Value/0
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If the channel is not found the error will be -3 (otherwise 0).

Note - as it is possible for the user to quit WeatherCat, change the station to that of a
different type/manufacturer, then relaunch WeatherCat, channel numbers should not be
cached in clients. To get at the live value of a channel use the getChannelOfType to get the
channel number then use that channel number for getChannel Value.

getData

This command takes three parameters:

param1 = the channel type (as per the enum found in the SDK header
StationPlugInProtocol.h).

param?2 = the number of samples to return (first sample in the array is the latest in the
database)

param3 = the period between samples in minutes.

Returns an array of values.

Example:

http://address of machine running WeatherCat:49255/data/getData/1/288/5

Returns an array of 288 external temperature values (channel type 1) at 5 minute intervals
(i.e. the last 24 hours at 5 minute resolution). The first entry in the array of returned values
represents the latest sample (i.e. now), the second entry in the array will be the temperature
5 minutes before that and so on.

Note: This command is limited to returning a maximum of 10000 data items.

Possible errors for this command:

-5 = Too much data requested - maximum is 10000 values.
-4 = Wrong number of parameters

-3 = Channel not found

Domain: image

getCustomGraph

Given a custom graph UID (see customGraphList), return the image of the graph with the
dimensions as set in the custom graph web width and height.

Example:

http://address of machine running WeatherCat:49255/image/getCustomGraph/1490220331

Possible errors for this command:
-5 = Custom graph not found, check UID.
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getBasicGraph
Returns a basic graph with the given ID - for example:
http://address of machine running WeatherCat:49255/image/getBasicGraph/ID

where ID 1s one of:
TEMPERATURE 1
DEWPOINT 2
WINDCHILL 3
PRESSURE 4
WINDSPEED 5
WINDDIRECTION 6
PRECIPITATION RATE 7
PRECIPITATION DAILY 8
RH 9

INT RH 10

INT TEMPERATURE 11
SOLAR_RAD 17

UV 18

Possible errors for this command:
-8 = Basic graph not found, check ID.

getCustomTextWindow

Given a custom text window UID (see customTextWindowsList), return the image of the
custom text window with the dimensions as set by the current custom text window size.
Example:

http://address of machine running WeatherCat:49255/image/getCustomTextWindow/
1507983243

Possible errors for this command:
-5 = Custom text window not found, check UID.

getWebCam

Returns the current camera image.

Example:

http://address of machine running WeatherCat:49255/image/getWebCam

Possible errors for this command:

-2 = camera not enabled or operational.
-3 = camera off-line for the night.

-6 = image not ready. Try again later.
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image domain notes:
1. All images are returned as a string of hex-chars and can be converted to an NSImage

object with the following Objective-C code:

myDict=[NSDictionary dictionaryWithContentsOfURL:[NSURL
URLWithString:@"http://address of machine running WeatherCat:49255/image/
getCustomGraph/1490220331"]17];

NSString* hexchar data=[myDict objectForKey:@"result"];

NSMutableData *imageData= [[NSMutableData alloc] init];
unsigned char the byte;
char byte chars[3] = {'\0',"'\0"',"'\0"};
for (int i=0; i < [hexchar data length]/2; i++)
{

byte chars[0] [hexchar data characterAtIndex:i*2];
byte chars[1] [hexchar data characterAtIndex:i*2+1];
the byte = strtol(byte chars, NULL, 16);

[imageData appendBytes:&the byte length:1];

}

NSImage *image = [[NSImage alloc] initWithData:imageDatal];

2. Images can be scaled before transmission by appending integer width and height
parameters - for example:

http://localhost:49255/image/getBasicGraph/ID/width/height

Note that the aspect ratio of the image will be maintained during scaling and as a result,
the dimensions you get back may not match the dimensions you requested.

Domain: webtag

Processes the given tag and returns a string with the result.
Example:

http://address of machine running WeatherCat:49255/webtag/
STATSTEMPERATURE:CURRENTS

Webtag return values are always strings.

The following webtags are currently supported:

STATS tags, so current and statistical data can be retrieved.
JOURNTS - return the journal text

SUNRISELOCALS - local sunrise time

SUNSETLOCALS$ - local sunset time
SUNRISEUTCS - UTC time of sunrise
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SUNSETUTC - UTC time of sunset

DAYLIGHTTIMES - day light time today
SUNRISELOCALI1S - sun rise time tomorrow
SUNSETLOCALTI - sun set time tomorrow

SUNRISEUTCI - sun rise time tomorrow in UTC
SUNSETUTCIS - sun set time tomorrow in UTC
DAYLIGHTTIMELIS - daylight time tomorrow
STRECORDSS - Records stats (formatted text)
STRECENTS - recent stats (formatted text)
STMONTHLY 13 - monthly stats part 1 (formatted text)
STMONTHLY2S$ - monthly stats part 2 (formatted text)
STMONTHLYS$ - monthly stats in total (formatted text)
STYEAROVERYEAR - year over year stats (formatted text)
STDAILYS - daily stats (formatted text)
STTHISMONTHOVS - this month overview (formatted text)
STLASTMONTHOVS - last month overview (formatted text)
STNOAAMOS - this month NOAA report (formatted text)
STNOAAPRMOS - last month NOAA report (formatted text)
STNOAAYRS - this year NOAA report (formatted text)
STNOAAPRYRS - last year NOAA report (formatted text)
BTTEXTS - baro trend as text

DOMWDTEXTS - dominant wind direction as text
WINDBEARINGFROMI10S - last 10 mins lowest clockwise bearing
WINDBEARINGTO108$ - last 10 mins highest clockwise bearing
DOMWDDEGREES - dominant wind direction as degrees today
WEATHERFACTS - return the current weather fact

AT Aus$ - current Australian apparent temperature.

AT USS - current US apparent temperature

HUMIDEXS - current humidex

WINDROSES - wind rose as 8 sectors

WINDROSE4S5 - wind rose as 45 sectors

CPS$ - current potential solar radiation

CCS - current conditions string

CFS - current forecast string

CSF$ - current short forecast

CUS - time of last sample

CDS$ - current dew point

CGS - current wind gust

CPS$ - current pressure

CRS - current rain

CTS$ - current temperature

CWS$ - current wind speed

CWCS - current wind chill

CXS$ - current wind direction

BDS - build string

BDLS - build string, localised
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t12s$ - 12 hour time with seconds

t12$ - 12 hour time, no seconds

t24s$ - 24 hour time with seconds

t24$ - 24 hour time, no seconds

da$ - date in the format of month/day/year

de$ - date in the format of day/month/year

UTS$ - WeatherCat uptime as a string

RSS - rain storm value

RSDS$ - date of rain storm start

RLDS - last rain date

RLDiS$ - last rain date (ISO format)

Llat$ - latitude of station

Llong$ - longitude of station

Lelevf$ - station elevation in feet

LelevmS$ - station elevation in metres

L$ - station name

DUTCS - date and time in UTC - yyyy,m,d,h,m,s

DS$ - date and time

HEIGHTUNITSS - string describing the height units - one of Metres of Feet
TEMPUNITSS - string describing the temperature units - one of A°C or A°F
RAINUNITSS - string describing the rain units - one of mm or in
WINDRUNUNITS - string describing the wind run units - one of km, miles, NM's or
metres

HEIGHTUNITSS - string describing the height units - one of Feet or Metres
PRESSUREUNITS - string describing the pressure units - one of mb, inHg, hPa
WINDSPEEDUNITSS - string describing the wind speed units - one of km/h, MPH,
Knots, m/s

COMMSFAILFLAGS - set to 1 if comms to station have failed else 0

Domain: help

List the current RCP help.
Example:
http://address of machine running WeatherCat:49255/help
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Appendix 8 — Frequently Asked Questions

Actually, these aren't asked frequently at all, but we've seen them frequently enough to
document them.

Q: WMR 928/968 — comms counts increasing fast and data bouncing up and down?
A: Quit WeatherCat, unplug your serial to USB converter, count to 5, plug it back in and
run WeatherCat.

Q: I’ve just moved to a new computer and used migration assistant to move
everything across from my old computer. Now I am getting no data from my station/
various things aren’t right in WeatherCat. How can I fix this?

A: Migration Assisitant may not move everything required for WeatherCat to run on the
new computer (drivers for example). A page on the wiki at https://wiki.trixology.com/
index.php?title=Moving a WeatherCat installation from one computer to another
details everything that needs to be moved from the old computer to the new one. Follow
through this page to correctly transfer everything needed.

Q: WS23xx — rain is incorrect on historical download.

A. Historical rain counter is out of sync. with real-time rain counter in console. Quit
WeatherCat. Unplug console from computer and mains power, take batteries out, count to
10, batteries back in, power up and connect to computer. Reset console by holding down
Wind and Pressure buttons until console beeps (indicating it has reset). Set-up the console,
especially the date & time then run WeatherCat. From the Tools Menu select ‘Station
Hardware Options’ and set the data logger interval to your preferred interval.

Q: Vantage — I wish to try WeatherCat and I’ve installed the latest USB drivers for
the Vantage but WeatherCat is not seeing my station

A. If you’ve used your Vantage with WeatherLink on a PC it may have switched your data
logger to USB mode; WeatherCat needs it to be in serial mode before it will be able to see
it. You should be able to switch the mode back to serial in WeatherLink for Windows.

Q: Sometimes the daily rain reported in WeatherCat is much higher than that
reported on my console — I’m running a Davis Vantage

A. A rain discrepancy normally happens as the result of inconsistent rain data coming in
from the console. Check the raw rain being recorded (in the data viewer within
WeatherCat) — it should be slowly incrementing as it rains and showing no increase whilst
it isn’t raining. If it’s dropping to 0 it will cause a problem as WeatherCat calculates rain
over a period by adding up the differences between individual samples. (This can happen
as a result of poor communications — check for comms errors or sensor errors being
reported by WeatherCat, or if the data has come from the data logger, corrupt records — in
this case try clearing the logger)
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To fix it, you can either edit up the fallen values, either in the editor (restart WeatherCat
after all values are edited) or if there are many to be done, directly in the data file with a
text editor such as TextWrangler (see the WeatherCat manual section ‘WeatherCat And
Data’) .

Alternatively you can use the daily rain editor (from the Tools menu) to edit the rain for
the day which will correct your stats.

Q: Is it OK to put my computer to sleep whilst running WeatherCat?

A: We do not recommend putting your computer to sleep if running WeatherCat. Instead
we suggest either quitting WeatherCat before putting the computer to sleep, or shutting the
computer down entirely. Alternatively, set the Energy Saver to sleep the display but never
sleep the computer. Note that since version 3, WeatherCat will ask the system not to sleep
while it is running.

Q: When I launch WeatherCat it just bounces in the dock until I force quit it — how
do I fix this?

A: Your station is not responding. When WeatherCat launches it attempts to automatically
connect to your station — it will keep trying until either your station responds or you force
quit it (it does not assume a human is present).

You can fix this situation by launching WeatherCat into ‘Safe Mode’ (by holding down the
‘ctrl’ key whilst launching WeatherCat) and then selecting ‘Configure Station Comms...’
from the Tools menu. This will cause WeatherCat to forget the current connection details
and when next launched will display the ‘Station Configuration’ window from where the
connection to your station can be set/tested.

Q: I sometimes get a message from WeatherCat saying communications have failed to
the station and/or the USB driver has failed — is there anything I can do about this?
A: Communication failures are typically caused by electrical or radio frequency noise
interfering with and/or crashing the USB to serial driver supplied by either the station
manufacturer or the manufacturer of your USB to serial converter. These drivers live in the
kernel space so if you do get this message it is wise to re-boot your computer.

The Davis USB data-logger is particularly prone to the problem and the driver crashes in
such a way that WeatherCat is not able to restart the driver — the only recourse is to reboot.
Some general advice is to make sure you don’t have any sources of RF or electromagnetic
interference near the console, its power supply or computer (TV’s, fluorescent lights,
electrical switches, thermostats, RF transmitters etc) and to add some ferrite rings or
clamps to the USB cable at both ends and the power supply cable as near as possible to the
plug that plugs into the console.

Another possible cause of communications failure is worn out batteries in the console.
Replacing the batteries with new ones may cure the problem.
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Q: Wunderground says it’s running, but the counts aren’t incrementing and my
Wunderground page shows no live data.

A: It’s most likely WeatherCat is uploading historical data. You can check if this is the case
by switching on the ‘Log Historical Uploads’ tick box in the Wunderground preferences
and then checking WeatherCat’s log window. You can cancel the historical upload by
disabling historical uploads, waiting a few minutes until real time operation resumes then
re-enabling the feature to cover periods when WeatherCat isn’t running in the future.

Q: Where does WeatherCat store its log files.

A: WeatherCat 3 log files are stored at ~/Library/Logs/WeatherCat

Previous versions logged to the systems console log. 7 days of log entries are stored in 7
rotating files.

Q: My current conditions are wrong.

A: The current conditions are calculated by the Current Conditions Calculator found in the
Tools menu. Open the current conditions calculator and hit the ‘Defaults’ button to reset
the rule list to factory defaults. This will give you a basic set of rules which will return a
result. You can then tweak these rules to suit your particular micro-climate.

Q: Apple has just released a major update to the operating system. Is WeatherCat
OK to run on the new OS?

A: In general we would advise avoiding the update until at least the first few bug fix
releases are out. Secondly, if you are using a USB to serial driver (for example
SiliconLabs), check with the manufacturer that the driver works correctly with the new OS
and whether you need to update it (otherwise WeatherCat won’t be able to communicate
with your station).1. Q: WMR 928/968 - comms counts increasing fast and data bouncing
up and down?

Page 228



Release notes

Version 3.3.0 Build 236 (Transient Atmospheric Phenomenon)

1. Native Apple Silicon Support.

2. WeatherLinkLive station driver stability improvements.

3. Fix a crash that could happen generating custom web pages on MacOS Sonoma

4. Fixed a bug whereby station comms may stop if the Station Hardware Options
window is displayed.

5. Removed the Netatmo station driver which is no longer supported after API changes
on the Netatmo side.

6. Changed FTPS to require an SSL connection (CURL: --ssl-reqd) , previously it was
'try' an SSL connection (CURL: --ssl)

7. Removed the SQL driver from the AppleSilicon build, still present in the Intel build.

8. Mail sending has been moved off the main thread. This will avoid the situation
where WeatherCat could hang until mail sending timed out (if for example, there is a
problem with the configuration or the mail server is not reachable/responding).

9. Removed Twitter functionality.

10. Updated documentation.

11. Minimum required operating system version is now 10.13.

V3.2.0 - 22nd April 2023

1. Added initial WeatherLinkLive support.

2. Custom text windows, Twitter, Banner generator, video preview and basic gauges
windows will no longer appear in the Windows menu when they shouldn't.

3. Added a 3 second webcam capture period, previous minimum was 5 seconds.

4. Admin emails are now defaulted to on for fresh installs

5. Fixed a bug whereby numbers between -1 and 1 would always be displayed as 1 in the
summary report to the log window as each sample is taken.

6. Added initial macOS notifications support - startup, shutdown and custom alerts are sent
to the notification system. Note that the alert text will be truncated by the notification
system and you can turn off and change the style of the alerts via the Notifications System
Preferences. Notifications can be switched off and on from WeatherCat's preferences
(Advanced pane)

7. Minimum period for WeatherCloud is now 1 minute (down from 10).

8. Temperatures in annual weather record emails are now reported to 1 decimal point,
previously was 2.

9. Temperatures in all-time weather record emails are now reported to 1 decimal point,
previously was 2.

10. Now built with Xcode 14, no change in earliest OS we can run on (10.9 or later).

11. Twitter - temperatures are now displayed to 1 decimal place, previously it was an
integer.
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12. If all station data is deleted, we now also delete the rain and snow edit data
(Preferences->Location/Colours->Delete Data).

13. Fixed an issue with inconsistent AM/PM designators across the interface.
14. Fixed a small leak in the Log window.

15. Update to German localisation courtesy of Reinhard.

V3.1.3 - 5th March 2022

1. Removed Wunderground webcam functionality as Wunderground announced
discontinuance of the webcam service 21 Oct 2021 — https://support.weather.com/s/article/
Webcam-hosting-service-is-discontinued-effective-October-21-2021?language=en_US ).
2. Fix a warning shown on first launch on macOS 12 that WeatherCat needs to be updated
(this is a Python 2 deprecation notice — if running on macOS 12 or later we now use
Python 3 — see note below)

3. Fix for an issue where the background on basic gauges would always be white
irrespective of the colour set in the preferences on macOS 11 or later.

4. Fix a crash that could happen when initialising the camera.

Note that from version 3.1.3 onwards, and if running on macOS 12, WeatherCat requires
Python 3 to be installed on your system for some of its functionality. You may be asked to
install it via a dialog box (this will only happen once) — this video shows the process.

V3.1.2 - 7th February 2021

1. Fix for banner generator not generating banners on macOS 11
2. Fix for custom text windows custom web uploads not working on macOS 11
3. Work around for flickering basic gauges on macOS 11, client also updated.

V3.1.1 - 8th November 2020

1. Fix AppleScript SetQuery broken if value returned is 1000 or greater and grouping
separator is in use on the system - visible for example as pressure being broken on Twitter
if units are hPa or mBar with values of 1000 or above.

2. Fix pressure being broken in export if units are hPa or mBar and grouping separator in
use on the system.

3. Correct spelling of 'Drier' in monthly summary tag (thanks to Steve for the spot).

V3.1.0 - 16th October 2020

1. If solar radiation is present on the station, it is now displayed on the camera overlay.
2. Fixed an issue where custom graph web-tag may be clipped when more than 9 custom
graphs are present.

3. Custom Alerts are now checked every two seconds, was five seconds previously.

4. Fixed a bug whereby it was very difficult to enter temperature offsets into calibration
window if temperature units were set to Fahrenheit.

5. The number of RCP requests in the last hour are now displayed in the status window.
6. Updated the button links in Wunderground preferences.
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7. You can now add a camera key to the Wunderground preferences for web-cam uploads.
8. We now indicate password/i.d. error for Wunderground if there’s a problem with the
station [.D. or password rather than a generic ‘Error’.

9. WeatherCat now honours the number grouping separator (for example 1,023 versus
1023) as set in the System Preferences->Language And Region->Advanced in places
where it makes sense (not years for example).

10. Added an AWEKAS uploader (https://www.awekas.at) (Preferences->Online-
>Additional Services)

11. Added an FTPS option to the ‘Advanced’ pane of WeatherCat’s preferences.

12. Netatmo: Channel changes required to upload gust to on-line services. NOTE: If you
are running a Netatmo, please check any custom graphs, gauges and current conditions
rules as the channels may have changed.

13. Fixed an issue in the SQL driver whereby the progress bar would not be displayed
when uploading historical data. We now also show how long uploading of historical data
will take and also how many transactions per second during upload of historical data.

14. Documentation update.

V3.0.5 - 28 December 2019

1. In monthly report, we now print temperatures to 2 decimal places - was 1.
2 Fixed a potential crash in the SQL driver.
3 Fix a crash when Simple Web '"Test Web Pages Locally' button pressed.

V3.0.4 - 26 January 2019

1. Netatmo: Improved server connection failure handling and reconnection. Also improved
token expiry handling to avoid latency when token expires.

2. On station comms fail, we no longer show the message to check the USB connections if
the station is IP based.

3. Fixed some alignment issues with dock update time in preferences.

4. WeatherLink IP and Vantage station drivers - we now check and correct the station clock
at 03:05, previously it was at 00:05 (if option is enabled in Station Hardware Options).

5. Custom web processing has been re-architected to increase the processing speed. The
actual speed up seen over V3.0.3 will depend on the computer - a more powerful computer
will show more of a speed up than a less powerful one when processing identical
templates.

6. Simple web processing speeded up as per custom web.

7. Fixed some threading issues.

8. Changed comms fail message so it doesn't show 'May need to restart computer' if station
doesn't use a serial to USB driver.

9. Tidied up the dock update time preferences for alignment.

10. Custom scrolling graphs now have a maximum period of 56 days, previously 28.

11. WeatherLink IP station driver now explicitly logs to WeatherCat's log window when it
disconnects hourly to allow the logger to upload historical data (if allowed in the Station
Hardware Options). In addition, the hourly disconnect period has been increased to the
recommended 1 minute (up from 20 seconds).
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12. Latest Italian translation updates courtesy of Federico Paoletti.

V3.0.3 - 28 October 2018

1. Maintenance update to address an issue where WeatherCat may hang on download of
data from your data logger.

Version 3.0.2 Build 28 (Tactical Grace) - 4 October 2018
1. Fixed an issue with display of coordinates in NOAA style reports.

2. Removed WeatherBug support as the service has shut down. See https://
athena.trixology.com/index.php?topic=2749 for details

3. Potential fix for an issue where heat index may display incorrectly on monthly report.
4. Fix an issue where custom gauges may not render for custom web pages.

5. Updates for macOS 10.14.

Version 3.0.1 Build 5 (Tactical Grace) - 27 April 2018
1. Fixed high CPU usage that may happen on some installs if webcam is not in use.

Version 3.0.0 (Tactical Grace) March 2018

Added a rich client protocol interface.

This interface runs over http and supports the following functionality: discovery, data
retrieval, web-tag processing, images (graphs, webcam etc) and help. See below for
functionality/usage.

Movie functionality has been rewritten and expanded.

As well as the normal hourly movies, WeatherCat can now also create a true 24 hour time-
lapse movie. This movie is updated hourly throughout the day and can be uploaded to your
website with a new web-tag on an hourly basis. The format of the generated movies has
been changed from Quicktime (.mov) to H.264 (.mp4) and an inter-frame dissolve option
added. Daily movies are now also archived at ~/Movies/WeatherCatMovies in a year/
month hierarchy. You can access the new functionality via the Webcam pane of
WeatherCat's preferences.
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Webcam/movie changes as follows:

a. Hourly movies are now created at the end of the hour on a background thread.
Previously they were created on the main thread. These are smaller than the hourly movies
created previously (for the same quality).

b. Webcam: 'Disable webcam uploads at night' relabelled to 'Disable webcam at night'. If
this option is selected, the webcam will stop capturing 1 hour after sunset and restart 1
hour before sunrise. Previously it would just stop webcam related uploads.

c. Added a DAILY MOVIES tag which will upload the daily time-lapse movie on the first
custom web run after the movie is created. If WeatherCat isn't running at that time, then no
upload will take place. The file uploaded by this tag is called
'WeatherCatDailyMovie.mp4'. The daily movie is created every hour as the day
progresses.

d. The custom web tag 'MOVIES$' now uploads a file called "WeatherCatlhrMovie.mp4',
previously the file uploaded was called "WeatherCatDailyMovie.mov'.

e. The webcam status in the 'Status' window now shows how many frames have been
captured.

f. Daily movies (not 1 hour movies) are now archived at ~/Movies/WeatherCatMovies as
they are created. Year and month folders will be created to aid organisation. There is a user
configurable default to switch this on/and off (ArchiveMovies) but it isn't available in the
Ul yet.

g. Added movie run-time length (default is 15 secs/hour) and inter-frame dissolve sliders
(default is off) to the webcam preferences. Note that enabling inter-frame dissolve will
increase the movie sizes significantly.

Auto-update functionality.

After installation, all updates are automatic from within the application itself. You will be
notified of updates within the application and via email if enabled.

Added Custom Text Windows.

A custom text window is a window you can create and edit to have just the data you want
in it.
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Custom text windows (CTW's) can be found in the Tools menu. There can be an unlimited
number of CTW's. On installation, example weekly and monthly windows are created and
will appear the the CTW menu - these can be used as an example for building new CTW's.

To create a CTW, use the Tools->Custom Text Window->New menu item.
To delete a CTW, use the Tools->Custom Text Window->Delete menu item.

To create items in a CTW, ctrl-click in the window. A pop-up menu lists items that can be
added (the window name can also be set from this menu as well as other functionality).

To edit an editable item, click it. To edit an items attributes (font, colour etc), first click the
item to make it editable then ctrl-click in the item where a pop-up menu will list the
available options.

Multiple items can be selected by cmd-clicking items. Items can be dragged with the
mouse or moved via the keyboard arrow keys by holding down the alt key whilst using the
arrow keys (the window's title bar will indicate the coordinates of the item).

Selected items can be copied with cmd-c. Items can be pasted with cmd-v (items can be
copied and pasted between CTW's).

Items can be cleared either by selecting delete this item in the pop-up menu (for a single
item) or using the Edit menu 'Clear' command when multiple items are selected.

All items in a CTW can be selected with cmd-a. cmd-z will undo the last operation.
The background image for a CTW can be set by dragging an image over the window.

You can save a Custom Text Window (CTW) from its pop-up menu. Similarly, individual
Custom Text Windows can be loaded from the Custom Text Window's menu (Tools-
>Custom Text Windows->File->Load... ).

All CTW's can be saved and loaded as a set from the CTW menu (Tools->Custom Text
Windows->File->Save Set.../Load Set...).

Note: loading a CTW set replaces your current CTW's with the CTW's in the set being
loaded.

Added additional time specifiers for use in web tags.

a) Added an HRSAGO(x) time period specifier which will pull out a single value x hours
ago - for example:
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STATSTEMPERATURE:HRSAGO(1)$ will return the temperature value an hour ago
whereas STATSTEMPERATURE:HRSAGO(0.5)$ will return the temperature value half
an hour ago.

This tag is useful for building things such as scrolling historical data-sets either for direct
display (for example in a table) or further processing on the server (for example graph
generation).

The upper limit on the parameter x is the start of your data set. Negative values or values
off the start of your data-set will return 'N/A".

HRSAGO(x) can also be used in a STATS$ tag with an operation type of MIN/MAX/
AVERAGE. This will pull out the minimum, maximum or average for the hour. Hours in
this case refers to wall-clock hours, and not the 60 minutes x hours ago from the time of
the call. E.g. If the time is 21:50 and HRSAGO(24) is called, the data returned will be for
the hour 21:00 to 21:59 24 hours ago.

Example: STATSTEMPERATURE:MAX:HRSAGO(12)$ will return the maximum
temperature for the hour 12 hours ago.

b) Added an DELTAHRS(x) time period specifier which will pull out the delta across the
specified time period - for example:

STATSTEMPERATURE:DELTAHRS(1)$ will return the temperature delta over the last
hour whereas STATSTEMPERATURE:DELTAHRS(0.5)$ will return the temperature
delta over the last half an hour.

DELTA1 and DELTA24 are deprecated as of version 3. These tags are retained for
backwards compatibility, but going forward new templates should use DELTAHRS(x).

Notes: The upper limit on the parameter x is the number of hours ago to the start of your
data set. Negative values or values off the start of your data-set or in the future will return
"N/A'.

¢). Added RAINSTORM as a time specifier for STATS tags. The period of time specified
by RAINSTORM is the period between a rain rate being detected and now. The rainstorm
period ends when there has been 24 hours with no rain rate. If there is no rain storm
period, the tag will display as 'N/A".

E.G:

STATSTEMPERATURE:MAX:RAINSTORMS$

will display the maximum temperature during the rain storm period or N/A if there is no
rain storm period currently active.

Note this tag is different to the Davis definition of a rain storm in that starts when the
console detects 2 tips of the bucket rather than a rain rate being detected.
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New Twitter functionality.

When you first open the Twitter uploader (Tools->Twitter), a sheet will open where you'll
need to enter your Twitter account details. Once done, the tool should then operate
normally as the authentication data it receives from Twitter will be stored in your keychain
and used for subsequent sessions. The Twitter uploader is compatible with Sylvester data
and will load your default set of Tweets as well as loading any saved sets from Sylvester

Should you wish to change the account you are posting from in the future, you'll need to
delete the authorisation data from your keychain. To do this, quit WeatherCat, open
Keychain access, search for 'WeatherCat Twitter' and delete it. Launch WeatherCat and
open the Twitter uploader, it will then ask you to sign in to Twitter again.

Version 2.4.4 Build 2 (Little Rascal) - October 2017
1. Changes for 10.13.1

Version 2.4.3 Build 4 (Little Rascal) - October 2017
1. Added soil temperature to the MeteoTemplate driver.

2. Fixed an issue where synthetic channels making average type STATS$ calls could drop to
0 on the hour.

Version 2.4.2 Build 15 (Little Rascal) - April 2017

1. Fixed an issue where a message 'WeatherCatPluginManager: errl' might be logged on
launch.

2. Davis Vantage and WeatherLink IP station drivers now report 'Partly Cloudy' in short
forecasts rather than 'Partially Cloudy'.

3. Added a Meteotemplate API driver (Tools->Meteotemplate). Please check the
WeatherCat manual for details.

4. Documentation update.

Version 2.4.1 Build 14 (Little Rascal) - December 2016
1. Added support for the Columbia Weather Systems Weather Micro-server.
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Notes:

a). Enter the URL or IP address of the server. Do not append a page address to the
URL.

b). Internal temperature and humidity will appear valid but will read 0 (as there is no
internal sensors).

c). There is no historical data support. Data will be interpolated for periods when
WeatherCat is not running.

d). The station is polled every 5 seconds.

2. We now tell the OS not to sleep whilst WeatherCat is running.
3. Fixed a crash that could happen in custom gauges on station hardware change.

4. Changed default imagery URL for channel 1 to http://api.sat24.com/mostrecent/EU/
visualShdcomplete as the old default had gone off-air.

Version 2.4.0 (Little Rascal) August 2016

1. Added monthly record emails - these are emails that are specific to the current month -
for example a new high temperature for May. We process for high and low temperature,
high wind speed, high and low pressure, high solar radiation and high U.V. These monthly
records are checked every three hours (the same for all record emails).

2. Fixed an issue whereby if more than 1 record was broken in any three hour period, only
the first record email would be sent.

3. We now show the percentage of packets sent versus acknowledgments in the
WeatherCat status window for Wunderground, CWOP and custom CGI.

4. Added STTHISMONTHOV$ and STLASTMONTHOV$ web tags. These generate an over-
view of either the current or last month in terms of comparison of select variables against
long term averages. For example:

STTHISMONTHOVS:
May so far has been...
Warmer than average (10.9°C versus an average of 10.4)
Dryer than average (43.80 mm versus an average total of 60.64)
Calmer than average (a wind run of 2554 miles versus an average of 3131)

STLASTMONTHOVS:

April was...
Cooler than average (6.4°C versus an average of 7.9)
Wetter than average (63.20 mm versus an average total of 47.98)

Calmer than average (a wind run of 2185 miles versus an average of 3116)
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Notes;

1. These tags, like all 'ST' type tags, output pre-formatted text, therefore the tag needs
to be surrounded with <PRE> and </PRE> tags (or equivalent).

2. These tags need at least 2 years of data to be able to compute the long term values
for a given month - if there isn't enough data the tag will be replaced with text indicating
there isn't enough data. Obviously the more years you have, the more accurate the long
term average,

3. When computing the long term average for a month, the current month is NOT
taken into account. The values given in STYEAROVERYEARS do take into account the
current month.

5. Change default imagery URL for Europe from http://image.weather.com/images/sat/
europesat_440x297.jpg to https://i.imwx.com/images/sat/europesat_600x405 jpg

6. Maximum period for Aux. FTP uploads increased from 1000 to 10000 minutes.
7. Vantage Vue station driver - attempt to remove the odd CRC error.

8. Fixed an issue introduced in V2.3.0 where some channels may not be generated on data
export (annual rain for example).

9. Latest German strings courtesy of Reinhard Unterwurzacher.

10. Attempt a fix at an issue whereby auto-daily export may not export all the data for the
previous day if WeatherCat was not running all the time.

11. We now send the current conditions to clients - the data is appended to the end of the
current data set so should have no affect on older clients. Client comms version changed
from 4 to 5 to indicate this change.

12. Fixed an issue where daily rain on an anchored annual custom graph may be
misaligned in time.

13. SQL driver - temperature type variables now use 2 decimal places resolution,
previously was 1. SQL driver version goes to 1.0.3.

14. Sylvester is now built into WeatherCat. Launching of Sylvester is controlled by a tick
box in the Misc 2 pane of WeatherCat's preferences (off by default). Old Sylvester's can be
removed.

15. Fix a bug where daily wind run sent to clients would be O if units were km's.
Page 238



16. Documentation/manual updated.

OS X Client
1. Preferences window was resizable - it shouldn't be.

2. Change in the connection mechanism - we no longer try to connect whilst launching, but
will immediately after fully launched.

3. Current conditions are displayed in the title bar of the window when running with a
version 2.4.0 (or later) WeatherCat.

Version 2.3.0 (Winter Storm) Feb 2016

1. We now interpolate additional temperature channels 1 to 4 if no data is available from
logger (or there is no logger). Similarly for extra humidity channels 1 to 4.

2. Potential fix for cumulative rain custom graph with a fill crashing.

3. Whilst running live, on stations that output a daily rain value, we now check for the
daily rain value falling when it shouldn't and make it the previous known good value.

4. Fixed an issue where a synthetic channel could return a large negative value on first
start-up.

5. Fixed an issue where it was possible to select days in the future in the daily rain editor.

6. Added support for Netatmo stations. All data is supported with the exception of the
sound data.
Netatmo Notes:
a). In the communications window in WeatherCat, select the Netatmo station
type and enter your Netatmo log-in email and password to connect.
b). All devices are supported, including rain and anemometer.
¢). 4 channels of CO2 are supported but note currently there is no CO2 specifier
for the STAT'S tag.
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d). Battery and wireless strength for all modules can be viewed in WeatherCat
via Tools->Station Hardware Options. (Hovering over a battery indicator will
indicate the remaining charge).

e). Suggested sampling rate in WeatherCat is 10 minutes, non adaptive (as this is
the polling rate to the Netatmo servers).

f). No historical data support - if WeatherCat isn't running for a while, data will
be interpolated (with the exception of daily rain which will use the old value,
resetting at midnight on first day of gap).

g). Local weather alerts will be emailed if email is enabled in WeatherCat.

h). Power fails will be emailed if email is enabled in WeatherCat.

7. AppleScript: added the following properties:

<property name="C021" code="C021" type="real" description="Returns the
current C02 sensor 1 value in parts per million (if fitted)'s></property>

<property name="C022" code="C022" type="real" description="Returns the
current C02 sensor 2 value in parts per million (if fitted)"></property>

<property name="C023" code="C023" type="real" description="Returns the
current C02 sensor 3 value in parts per million (if fitted)'></property>

<property name="C024" code="C024" type="real" description="Returns the
current C02 sensor 4 value in parts per million (if fitted)'></property>

8. AppleScript: WeatherCat AppleScript interface version goes to 6 (WeatherCatASIFVers).

9. Data export speeded up a little.

10. Removed the OpenWeatherMap service.

Version 2.2.3 ( ShadowFax) December 2015

1. Updates for 10.11.2

2. NOAA style report: Fixed an issue where the hour of the daily high wind could be one
hour later than actual.

3. NOAA style report: If daily high wind is 0, report no time of occurrence.

Version 2.2.2 ( ShadowFax) October 2015
1. Address stability issue on 10.11.
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Version 2.2.2 ( ShadowFax) October 2015
1. Fix issue whereby monthly low would be wrong on NOAA style annual report.

2. Fixed an issue whereby journal entries were not being saved.

Version 2.2.1 ( ShadowFax) August 2015
1. Updates necessary for OS X 10.11

Version 2.2.0 ( ShadowFax) June 2015

1. Added a quit check (Preferences->Advanced->Quit Check). Disabled by default. If
enabled, we now need to be told twice in 5 seconds to quit (otherwise the shut down is
aborted). The normal shutdown process is unaffected in that we will still wait for the user
definable delay for shutdown scripts and still wait if a backup or restore operation is in-
progress after the shutdown check.

Note, if enabled, this feature will cause an error to be returned to any AppleScript trying to
quit WeatherCat ('User Cancelled') on the first quit command. To quit WeatherCat from an
AppleScript, handle the error in your script and tell it to quit twice - for example:

tell application "WeatherCat"
try
quit
end try
try
quit
end try
end tell

2. Added a 'Save All' button to the NOAA reports window. This is useful if you wish to
generate a complete set of reports from your database or you have changed something
which would affect all historical reports (heating degree days base temperature for
example). This will save all NOAA style reports to disk (overwriting any existing ones).
This processing can take a while so is carried out as a background task. Task start and end
are reported in the WeatherCat log window along with how long the task took to run.

3. Sylvester.
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Sylvester, a companion application for WeatherCat, integrates with the Twitter account on
your Mac to post weather data at predefined times throughout the day to these services.

Each tweet is defined by a template - there may be an unlimited number of templates.

Each template is made up from one of the following WeatherCat tags:

t12$ - time in 12 hours format

t24$ - time in 24 hour format.

de$ - date in the format d/my

da$ - date in the format m/d/y

STATS - any stat tag that can be processed by WeatherCat including TIME specifiers.

Each template also has a list of tweet times associated with it, these times are defined to a
resolution of one minute (i.e. a maximum of 1440 possible times per day). By default, 4
templates are provided - an hourly and 3 daily templates. You can add to, edit and delete
the default templates. You can also save and load the templates as sets (Tools menu).

Usage:

Make sure you have a Twitter account configured on your Mac. Launch Sylvester and
select the account you wish to post to. Hit the 'Start' button then at the predefined times,
the relevant tweet will be made.

To edit a template, double click it. To add or delete templates, hit the relevant button.

Note: Sylvester requires OS X 10.9 or later and a 64 bit processor.
Note: If Sylvester is found in the same directory as WeatherCat it will launch (as hidden)
when WeatherCat launches and quit when WeatherCat quits.

Tags

1. Added 'DELTACHAR' as a type specifier to the STAT$ tag which is the same as
DELTAT1 but rather that returning the numerical value of the 1 hour delta returns one of the
following characters: '}/ —\\ | ' which represents > 3 units, > 1.5 units, between 1.5 and

-1.5, less than -1.5 and less than -3 units respectively (encoding is UTF-8 if accessed via
the AppleScript interface). Note for pressure, the units for this comparison are millibars
irrespective of the user set units.

DELTACHAR arrows are translated in custom web processing to one of three arrows, up,
right or down. Detail: if the value is rising by 1.5 units or more per hour then &uArr; is
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output. If the value is falling by more than 1.5 units or more per hour then &dArr; is
output, otherwise &rArr; is output.

AppleScript
1. WeatherCat's AppleScript interface version (WeatherCatASIFVers) now returns 5
(Pegasus was 4)

2. Added QueryResultString to the AppleScript interface which will return a string
indicating the result of a query.

For example:

tell application "WeatherCat"
set Query to "STAT$TEMPERATURE:MAX:TODAY:TIMES$"
set result to QueryResultString

end tell

result will contain a string representation of the time of the occurrence (formatted as per
WeatherCat's user settings)

3. Added 'PrecipUnits ' to the AppleScript interface. Returns O if mm's, 1 if inches.

4. Added 'TemperatureUnits ' to the AppleScript interface. Returns 0 if Centigrade, 1 if
Fahrenheit.

5. Added 'WindSpeedUnits ' to the AppleScript interface. Returns O if km/h, 1 if MPH, 2
if knots, 3 if m/s.

6. Added 'PressureUnits ' to the AppleScript interface. Returns O if mB, 1 if inHG.

WeatherCat Client
1. Added dock icon weather display (settings in the preferences). Version changed to 1.5.0.

Other Changes
1. Fixed an issue where heat index average in year over year statistics may be incorrect.

2. Fixed an issue where SNOW in STATS$ tag was displayed to 2 decimal places instead of
1.

3. Fixed a potential hang at the end of an export.
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4. Removed the 'send times and how to turn off" text from forecast emails.

5. WMR200 - we now catch and correct for rain drops (both when running live and
historical download).

6. WMR200 - if the dates on the records from the logger are obviously wrong (i.e. the
date/time hasn't been set on the console), we will now display 'x of 0' records to be
downloaded during a historical download (as we can't calculate how many there are to
come from the timestamps).

7. Added a 'Once Per Hour' option to the speech preferences (Units/Misc 1 pane). If ticked,
the weather will be spoken on the first sample past the hour (rather than on every sample).

8. Improved pronunciation of 'millibars' for English speech.

9. Re-instated update notifications (Preferences->Units/Misc 1). Enabled by default.

Version 2.1.0 ( Pegasus) March 2015

General:

1. Added NOAA style reports - Tools->NOAA Style Reports.

Monthly and Annual NOAA reports are saved to disk at ~/Documents/

WeatherCatNOA AReports/. The monthly report is updated every sample, the annual report
is updated hourly on the first sample past the hour. The report is saved as a simple text file
(.txt).

A 'Save' button on the NOAA reports window will save the report currently being
displayed to disk at ~/Documents/WeatherCatNOA AReports/ (folders will be created for
the year/month if they do not exist).

The extreme high and low temps for NOAA reports can be set in the 'Advanced' pane of
WeatherCat's preferences (defaults are a high of 90°F/32.2°C and a low of 0°F/-17.7°C).
See Custom Web section below for NOAA related tags.

2.Added a Weather Facts editor (Prefs->Misc 1->Weather Facts Editor.

Facts can be added and deleted. In addition, the currently running facts can saved and
loaded allowing the creation of sets (you might for example have a set for Christmas,
seasons of the year and so on).
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3. Added heating degree days and cooling degree days as optional items in the year over
year statistics. (Preferences->Misc 2). Individual base temperatures can be set for both
heating degree days and cooling degree days in the preferences (these temperatures also
affect HDD's and CDD"s on NOAA reports).

4. Added a generic XML based station driver. This connects to your server via HTTP and
expects to read the real time weather data as an XML document.

In the L.P. field of the Station Communications window in WeatherCat enter the URL to the
document - typically something like myserver.com/my_weather.cgi?action=1

From the XML document received, the following keys will be decoded:

AirTemp_C, IntTemp_C, T1_C, T2_C, T3_C, T4_C - External, internal and 4
additional temperature sensors (°C)

RH, IntRH - External and internal relative humidity (0-100)

Solar - Solar radiation (W/M"2)

UVIndex

Barometer_hPa - barometer in hecto-pascals

WindSpeed_ms - windspeed in m/s

WindDirect_deg - wind direction in degrees

Rain_mm - rain in millimetres - can be accumulating rain or daily rain

The format of a data item in the document should be of the form:
<value>

<name>jitem name</name>

<data>item value</data>

</value>

for example:
<value>
<name>RH</name>
<data>52</data>
</value>

Notes:
1. The weather server is polled every 3 seconds.

Custom Web:

1. CustomWeb - added 'STNOAAMO$ ' which is replaced with the current NOA A monthly
report (Note: preformatted text, needs <PRE> and </PRE> tags)

2. CustomWeb - added 'STNOAAPRMO$ ' which is replaced with the NOAA monthly report
for the previous month (Note: preformatted text, needs <PRE> and </PRE> tags)
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3. CustomWeb - added 'STNOAAYR$' which is replaced with the current NOAA annual
report (Note: preformatted text, needs <PRE> and </PRE> tags)

4. CustomWeb - added 'STNOAAPRYR$' which is replaced with the NOAA annual report for
the previous year (Note: preformatted text, needs <PRE> and </PRE> tags)

5. Added 'HEIGHTUNITS$' custom web tag which will return either 'Metres' or 'Feet'
(without the quotes) depending on the units selected by the user.

6. CLOUDBASE can now be used with the STATS$ tag to return the current cloud base -

for example:
STAT$CLOUDBASE: CURRENT$ HEIGHTUNITS$

Note: Will only work with CURRENT.

7. WINDROSESS$, WINDROSES(PERIOD)$, WINDROSE45$ and
WINDROSE45(PERIOD)$ custom web tags now return non-localised output. i.e. decimal
points are always the '.' character.

AppleScript:

1. Apple Script: WeatherCatASIFVers goes to 4 (Rocinante was 3).

2. Added SunriseTime - this will return the sunrise time for today as a localised string.

3. Added SunsetTime - this will return the sunset time for today as a localised string.

4. Added DaylightTime - this will return the daylight time for today as a localised string.
5. Added FTPOverdriven - this will be true if any of the FTP queues are full (else false).
6. Added RunCustomWeb - writing true to this property will start a custom web run.

7. Apple Script: Added two new properties to the Apple Script interface, Query and
QueryResult. These two properties allow the processing of STATS tag type queries via the
Apple Script interface - you place a query and then read the result (Note: does not support
the TIME specifier - access to values only).

Example:

tell application "WeatherCat"
set Query to "STAT$TEMPERATURE:AVERAGE:YESTERDAY$"
set result to QueryResult

end tell

These can also be used from synthetic channel functions.

Note that QueryResult will return a sentinel value of -1000000 if there's an error with the
string passed to Query.

Wunderground:
1. It is now possible to send internal temperature and humidity. Tick-box added to the

Wunderground settings. Off by default.
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2. It is now possible to log the sent packets to the console log. Tick-box added to the
Wunderground settings. Off by default.

Misc:

1. Turned off all smart editing features in a synthetic channel edit box (smart quotes for
example).

2. It is now possible to change the font size as used in the statistics window between 8 and
12 - default is 10 (was 9) (Preferences->Units/Misc 1)

3. We will no longer show solar radiation on year over year statistics if the station in use is
an Instromet.

4.1t is now possible to add STATS tags to the banner generator (banner generator goes to
version 1.5.0). Note that it is possible to embed the tag in other text - for example:

Av. Temp Today: STATSTEMPERATURE:AVERAGE: TODAYS °C

5. Added a cream base for custom gauges.

6. Snow in year over year stats now displayed to 1 decimal point (d.p.) for all units (used
to be 1 d.p. for metric and 2 d.p. for imperial).

7. Wind direction type custom gauges will now rotate through 0° when rotating around the
top of the gauge rather than taking the long way round.

8. Snow entry now limited to 1 decimal place (was 2).

9. Added a hidden preference, 'WindChillWindType' This tells WeatherCat what wind
variable to use for calculating wind chill for logging. O is the default and calculates wind
chill from the average wind speed, 1 tells it to use the current wind speed and 2 tells it to
use the largest gust speed seen over the sampling period.

For example entering the following into the terminal:
defaults write com.trixology.weathercat WindChillWindType -int 2

tells WeatherCat to use the maximum gust seen over the sample period for the windchill
value to record.

10. Fixed an issue where the time for historical data between 00:00 and 01:00 in the
WeatherCat controller would display as 24:xx (if time display was set to 24hr mode)

11. Fixed an issue where barometric pressure and rain data on WeatherCat controller would
display strange values until the first sample of the data came in after midnight (if units
were inHg and inches respectively).

12. Fixed bug on wind run custom gauge where values of 360 would be displayed as O.

Version 2.0.0 September 2014
1. Added Custom Gauges (Tools->Custom Gauges)

2. Added snow support (Tools->Daily Snow Editor).
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3. Added synthetic channels (Tools->Synthetic Channels)

4. Added a WMR-88 station driver. Supports additional temp/thermo sensors, rain bucket
area multiplication (Tools->Station Hardware Options) and short forecast . Note station
hardware code sent to CWOP is for a WMR-100. No historical download support as the
WMRSE8 does not have a logger.

5. Added rain bucket area multiplication to the Oregon Scientific WMR200 (Tools-
>Station Hardware Options).

6. Historic download progress window now shows time remaining for download from
logger.

7. Custom alerts can now use any channel available on your hardware. In addition
synthetic channels can also be used in custom alerts.

8. The Current Conditions Calculator now accepts up to 3 clauses per rule allowing rules
such as 'Warm but windy' or 'Cold rain/sleet' etc.

9. Plugins now remember their visibility state across reboots of WeatherCat.

10. The Banner Generator is now built into WeatherCat as an internal plug-in (older
versions found externally will be ignored).

11. The WeatherCat Controller window is now resizable and the date entry field has been
replaced with a graphical date picker. Dragging the hands of the analogue clock allows the
data to be scrubbed forward and backwards in time. The background image of the window
will change depending on whether the date/time being displayed is night-time or day-time.
(Requires coordinates and location are set correctly in WeatherCat's preferences).

12. Sunrise/sunset will no longer display in the WeatherCat Controller window if the
location has not been set in WeatherCat's preferences.

13. Additional on-line services have been moved from the Tools menu to a new tab in the
'On-Line' tab of the preferences (Additional Services). (SDK update required).

14. Added 'Daily Types' - these are custom day types displayed in the 'Year Over Year'
statistics; for example a 'Wind Day' might be a day where the wind run is greater than 100
miles. Day types are specified in the Misc 2 pane of WeatherCat's preferences via the 'Set

Day Types' button.
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15. Added averages to the year over year statistics for each month of the year and the
yearly totals if there is more than one year displayed.

16. Humidex custom web tags now display to 1 decimal point.

17. Data restore mode is now 'Safe Mode' - to get into this mode, launch WeatherCat and
hold down the control key immediately it starts launching. In this mode, no plugins are
loaded (station drivers or additional tools), no data is loaded and weather related processes
are not running. You can restore your data from a back up or use the synthetic channel
manager to edit channels. When done, quit WeatherCat.

Version 1.2.0 July 2013

Highlights:
1. Added stats for the following additional channels:
T1 through T8 (extra temperature sensors 1 to 8)
H1 through H8 (extra humidity sensors 1 to 8)
LW1 through LW4 (leaf wetness sensors 1 to 4)
SM1 through SM4 (soil moisture sensors 1 to 4)
ST1 through ST4 (soil temperature sensors 1 to 4)
These channels can now be graphed on 1 hour type custom graphs and can be queried with
the STATS custom web tag.

2. Data Export (Tools->Data Export) - new implementation. Exports can be created
manually or automatically on a daily basis. Two types of export are available - weather
data or hourly data.

3. Added the following tools: Met-Office uploader, WeatherBug uploader, PWSWeather
uploader, OpenWeatherMap uploader.

4. Added a MySQL driver. This tool can upload your weather data to a MySQL database
opening up a world of applications not previously available to WeatherCat - charting and
analysis for example (e.g. High-Charts, JpGraph, GraPHPite, pChart and so on). Features:
Auto-import of initial data. Uploading of historical data. Variable rate upload frequency
depending on data (fast for wind, slower for other data), resolution down to 1 second.

5. Various minor improvements and bug fixes.
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Note: When first run, version 1.2.0 will update your hourly data on disk - this may take a
minute or two. Should you need to go back to an earlier release, this rebuilding will occur
again when you run the older version.

V1.2.0 Detailed Change Notes
1. Fix WH3080 hardware code to CWOP.

2. WeatherCat Client update for heat index. Also note, this client is Intel build only - 10.6
or later required.

3. SDK update for V1.20.

4. Latest German resources thanks to Reinhard.

5. We now throw an error on email test if there isn't at least one email address to send to.
6. CWOP update for version 4 servers - we now send TCPIP rather than TCPXX.

7.Added a 'DOTSEPARATORS$' custom web tag. This tag is important if you run a non-
English version of WeatherCat - it switches off localised decimal separators whilst
processing STAT$ tags across a page. For example if the result of a tag is normally
something like '13,6', with this tag in effect the output will be '13.6'. This is handy if you
know the output is going to be machine parsed and the script doing the parsing doesn't
understand localised decimal separators.

This tag may appear only once on a page, it can be placed anywhere and stays in effect for
the whole page.

8. Fixed a bug where STATS$ tags calculating average AT_US, AT_AUS or HUMIDEX
returned incorrect results if temperature units were set to Fahrenheit.

9. On a new install, imagery for location 1 is now off by default.

10. Heat index will no-longer calculate below 80°F - the formula used is not accurate
below this value.

11. Maximum data logger periods for both 1080 and 3080 Fine Offset stations is now 59
minutes.
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12. Fixed an issue where internal temperature/delta and heat index/delta values as entered
into the test window were not being sent when testing a custom alert.

13. Added an OpenWeatherMap plug-in. (Tools->OpenWeatherMap).
Sign up at http://openweathermap.org, enter your name and password (as you entered them
when you registered on OpenWeatherMap) into the tool and hit the 'Start' button.

14. Added a PWSWeather plug-in. (Tools->PWSWeather).

Sign up at http://www.pwsweather.com/register.php, create a station then enter your station
ID and password (as you entered them when you registered on PWSWeather) into the tool
and hit the 'Start' button.

15. Added a MySQL driver plug-in (Tools->SQLDriver). This tool can upload your
weather data to a MySQL database opening up a world of applications not previously
available to WeatherCat - charting and analysis for example (e.g. High-Charts, JpGraph,
GraPHPite, pChart and so on).

Features: Auto-import of initial data. Uploading of historical data. Variable rate upload
frequency depending on data (fast for wind, slower for other data), resolution down to 1
second.

Details:

The database must exist - WeatherCat will not create it. Four tables are created and
maintained in the database - one for wind (WindData), one for common variables
(WeatherData) and one for extra sensors (ExtraData). An additional table is maintained for
maintenance reasons - do not edit this additional table (_WeatherCatPrivate).

If WeatherCat detects the database is new (i.e. has no tables), it will create the tables then
import all of your existing WeatherCat data. The period of the data when uploading
historical data can be set in the tool - the default is 5 minutes. Thereafter, data will be
uploaded to fill in gaps (for example when WeatherCat isn't running or the database server
is not available).

When running in real-time, the wind data can be updated faster than the other data (down
to 1 second) - this is handy if you have a station which updates wind data faster than other
data (Davis Vantage or Vue for example). The other data is updated at a user settable
multiple of this period.

If you wish to reset the database, stop the SQLDriver, drop all four tables (using something
like phpMyAdmin), then start the SQLDriver again - it'll re-import your weather data.
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Notes:

1. If your database is managed via CPanel, be sure to enable external
connections from your I.P. address (normally via RemoteMySQ)

2. Verbose errors are logged to WeatherCat's log window. On error, the
SQLDriver will wait a second or two before retrying the transaction.

3. SQLServers can block repeated unauthorised attempts to access. If your
passsword is wrong, or there's some authentication problem, do not repeatedly
keep hitting the 'start’ button, or leave authentication errors repeat. If this does
happen to you, the error reported in WeatherCat's log window should tell you
what you need to do to unblock yourself.

4. The initial import to a new database can take a very long time. For example,
importing 6 years worth of data (Vantage with extra channels) from a MacMini
to a Synology 1512+ at the default 5 minute intervals took ~ 60 minutes at
approximately 250KB's per second. For your entertainment, a progress bar and
percentage complete are displayed during this time. Weather data collected by
WeatherCat during initial import or 'hole filling' will not be lost.

5. At the end of the initial import or uploading historic data, the SQLDriver will
switch to real-time logging.

6. If the initial import or uploading of historic data is interrupted, it will resume
when the SQLDriver is next able to make contact with the database.

7. The period of historic data uploads is read when the upload is started - if you
want to change the period during an upload, hit the 'Stop' button, change the
period then hit the 'Start' button.

8. The time field in the database tables is in U.T.C.

9. The data size reported in the tools' window is not the database size - merely
the number of bytes transmitted to the server. Typically this is far greater than
the actual data size in the database.

10. Imagery is not uploaded to the SQL server.

11. When running with live data, the minimum, average and maximum
transaction time is logged in the window - these values can be reset with the
small 'R' button.

12. The SQLDriver requires WeatherCat 1.2.0 build 600 or later.

13. Tested with MySQL 5.1.49. Should work with other versions of MySQL -
the minimum MySQL version in theory should be 4.1 (not tested).

14. Uses the MariaDB SQL connector - source code and Xcode project for this
plug-in can be found at http://resources.trixology.com/downloads/
WeatherCat_SQLDriver.zip.

16. Fixed issue in WeatherCat API method to return the localised display value of a given
channel. It was as returning one decimal place for additional precipitation and ET
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channels if units were set to inches (should have been 2). This affected plug-ins displaying
these channels - i.e. Banner Generator. Affected channels were monthly rain, yearly rain,
daily ET, monthly ET and annual ET.

17. If station communications have failed for longer than 20 minutes, all FTP processing
will halt until station communications are resumed.

18. Added a WeatherBug uploader (Tools->WeatherBug).

19. Added a Met-Office WoW uploader (Tools->MetOfficeWoW). Notes: 1) Soil moisture
is uploaded from soil moisture sensor #1. 2) Soil temperature is uploaded from soil
temperature sensor #1 (soil temperature appears as grass temperature on WoW site). 3).
The Met-Office recommends upload intervals of at least 15 minutes (which is the default
on a new installation) - WeatherCat will allow down to 1 minute intervals should the Met-
Office recommend more frequent uploads in the future.

20. Added CPS$ custom web tag which is replaced with the current potential solar energy
based on location and date/time. Uses the Ryan-Stolzenbach model with an atmospheric
transmission factor of 0.8. Note it is not at all unusual to see the measured solar reading
exceed the potential solar energy as the sensor measures not only direct radiation but also
indirect radiation.

21. Fixed an issue where STAT$AVERAGEWINDSPEED :MAX would return the maximum gust
speed.

22. Fixed an issue where stats for additional temperature type sensors was returning
unconverted values.

22. Added stats for the following additional channels:
T1 through T8 (extra temperature sensors 1 to 8)
H1 through H8 (extra humidity sensors 1 to 8)
LW1 through LW4 (leaf wetness sensors 1 to 4)
SM1 through SM4 (soil moisture sensors 1 to 4)
ST1 through ST4 (soil temperature sensors 1 to 4)

These can be used with the STATS tag as per other variables - for example to find the

maximum soil temperature this year:
STAT$ST1:MAX: THISYEAR$

or
STAT$H2:MAX: THISWEEK$ at STAT$H2:MAX:THISWEEK:TIMES$

etc.
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23. The hourly data for these additional sensors can now be graphed on custom graphs -
1.e. min/max/average, line or bar types.

24. Data Export (Tools->Data Export) - new implementation. Exports can be created
manually or automatically on a daily basis.

Two types of export are available - weather data or hourly data. The weather data is
exported at the period specified, the hourly data consists of hourly minimum, maximum
and average except for accumulated precipitation which is the total accumulated for the
hour. All data is converted to user units. The file format of the exports is .csv, which should
open in any spreadsheet software.

Convenience date selectors are available (today, this year, etc.), custom ranges can be
created by clicking the calendars to set the 'from' and 'to' dates. If the date range doesn't
make sense, the export button will be greyed out. The export period can be set for raw
weather data (i.e. every ten minutes). To export a particular day, select the same date on
both calendars.

The channels that are exported are determined by the sensors fitted to your station.

Daily exports can be selected to run automatically (this feature is off by default). Auto-
exports are stored in ~/Documents/WeatherCatExports/year/month/HourlyData and
WeatherData (where ~ is your home directory). A daily export will run at the first
opportunity - WeatherCat doesn't need to be running around midnight for the export to be
processed (for example if WeatherCat is off for the night, the export for yesterday will
happen when it's launched in the morning).

FTP of daily exports to your custom web site 1s being considered for WeatherCat V2.

25. Fixed a bug in WH3080 driver where an invalid block on historical download would
result in a solar reading of 1800W/mA2.

Version 1.1.5 - 29 Mar 2013
1. Fix a potential crash on 10.8.3 whilst sending data to C.W.O.P.
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Version 1.1.4 - 17 February 2013

1. Added support for WH3080 stations - these are the Fine Offset stations with solar and
u.v. Note: The console can display solar radiation in watts per square meter but this display
reads low by a huge factor. WeatherCat corrects this. Because of this correction, the solar
radiation displayed and recorded by WeatherCat will not match the solar radiation as
displayed on the console. The solar radiation as displayed by WeatherCat has been verified
against the solar radiation as measured by a Davis Vantage (sensors in same location).

2. WMR200: Fixed a crash that could occur on start-up.

3. WMR200: Fixed an issue where additional channels may be missing from the first few
samples on historic download.

4. Fixed a long-standing bug that could cause a spike on graphs at the start of a month.
5. Fixed an issue that could cause email to hang on some systems.
6. Scaling improvements when multiple humidity channels are present on a custom graph.

7. Tag additions/changes
a. Added MAXGUSTDIR(PERIOD)$ custom web tag. This is replaced with the
wind direction at the time of the maximum wind gust over the period. PERIOD can
be any time period accepted by the STATS$ web tag. For example:
MAXGUSTDIR(TODAY)$
Can be combined with STATS tags to find speed and time - for example:
Max gust today: STATSWINDGUST:-MAX:TODAYS$ from
MAXGUSTDIR(TODAY)S$ degrees at STATSWINDGUST:-MAX:TODAY:TIME$

b. Added MAXGUSTDIRTEXT(PERIOD)$ custom web tag. This is exactly the
same as MAXGUSTDIR but the output is localised text, rather than degrees.

c. Added a DUTCS$ custom web tag, this outputs the current UTC date and time
formatted as: yyyy,M,d,H,m,s - for example '2013,1,24,19,50,57'

d. Improvements to DOMWDDEGREES$ and DOMWDTEXTS tags - we now use
a sector based calculation.

¢. Added DOMWDDEGREES(PERIOD)$ which calculates the dominant wind
direction over a given time period, where PERIOD can be any period accepted by
the STATS tag.

f. Added WINDROSES(PERIOD)$ and WINDROSE45(PERIOD)$ web tags.
Replaced with a list of 8 or 45 wind rose values (starting at north and running
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[edit]

clockwise, every 45 degrees or 8 degrees) over the period specified by PERIOD
which can be any period accepted by the STATS tag.

g. Added WINDBEARINGFROM10$ custom web tag which is replaced with the
lowest wind bearing recorded in the last 10 minutes rounded down to the nearest
10 degrees.

h. Added WINDBEARINGTO10$ custom web tag which is replaced with the
highest wind bearing recorded in the last 10 minutes rounded down to the nearest
10 degrees.

1. Added AT AUS (apparent temperature (Australian variant)), AT US (apparent
temperature (U.S. variant)) and HUMIDEX as variable types that can be used with
the STATS tag. These types are currently limited to time periods that extend no
further than 1 year in the past.

Examples:

STATSAT AUS:CURRENTS (STATSAT AUS:DELTAI1S$) is replaced with the
current apparent temperature (Aus) and the 1 hour delta.

STATSAT US:MAX:TODAYS$ TEMPUNITSS at

STATSAT US:MAX:TODAY:TIMES is replaced with the highest apparent
temperature (US) recorded today and the time of the high.
STATSHUMIDEX:AVERAGE:LASTMONTHS is replaced with the average
humidex for last month.

j. Added COMMSFAILFLAGS web tag - this is replaced with O if the station
comms are good or 1 if the comms have failed (hardware fail or stale data).

k. Fixed an issue where numbers in STATS tag results were not localised.

1. Changed BD$ web tag (build info) to always output a non-localised decimal
point.

m. Added BDLS$ which will output with a localised decimal point.

Version 1.1.3 - 12 January 2013
1. Fixed an issue that could cause FTP to crash if passed an invalid path.

2. Mac OS X 10.8.3 compatibility update.

3. Added LLat$ and Llong$ custom web tags which are replaced with the station latitude
and longitude respectively. These coordinates are displayed as degrees, minutes and
seconds. Note that the seconds will be different to the coordinates entered into WeatherCat
as WeatherCat needs the coordinates in degrees, minutes and hundredths of a minute (i.e.
LORAN format).
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4. Added Lelevf$ and Lelevm$ custom web tags - these are replaced with the station
elevation in feet or metres respectively.

5. Added AT USS$ custom web tag - replaced with the current apparent temperature (US
version) - http://www.ncdc.noaa.gov/societal-impacts/apparent-temp/

6. Added AT Aus$ custom web tag - replaced with the current apparent temperature
(Australian version, non solar) - http://www.bom.gov.au/info/thermal stress/

7. Added HUMIDEXS custom web tag - replaced with the current humidex (Canadian
version) - http://ec.gc.ca/meteo-weather/default.asp?lang=En&n=6C5D4990-1#humidex

8. Added DOMWDTEXTS custom web tag - replaced with the dominant wind direction
today as text (i.e. ENE), localised.

9. Added DOMWDDEGREESS$ custom web tag - replaced with the dominant wind
direction today as degrees.

10. Added WINDROSESS custom web tag - replaced with a list of 8 wind rose values
(starting at north and running clockwise, every 45 degrees).

11. Added WINDROSE45$ custom web tag - replaced with a list of 45 wind rose values
(starting at north and running clockwise, every 8 degrees).

Version 1.1.2 December 27t 2012
1. Fixed a crash that could occur in WMR200 and WH1080 drivers on start-up.

2. Added a DAYSAGO(x) function that can be used as a time specifier with the STAT$

web tag. Example:
Highest temperature 2 days ago = STAT$TEMPERATURE:MAX:DAYSAGO(2)$TEMPUNITS$
at STAT$TEMPERATURE:MAX:DAYSAGO(2):TIME$

The valid range for this function is 1 to 99999 days, integers only.

3. Added Internal Humidity as a trigger for custom alerts.

Version 1.1.1 December 23rd 2012

1. Added Fine Offset WH1080/2080 station driver. This station is sold under a variety of
brands including Maplin (N96GY), Ambient Weather, Conrad, Clas Ohlson, Watson
(W-8681) and others.

2. WMR200: Fixed an issue whereby UV would indicate as invalid when it should be
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valid.

3. WMR200: Fixed an issue whereby the historical download window would stop updating
after 5 minutes (the download continues and completes).

4. Latest Italian translations courtesy of Federico Paoletti.

Version 1.1.0 December 18th 2012

1. Added calibration (Preferences->Misc 2).

2. Various bug fixes.

3. Added an SDK (see separate download)

4. Added daily backups (Tools menu).

5. Added Wd$ macro (wind direction) that can be used with custom alert emails.

6. Printing improvements - it is now possible to print all basic graphs and the current daily
and monthly reports.

7. Plotting style of basic wind direction graph is now settable to one of line, shortest path
or dots (Preferences->Misc 2)

8. Data export rewritten. It is now possible to export all raw data as a .csv file which
should open directly in most spreadsheet software.

9. Tag additions:

Added SINCE9AM as a period parameter that can be used in the STATS tag - example:
Highest temperature since 9 A.M.= STAT$TEMPERATURE :MAX:SINCE9$TEMPUNITSS at
STAT$TEMPERATURE :MAX : SINCEQ: TIME$ <BR>

Added an HRS(x) function which can be used as the period parameter in the STATS tag,

This function specifies a time period in hours from 'now' - examples.
Highest temperature in the last 24 hours = STAT$TEMPERATURE :MAX:HRS(24)$TEMPUNITSS at
STAT$TEMPERATURE :MAX : HRS(24) : TIME$<BR>

10. FTP re-architected to increase upload speed, reduce the number of connections and
reduce latency of time sensitive data.

11. Holding down the 'ctr]l' key whilst scrolling graphs and imagery via the WeatherCat
Controller buttons now accelerates the scrolling.

12. Added Oregon Scientific WMR200 support.

13. Vantage VUE stability update.

14. Documentation update.

Version 1.02 15 July 2012

1. Compatibility with Mac OS X 10.8 (GM).
2. Will now calculate heat index below 40% RH.

Version 1.01 June 2012

1. Mac OS X 10.8 compatibility
2. Added optional shutdown delay to wait for scripts that are being closed
3. Updated localisations
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4. Stability improvements

Version 1.0 6 May 2012
Initial Release

Page 259



License

WeatherCat License

Single User Full Registered License
The software accompanying this license, whether on disk, in read only memory, or on any other media
(hereafter referred to as "the Software") and the related documentation are licensed to you by Trixology.

You own the media on which the Software is recorded (if supplied on media) but Trixology retains title to
the Software and related documentation.

This License allows you to use the Software up to two (2) Apple Macintosh computers within your home.
If you wish to run WeatherCat on more than two (2) computers within your home, please buy additional
licenses (1 license for each additional computer).

Business and Educational Full Registered Licenses
If you wish to run WeatherCat in an Educational or Business environment please contact Trixology for
site licensing prices.

Restrictions

The Software contains copyrighted and proprietary material. In order to protect them, and except as
permitted by applicable legislation, you may not decompile, reverse engineer, disassemble or otherwise
reduce the Software to a human-perceivable form. You may not modify, network, rent, lease, loan,
distribute or create derivative works based upon the Software in whole or in part apart from via published
APTI's that form part of the Software.

Liability

Trixology has used its best efforts to produce this software and documentation. The authors make no
representation or warranties with respect to either the accuracy or completeness of either software or the
manual for any particular purpose, and shall in no event be liable for any loss of profit or any other
commercial or personal damage, including, but not limited to special, incidental, consequential, or other
damages.

WeatherCat will try its best to send out weather alerts and warnings. However we do not guarantee that
any alert or warning generated will reach its intended recipient.

Even in WeatherCat's display, glitches might occur. Before undertaking any journey or other activity that
may be adversely affected by the weather, you should check with multiple sources of information and
appraise local weather conditions yourself. With all these pieces of information you should make a
judgment. Failure to do so could be fatal. Only you can know whether it is safe - WeatherCat cannot.

With all this in mind, Trixology will not be held responsible for any accident, or loss of business, or other
unfortunate event that might occur from decisions based upon WeatherCat. If your local laws do not allow

this limitation of liability then you should not use WeatherCat.

Remember - always take the safe option.
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Acceptance
By using the Software, you agree to the terms of this license. If you do not agree with the terms of this
license then you are not licensed to use the Software.
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French Localisation: Michel Le Berre & Frederic Genevey
German Localisation: Reinhard Unterwurzacher
Italian Localisation: Federico Paoletti

Floater Graphics: Charles Cohn
Progress dialog graphics licensed from Polylooks
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development versions of WeatherCat and provide valuable feedback.

This software is brought to you via the colour blue and with the help of 2 cats, Dream
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